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Capitolo 1

Informazioni generali

Nel presente capitolo verranno introdotti i concetti di base ed evidenziati i
passi fondamentali che compongono il processo di progettazione e veri�ca degli
elementi in calcestruzzo.

SAP2000 integra un post processore in grado di fornire risultati completi per
quanto riguarda:

� Progettazione dell'armatura longitudinale e trasversale di travi in c.a.

� Progettazione e veri�ca dell'armatura longitudinale e progetto dell'arma-
tura trasversale di pilastri in c.a.

� Progettazione dell'armatura longitudinale di elementi piani in c.a. (solette,
setti...)

1.1 Normativa di riferimento

La normativa di riferimento per il progetto/veri�ca degli elementi struttu-
rali deve essere determinata all'interno del menu Design > Concrete Frame
Design > View/Revise Preferences. È possibile scegliere una normativa di
progetto qualsiasi da applicare ad una qualunque analisi di carico. Nella me-
desima esecuzione della procedura progettuale non è possibile progettare alcuni
elementi seguendo una normativa ed altri seguendone un'altra, tuttavia è possibi-
le realizzare esecuzioni progettuali diverse utilizzando normative di�erenti senza
rilanciare le analisi.

La descrizione dettagliata delle procedure di progetto/veri�ca implementate
per le varie normative è consultabile attraverso il menu Help > Documen-
tation > Design > Concrete Frame Design e speci�cando la normativa
desiderata.
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1.2 Unità di misura

Per la progettazione di aste in calcestruzzo, può essere utilizzato come input
un set qualsiasi di unità consistenti. Convenzionalmente, i codici progettuali
sono basati su uno speci�co set di unità (ad es. Newton - millimetri - secondi
per l'EC2) ma è comunque possibile utilizzare un qualunque sistema di unità di
misura per de�nire e progettare un edi�cio, come anche cambiare in qualsiasi
momento il sistema di unità che si sta utilizzando.

1.3 Assegnazione della procedura di progetto

Prima di procedere al progetto od alla veri�ca degli elementi strutturali oc-
corre associare agli stessi una determinata procedura di progetto. L'assegnazione
delle procedure di progetto ai vari elementi viene fatta a livello di de�nizione
della sezione.

In particolare, per elementi frame in calcestruzzo, all'interno del menuDe�ne
> Section properties > Frame Sections > Modify/Show Properties >
Concrete Reinforcement è possibile speci�care il tipo di progettazione fra:

� Column: pilastri in calcestruzzo progettati o veri�cati per l'interazione P -
M2-M3, e progettati a taglio in entrambe le direzioni del piano.

� Beam: travi in calcestruzzo progettate solo a momento forte M3, taglio
corrispondente V2 e torsione.

Per sezioni de�nite attraverso Section Designer l'unica opzione disponibile fra le
preferenze di progettazione è �Concrete Column�. È inoltre possibile escludere
taluni elementi dal processo di veri�ca assegnando, attraverso il comandoDesign
> Overwrite Frame Design Procedure, l'opzione No Design.

Per elementi piani in calcestruzzo, all'interno del menu De�ne > Section
properties > Area Sections > Modify/Show Shell design parameters è
possibile speci�care il tipo di progettazione fra:

� Default: soletta a doppia armatura con copriferro pari al 10% dello spessore
della soletta

� One layer: soletta a semplice armatura con copriferro speci�cato

� Two layers: soletta a doppia armatura con copriferro speci�cato
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1.4 Combinazioni di carico di progetto

Il programma crea automaticamente un numero di combinazioni di carico di
progetto in base alla normativa selezionata. E' possibile aggiungere combina-
zioni personalizzzate oppure modi�care o cancellare le combinazioni di default
del programma. Le combinazioni di carico da includere nel processo di proget-
to/veri�ca possono essere speci�cate attraverso il menu Design > Concrete
Frame Design > Select Design Combos.

Tutti i codici di calcolo prevedono la combinazione dei carichi e delle azioni
attraverso l'uso di fattori moltiplicativi. I fattori utilizzati ed il modo in cui ca-
richi e le azioni vengono combinati dipendono dal codice di calcolo selezionato.
Più in dettaglio i fattori di combinazione vengono applicati alle forze ed ai mo-
menti corrispondenti alle analisi dei singoli casi di carico. I valori così ottenuti
vengono poi sommati per ottenere le forze ed i momenti relativi alla combinazio-
ne di carico. Eseguendo l'analisi ad elementi �niti per i singoli casi di carico e
poi sommando i risultati moltiplicati per i fattori di carico, è possibile de�nire le
varie cambinazioni anche dopo aver lanciato l'analisi della struttura.

Per combinazioni di carico che comprendono analisi a spettro di risposta,
analisi time history, analisi a carichi mobili, e combinazioni del tipo invilup-
po, srss, somma dei valori assoluti... dove pertanto ogni corrispondenza fra le
quantità interagenti viene persa, il programma crea automaticamente le
sottocombinazioni multiple usando permutazioni di massimi/minimi
delle quantità interagenti. La procedura di permutazione appena descritta
genera quindi otto scenari di veri�ca distinti per ogni combinazione.

Nota: non sono richieste combinazioni separate con fattori negativi per i casi di
carico a spettro di risposta poiché il valore derivante dall'analisi viene automati-
camente assunto sia con segno positivo che negativo.

Come anticipato, per le combinazioni di carico standard che includono cari-
chi statici (come carichi permanenti, carichi variabili, carico da vento e carico
da sisma) e/o carichi dinamici (come il carico sismico generato da uno spettro di
risposta), il programma è dotato di una procedura per la generazione di combina-
zioni di default. Tali combinazioni sono basate sulle raccomandazioni contenute
nel relativo codice di progetto. Le combinazioni di carico di default assumo-
no come presupposto che tutti gli schemi di carico dichiarati come permanenti
(DEAD) siano addittivi. Allo stesso modo, tutti gli schemi di carico dichiarati
come variabili (LIVE) sono considerati addittivi. Ogni schema di carico statico
dichiarato come da vento (WIND) o da sisma (QUAKE), o i casi di carico a
spettro di risposta, sono considerati non addittivi fra di loro e danno luogo a
combinazioni di carico laterale multiple (nel caso di carichi da vento e carico da
sisma statico anche con permutazione di segno).
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Qualora le combinazioni generate automaticamente non siano corrette, e/o
qualora vi sia la necessità di inserire altri scenari di carico non inclusi, l'utente
deve intervenire correggendo e/o inserendo manualmente le combinazioni.

1.5 Stazioni di progetto

Per ogni combinazione di carico, ogni elemento viene progettato e/o veri�cato
in un numero prede�nito di stazioni distribuite in modo equidistante su tutta la
sua lunghezza. Il numero di stazioni per ogni elemento frame può essere impostato
dall'utente, prima di e�ettuare l'analisi della struttura, attraverso il menuAssign
> Frame > Output Stations.

1.6 Progetto di travi

Il programma progetta come travi, tutti gli elementi asta in calcestruzzo cui
è stato assegnato il design type �Beam� come speci�cato in precedenza. Gli
elementi frame de�niti come travi devono avere sezione rettangolare,
ad L o a T.

Nella progettazione di travi in calcestruzzo il programma calcola e riporta,
per ogni stazione di output della trave, le aree di acciaio richiesto per la �essione,
per il taglio e per la torsione basate sui momenti e i tagli della trave. Tutte le
travi sono progettate solamente per la �essione in direzione principale
M3, per il taglio associato V2 e per la torsione T . Gli e�etti risultanti da
qualsiasi forza assiale e da �essione in direzione secondaria che potreb-
bero esistere nelle travi, devono essere investigate indipendentemente
dall'utente in modo autonomo.

La sezione della trave è progettata per gli inviluppi dei momenti �ettenti
fattorizzati ottenuti da tutte le combinazioni di carico selezionate. Momenti
negativi nella trave producono armatura superiore. In questi casi la trave è
sempre progettata come una sezione rettangolare. Momenti positivi nella trave
producono armatura inferiore. In questi casi la trave è progettata come una trave
rettangolare o come una trave a T. Per la progettazione dell'armatura, la trave
è dapprima progettata come una trave ad armatura singola, qualora la sezione
non risultasse adeguata, viene calcolata un opportuna armatura a compressione.

Nella progettazione dell'armatura a taglio i passi comprendono la determi-
nazione della forza di taglio fattorizzata, la determinazione della forza di taglio
che può essere portata dal calcetruzzo privo di sta�e ed in�ne la determinazione
dell'eventuale armatura richiesta.

Per la progettazione dell'armatura a torsione il momento torcente fattorizzato
viene confrontato con il momento torcente di fessurazione. Qualora il momento
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fattorizzato risultasse superiore al momento di fessurazione il programma calcola
l'armatura necessaria a resistere alla torisione.

1.7 Progetto di pilastri

Il programma progetta come pilastri, tutti gli elementi asta in calcestruzzo
cui è stato assegnato il design type �Column� come speci�cato in precedenza.
I pilastri in c.a. possono avere sezioni di forma arbitraria e vengono calcolati
a presso-tenso �essione biassiale e taglio. Nel calcolo dei pilastri l'utente può
speci�care se il pilastro deve essere progettato oppure veri�cato. A tal proposito
nel menuDe�ne > Section properties > Frame Sections >Modify/Show
Properties > Concrete Reinforcement è possibile scegliere fra le opzioni:

� Reinforcement to be designed

� Reinforcement to be checked

Nel primo caso l'output sarà del tutto analogo a quello delle travi e verrà fornita,
per ogni stazione, la quantità di armatura longitudinale e trasversale minima
necessaria a riprendere le sollecitazioni di progetto. Il risultato viene espresso
come area minima necessaria da distribuire in modo omogeneo nelle posizioni
stabilite dall'utente. Nel secondo caso il programma esegue il calcolo dei fattori
di utilizzo (capacity ratio) della sezione in funzione dell'armatura speci�cata.
I fattori di utilizzo danno un'indicazione della condizione di sforzo del pilastro
rispetto alla capacità resistente dello stesso. La procedura di calcolo per pilastri
in calcestruzzo comprende i seguenti passi:

� Generazione delle super�ci di interazione forza-assiale momento biassiale
per tutte le di�erenti sezioni in calcestruzzo del modello

� Veri�ca della capacità di ogni pilastro per la forza assiale e il momento �et-
tente corrispondente ad ogni combinazione di carico, eventualmente incre-
mentato per tener conto degli e�etti del secondo ordine. In alternativa, se il
pilastro deve essere progettato, calcolo dell'armatura minima che produce
un rapporto di capacità pari ad 1.0

� Progettazione dell'armatura a taglio del pilastro

La procedura di calcolo per l'armatura a torsione è la stessa vista per le travi,
viceversa per il calcolo dell'armatura a taglio deve essere considerato l'e�etto
della forza assiale sulla capacità resistente del calcestruzzo.
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1.8 Progetto di elementi piani

SAP2000 implementa una procedura per il progetto dell'armatura longitu-
dinale di elementi piani in c.a.. L'algoritmo di calcolo si basa sul cosiddetto
�modello a sandwich� composto, al più, da due strati esterni di armatura ed un
nucleo centrale in c.a.. In tale rappresentazione si assume che gli sforzi assiali,
gli sforzi taglianti nel piano e i momenti �ettenti fuori piano siano assorbiti dagli
strati esterni; mentre gli sforzi di taglio trasversali vengano ripresi direttamen-
te dal nucleo centrale che si ipotizza essere non fessurato. Nessuna armatura
trasversale sarà quindi calcolata.

L'output è composto dall'armatura longitudinale per unità di lunghezza, su-
periore ed inferiore, nelle due direzioni. Maggiori dettagli sul modello di calcolo
utilizzato sono reperibili all'interno del documento: Help > Documentation
> Technical Notes > Concrete Shell Reinforcement Design.

1.9 Gerarchia delle resistenze

I più importanti codici normativi a livello internazionale prevedono che la
progettazione sismica delle strutture sia basata sul criterio della gerarchia delle
resistenze. SAP2000 integra pienamenente tali prescrizioni e�ettuando, per tutte
le combinazioni sismiche selezionate, una progettazione in grado di garantire:

� gerarchia a taglio delle travi in funzione dei momenti resistenti di estremità

� gerarchia a �essione dei pilastri in funzione dei momenti resistenti delle
travi incidenti

� gerarchia a taglio dei pilastri in funzione della resistenza �essionale degli
stessi

� gerarchia a taglio del nodo strutturale in funzione dei momenti resistenti
delle travi incidenti

Le modalità di controllo dei criteri di gerarchia sopra citati sono funzione
della normativa di calcolo selezionata. Tutti i dettagli relativi alle procedure
implementate per i diversi codici sono reperibili all'interno del percorso Help >
Documentation > Design > Concrete Frame Design.

1.10 E�etti del secondo ordine

Le normative richiedono solitamente che gli e�etti del secondo ordine vengano
considerati quando si progettano telai in calcestruzzo. Gli e�etti del secondo
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ordine hanno origine da due fonti: la traslazione laterale globale del telaio e la
deformazione locale dei singoli elementi del telaio.

Si consideri l'elemento asta mostrato nella �gura 5.1 facente parte di una
data struttura: il drift globale fra le estremità dell'elemento è indicato con ∆,
viceversa la deformazione locale dello stesso è indicata con δ. Gli e�etti totali
del secondo ordine nell'elemento sono determinati sia da ∆ che da δ.

Figura 1.1: e�etti del secondo ordine su un elemento

SAP2000 è in grado di cogliere l'in�uenza di entrambi gli aspetti sul com-
portamento globale della struttura attraverso un'analisi non lineare P-Delta o
in grandi spostamenti. A�nché il contributo dello sbandamento locale dell'ele-
mento venga colto in maniera corretta è necessario che lo stesso sia �sicamente
suddiviso in più elementi intermedi. Nella maggioranza dei casi di interesse pra-
tico si preferisce tuttavia non suddividere gli elementi e tener conto degli e�etti
locali attraverso procedure sempli�cate integrate nel codice di veri�ca selezionato
(ad es. metodo della curvatura nominale per l'EC2 e le NTC2008).

Al �ne di impostare un'analisi di tipo P-Delta o in grandi spostamenti è
necessario de�nire un caso di analisi di tipo statico non lineare o di tipo time
history non lineare e scegliere fra i possibili parametri di non linearità geometrica:

� P-Delta: in tal caso la matrice di rigidezza degli elementi viene costruita
tenendo conto dell'interazione fra l'azione assiale e �ettente. Così facendo
viene correttamente modellato l'e�etto instabilizzante dei carichi assiali di
compressione e quello stabilizzante dei carichi assiali di trazione sul com-
portamento �ettente degli elementi. La matrice di rigidezza diventa perciò
funzione dello stato sollecitante e deve essere calcolata attraverso un pro-
cesso iterativo. Per carichi assiali di compressione molto elevati, vicini
ai carichi critici degli elementi, potrebbe essere necessario intervenire sui
parametri di convergenza dell'analisi
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� P-Delta più grandi spostamenti: scegliendo tale opzione, in aggiunta all'a-
nalisi P-Delta, si assume che la struttura sia soggetta a grandi spostamenti
e, pertanto, l'ipotesi di riferire le equazioni di equilibrio alla con�gurazione
indeformata non abbia signi�cato. Il sistema risolvente viene pertanto as-
semblato a partire dalla con�gurazione deformata della struttura seguendo
un processo iterativo. Il primo passo consiste nell'applicare i carichi alla
struttura e calcolare la soluzione in termini di spostamenti tenendo con-
to dell'e�etto P-Delta. La con�gurazione deformata così ottenuta sarà la
con�gurazione cui verranno riferite le equazioni di equilibrio al passo suc-
cessivo. In sostanza la soluzione al passo i-esimo viene calcolata tenendo
conto dell'e�etto P-Delta applicato alle matrici delle proprietà strutturali
relative al passo i-1. La procedura descritta è quindi doppiamente iterativa:
vi è un'iterazione �principale� per il calcolo della con�gurazione cui riferire
le matrici delle proprietà strutturali, ed un'iterazione �secondaria�, all'in-
terno del generico passo, per il calcolo della matrice di rigidezza che tiene
conto dell'interazione assiale. Il processo termina quando le con�gurazio-
ni corrispondenti a due passi successivi di�ersicono meno della tolleranza
speci�cata. Alla luce di quanto detto, un'analisi P-Delta in grandi sposta-
menti risulta molto più sensibile ai parametri di convergenza rispetto ad
una semplice analisi P-Delta

In generale quindi, al �ne di rappresentare correttamente gli e�etti del secondo
ordine su una data struttura, occorre de�nire gli opportuni casi di analisi non
lineare. Nella stragrande maggioranza dei casi pratici è su�ciente fare riferimento
ad analisi P-Delta mentre le analisi in grandi spostamenti si rendono necessarie
solo per particolari tipologie strutturali. Trattandosi di analisi non lineari, in
linea di principio, occorrerebbe de�nire un'analisi diversa per ogni combinazione
strutturale in quanto il principio di sovrapposizione degli e�etti non risulta più
valido.

Nella pratica progettuale tuttavia, è solitamente possibile e�ettuare un'uti-
le sempli�cazione de�nendo un unico caso non lineare P-Delta, comprendente i
carichi verticali più signi�cativi, e lanciare le successive analisi lineari a partire
dalla rigidezza corrispondente al caso P-Delta de�nito. In tal modo sarà possi-
bile cogliere gli e�etti instabilizzanti sulla struttura e allo stesso tempo costruire
combinazioni di carico basate sul principio di sovrapposizione degli e�etti. La
rigidezza corrispondente al caso di analisi P-Delta può essere usata anche come
rigidezza di partenza per un'analisi modale in modo da considerare opportu-
namente gli e�etti del secondo ordine anche nelle eventuali analisi a spettro di
risposta.

Come anticipato, le analisi P-Delta vengono solitamente utilizzate allo sco-
po di cogliere gli e�etti globali sulla struttura mentre gli eventuali e�etti locali
vengono tenuti in considerazione attraverso procedure sempli�cate basate sulla
snellezza degli elementi. Qualora si sia utilizzata un'analisi P-Delta e gli elementi
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siano stati opportunamente suddivisi allo scopo di cogliere sia gli e�etti globali
che gli e�etti locali, è opportuno disabilitare tutte le procedura di ampli�cazione
delle sollecitazioni per la valutazione degli e�etti del secondo ordine in fase di
veri�ca.

1.11 Lunghezze libere di in�essione degli elementi

Le lunghezze di libera in�essione degli elementi sono necessarie per la deter-
minazione mediante metodi approssimati degli e�etti locali del secondo ordine
agenti sugli stessi. Tali quantità sono espresse come prodotto dei termini:

Lii = lii · kii · L

in cui:

Lii lunghezza libera di in�essione secondo l'asse i-i
lii rapporto fra la distanza dei punti di supporto dell'elemento e

la lunghezza dell'elemento in esame (Unbraced Lenght Ratio)
kii coe�ciente di lunghezza e�ettiva per lo sbandamento secondo

l'asse i-i (E�ective Lenght Factor)
L lunghezza dell'elemento

Il signi�cato dei termini appena introdotti può essere facilmente interpretato
considerando l'esempio riportato in 5.2.

SAP2000 è dotato di algoritmi per la determinazione automatica dei parame-
tri lii e kii. Il primo viene determinato attraverso il rapporto fra la distanza dei
punti di ritegno del generico elemento e la sua lunghezza, viceversa il secondo
viene calcolato in funzione del rapporto fra la rigidezza �essionale dell'elemento e
quella degli elementi di ritegno laterale. Tale procedura, descritta compiutamen-
te al paragrafo 1.12, è valida per strutture continue a nodi spostabili per le quali
il valore del parametro kii può assumere valori superiori all'unità. Per strutture
a nodi �ssi (controventate) il parametro kii è assunto cautelativamente pari ad
1. Entrambi i valori dei parametri l e k vengono determinati indipendentemente
per entrambe le direzioni principali.

I valori dei parametri così calcolati possono essere sovrascritti in ogni momen-
to dall'utente attraverso il comando Design > Concrete Frame Design >
View/Revise Overwrites. È molto importante che, in fase di veri�ca, venga
sempre controllata la bontà dei parametri utilizzati al �ne di scongiurare even-
tuali grossolani errori di calcolo.
In particolare, in assenza di ritegni laterali ad un estremo dell'asta, il program-
ma assume che il pilastro sia controventato ed assume un valore di kii pari al-
l'unità. Sarà pertanto compito dell'utente sovrascrivere tale valore qualora il
comportamento dell'elemento fosse diverso (ad es. a mensola).
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Figura 1.2: calcolo della luce libera di in�essione degli elementi
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1.12 Calcolo automatico dei coe�cienti di lunghez-
za e�ettettiva (k)

Il programma determina automaticamente i fattori k per elementi asta. Que-
sti fattori k possono essere, se desiderato, sovrascritti dall'utente utilizzando
il comando Design > Steel Frame Design > View/Revise Overwrites.
Per alcuni utili consigli sui modi in cui il programma calcola i fattori k si dia
un'occhiata all'elenco puntato alla �ne di questa sezione.

L'algoritmo per il calcolo del fattore k è stato sviluppato per edi�ci a telaio
continuo, in cui i pilastri sono verticali e le travi orizzontali, per le quali il calcolo
del fattore k risulta relativamente complesso. Ai �ni del calcolo dei fattori k, gli
elementi sono identi�cati come pilastri, travi e controventi. Tutti gli elementi
paralleli all'asse Z vengono classi�cati come pilastri. Tutti gli elementi paralleli
al piano X-Y vengono classi�cati come travi. I rimanenti sono controventi. Alle
travi ed ai pilastri sono assegnati fattori k unitari. Nel calcolo dei fattori k per
un pilastro, il programma esegue per prima cosa le seguenti quattro somme per
ogni nodo nel modello strutturale:

Scx =
∑(

Ec Ic
Lc

)
x

Sbx =
∑(

Eb Ib
Lb

)
x

Scy =
∑(

Ec Ic
Lc

)
y

Sby =
∑(

Ec Ic
Lc

)
y

dove i pedici x e y corrispondono alle direzioni globali X e Y e i pedici c e b
si riferiscono a pilastro e trave. I termini, locali 2-2 e 3-3, EI22/L22 e EI33/I33
vengono ruotati per dare i componenti lungo le direzioni globali X e Y a for-
mare i valori (EI/L)x e (EI/L)y. Quindi per ogni pilastro, le somme nel nodo
all'estremità I e J dell'elemento vengono trasformati all'indietro nel sistema di
coordinate locali 1-2-3 del pilastro e i valori G per gli estremi I e J dell'elemento
vengono calcolati secondo le direzioni 2-2 e 3-3 come segue:

GI22 =
SIc22
SIb22

GJ22 =
SJc22
SJb22

GI33 =
SIc33
SIb33

GJ33 =
SJc33
SJb33

Se esiste un rilascio torsionale in una particolare estremità (e direzione) di un
elemento, il corrispondente valore è impostato a 10.0. Se tutti i gradi di libertà
di un particolare nodo vengono cancellati, il valore G per tutti gli elementi che
si connettono in quel nodo verrà impostato a 1.0 per l'estremità dell'elemento
che si connette a quel nodo. In�ne, se GI e GJ sono noti per una particolare
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direzione, il fattore k del pilastro per la direzione corrispondente viene calcolato
risolvendo la seguente relazione per α:

α2GI GJ − 36

6 (GI +GJ)
=

α

tanα

da cui k = π/α . Questa relazione è la formulazione matematica per la valuta-
zione dei fattori k per telai resistenti a momento assumendo che lo sbandamento
laterale (sidesway) non sia inibito. Per altre strutture, ad esempio strutture a
telaio controventato, i fattori k, per tutti gli elementi, sono usualmente unitari e
dovrebbero essere impostati così dall'utente.

I seguenti aspetti associati all'algoritmo del fattore k per i pilastri, rivestono
una certa importanza:

� Un elemento che ha una cerniera (pin) nel nodo in considerazione non entra
nella sommatoria delle rigidezze riportata sopra. Un elemento che ha una
cerniera (pin) nell'estremità più lontana rispetto al nodo in considerazione
contribuirà solamente per il 50% al valore calcolato di EI. Inoltre, gli
elementi trave che non hanno elementi pilastro nell'estremità più lontana
dal nodo in considerazione, come ad esempio le mensole, non entreranno
nella sommatoria delle rigidezze.

� Se non ci sono travi che si uniscono in un elemento pilastro in una deter-
minata direzione, il valore G associato sarà in�nito. Se il valore G in una
qualunque estremità del pilastro per una particolare direzione è in�nito, il
fattore k corrispondente in quella direzione è impostato all'unità.

� Se i rilasci torsionali esistono in entrambe le estremità dell'elemento per
una particolare direzione, il corrispondente fattore k è impostato all'unità.

� La procedura di calcolo automatico del fattore k può occasionalmente ge-
nerare valori arti�cialmente alti di k, speci�catamente quando vi sono travi
in varie direzioni oppure condizioni di supporto �sso o ancora in altre con-
dizioni in cui il programma potrebbe avere di�coltà a riconoscere che gli
elementi sono supportati lateralmente e che devono essere usati fattori k
unitari.

� Tutti i fattori k generati dal programma possono essere sovrascritti dall'u-
tente. Questi valori dovrebbero essere revisionati e ogni valore inacettabile
dovrebbe essere rimpiazzato.

� Alle travi e ai controventi vengono assegnati valori di k unitari.

14



1.13 Sezioni di analisi e sezioni di progetto

La procedura di progetto/veri�ca integrata all'interno di SAP2000 è forte-
mente interattiva e permette all'utente di variare numerosi dei parametri in gioco
senza dover ripetere l'analisi completa del modello. In particolare, in fase di post
processamento, è possibile assegnare in qualsiasi momento ad un dato elemen-
to una sezione diversa da quella utilizzata nell'analisi. In tal modo è possibile
rilanciare unicamente il processo di veri�ca in modo da avere una rapida stima
dell'e�etto della variazione apportata.

Il comando per assegnare ad un elemento una determinata sezione di progetto
è raggiungibile dal menuDesign > Concrete Frame Design > View/Revise
Overwrites. Alla voce Current Design Section è possibile imporre che la sezione
di progetto sia la medesima utilizzata in fase di analisi, opzione Program Deter-
mined, oppure assegnare come sezione di progetto una qualunque delle sezioni
de�nite.

È importante sottolineare che l'assegnazione di una sezione di�erente da quel-
la utilizzata per l'analisi comporta, in generale, anche una ridistribuzione degli
sforzi sui vari elementi a seguito della variazione di rigidezza introdotta. Risulta
pertanto fondamentale, una volta e�ettuate le modi�che in fase di post processa-
mento, ripetere l'intero processo di analisi e veri�ca utilizzando le sezioni correnti.
Per individuare l'eventuale presenza di elementi con sezione di analisi e progetto
diverse è su�ciente eseguire il comando Design > Concrete Frame Design
> Verify Analysis vs Design Sections.
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Capitolo 2

Procedura di progetto per

elementi in c.a.

In questo capitolo viene descritto il processo di base da seguire per progettare
aste ed elementi piani in calcestruzzo utilizzando SAP2000. Sebbene i passaggi
esatti da seguire possano, in generale, variare da caso a caso, i passi fondamentali
per la progettazione dovrebbero essere simili a quelli descritti di seguito.
Il post processore per il progetto di elementi in calcestruzzo può progettare o
veri�care l'armatura longitudinale e trasversale di pilastri, può progettare l'ar-
matura longitudinale e trasversale di travi e progettare l'armatura longitudinale
bidiriezionale di elementi piani in semplice o doppia armatura.

Nota: Un elemento asta in calcestruzzo viene progettato come una trave o come
un pilastro, in funzione dell'opzione speci�cata all'interno del menu De�ne >
Section properties > Frame Sections come descritto al paragrafo 5.3.

2.1 Sequenza di progetto per elementi frame in
c.a.

Vengono di seguito riportati i passi fondamentali per la corretta progetta-
zione di elementi asta in c.a.. Come anticipato la sequenza o il numero delle
assegnazioni potrà variare da caso a caso ma, in generale, la procedura descritta
sarà su�ciente per eseguire il progetto/veri�ca di un qualunque elemento trave
o pilastro.

1. Creare il modello dell'edi�cio.
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2. Assegnare agli elementi frame la procedura di progettazione scegliendo fra
�Beam� oppure �Column� nel menu De�ne > Section Properties.
Per i pilastri è necessario speci�care se l'elemento debba essere progettato
o veri�cato. Nel primo caso è su�ciente speci�care unicamente la posizione
esatta dei ferri longitudinali, nel secondo è necessario speci�care compiuta-
mente anche l'armatura trasversale.
Per le travi è invece necessario speci�care solamente il valore del copriferro
superiore ed inferiore e l'armatura di estremità (necessaria per il corretto
svoglimento delle veri�che di gerarachia).

Figura 2.1: parametri di progetto per pilastri in c.a.
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Figura 2.2: parametri di progetto per travi in c.a.

3. Eseguire l'analisi dell'edi�cio.

4. Speci�care il codice di veri�ca, scegliendo tra quelli presenti all'interno del
menu Design > Concrete Frame Design > View/Revise Preferen-
ces, e de�nire i parametri generali ad esso associati (se diversi da quelli di
Deafult).

5. De�nire le combinazioni di carico da veri�care attraverso il menu Design
> Concrete Frame Design > Select Design Combos. È possibile
scegliere se utilizzare o meno le combinazioni di default previste per il codice
di calcolo selezionato, inoltre è sempre possibile inserire manualmente delle
combinazioni di carico create dall'utente.

6. Eseguire il progetto/veri�ca degli elementi attraverso il comando Design
> Concrete Frame Design > Start Design/Check of Structure.

7. Revisionare i risultati del progetto attraverso il menuDesign > Concrete
Frame Design > Display Design Info. Attraverso tale comando è
possibile visualizzare a schermo i risultati corrispondenti a tutti gli elementi
frame in calcestruzzo presenti nel modello. Cliccando col pulsante destro
su un qualunque elemento verrà aperta la �nestra dei dettagli di progetto
attraverso cui sarà possibile avere accesso alle procedure di calcolo relative
a tutte le stazioni dell'elemento e corrispondenti a tutte le combinazioni di
carico speci�cate.
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8. Assegnare, se necessario, le sovrascritture agli elementi in calcestruzzo i cui
parametri di progetto non fossero risultati coerenti con le ipotesi fatte. A
tal �ne è possibile operare in due modi: selezionare gli elementi ed asse-
gnare le sovrascritture attraverso il menu Design > Concrete Frame
Design > View/Revise Overwrites, oppure accedere alla �nestra di
dettaglio del singolo elemento e speci�care le sovrascritture cliccando sul
tasto �Overwrites�.

9. Qualora fosse necessario, assegnare una diversa sezione di progetto agli
elementi non veri�cati attraverso il comando Design > Concrete Frame
Design > Change Design Section.

10. Ripetere i passi dal 6 al 9 �nché tutti gli elementi vengono correttamente
progettati o veri�cati.

11. Una volta soddisfatti dei risultati ottenuti, veri�care che tutte le sezioni di
progetto coincidano con le sezioni di analisi attraverso il comando Design
> Concrete Frame Design > Verify Analysis vs Design Section. In
caso a�ermativo la procedura di progetto può considerarsi conclusa, in caso
contrario occorre ristabilire la congruenza fra sezioni di progetto e sezioni di
analisi, rilanciare l'analisi della struttura e ripetere la procedura di progetto
dal punto 6 al punto 10 �no ad ottenere dei risultati soddisfacenti e la totale
coincidenza fra sezioni di analisi e sezioni di progetto.

È importante notare che questo tipo di progettazione è un processo iterativo.
Le sezioni utilizzate nell'analisi originale non sono solitamente le stesse di quelle
ottenute alla �ne del processo di progettazione. È consigliabile eseguire sempre
l'analisi dell'edi�cio utilizzando le sezioni de�nitive delle aste e quindi eseguire
un controllo sul progetto utilizzando le forze corrispondenti.

2.2 Progetto interattivo di elementi frame in c.a.

L'algoritmo di progetto interattivo permette all'utente di intervenire in tempo
reale sui risultati della progettazione in modo da valutare, istantaneamente, gli
e�etti provocati da una qualunque modi�ca nei parametri di progetto di un dato
elemento. Attraverso tale procedura è infatti possibile assegnare una qualsiasi
sovrascrittura all'elemento ed ottenere istantaneamente i risultati aggiornati.

A�nché la modalità di progettazione interattiva sia disponibile, deve essere
stato precedentemente eseguito il comando Design > Concrete Frame Desi-
gn > Start Design Check of Structure. Completata la progettazione, una
volta che i risultati vengono visualizzati a schermo, per intervenire interattiva-
mente è su�ciente cliccare col tasto destro del mouse su un qualunque elemento
frame. Se i risultati della progettazione non sono correntemente visualizzati (ma
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la progettazione è comunque stata eseguita), è necessario accedere al menu De-
sign > Concrete Frame Design > Interactive Concrete Frame Design
e quindi cliccare col tasto destro sull'elemento da modi�care interattivamente.
In entrambi i casi si aprirà una �nestra di dettaglio attraverso la quale sarà pos-
sibile accedere alle sovrascritture dell'elemento attraverso il tasto �Overwrites�
(vedi �gura 6.2). Modi�cando uno qualunque di tali parametri, il programma
aggiornerà di conseguenza il progetto dell'elemento.

Figura 2.3: progettazione interattiva degli elementi frame

2.3 Visualizzazione dei risultati di progetto per
elementi frame in c.a.

I risultati del processo di progettazione degli elementi frame in c.a. possono
essere visualizzati direttamente a schermo oppure in forma tabellare. Nel primo
caso è su�cente accedere al menu Design > Concrete Frame Design >
Display Design Info. È possibile scegliere se visualizzare i dati relativi all'input
oppure all'output di progetto. Le informazioni di input visualizzabili sono:

� Design Sections: sezioni di progetto

� Design Type: tipo di progettazione (trave o pilastro)

� Live Load Reduction Factors: fattore di riduzione del carico acciden-
tale. Viene normalmente assunto pari a 1 (nessuna riduzione) anche se
talvolta, per particolari normative e per particolari condizioni di carico,
può assumere valori inferiori all'unità

21



Parte I Veri�ca elementi in calcestruzzo

� Unbraced Length Ratios: rapporto fra la distanza dei punti di supporto
e la lunghezza dell'elemento (vedi paragrafo 5.8)

� E�ective Lenght Factors: coe�ciente di vincolo (vedi paragrafo 5.8)

Le informazioni relative all'output sono invece:

� Longitudinal Reinforcement: area di armatura longitudinale espressa
nell'unità di misura corrente. Nel caso di travi vengono forniti due valori,
uno superiore per l'armatura a momento negativo, ed uno inferiore per
l'armatura a momento positivo. Nel caso dei pilastri viene fornito un unico
valore da suddividere omogenamente fra le posizioni indicate in fase di
de�nizione della sezione

� Rebar Percentage: percentuale di armatura. Analogamente a quanto
visto per l'armatura longitudinale vengono forniti due valori per le travi
(uno relativo all'armatura superiore ed uno relativo all'armatura infeirore)
ed un unico valore per i pilastri

� Shear Reinforcing: area di armatura trasversale espressa in area per
unità di lunghezza nell'unità di misura corrente

� Column P-M-M Interaction Ratios: coe�cienti di utilizzo a presso-
tenso �essione biassiale per i pilastri

� Identify P-M failure: identi�cazione delle rotture a presso-tenso �essione

� Identify Shear Failure: identi�cazione delle rotture a taglio

� Identify All Failures: identi�cazione di tutti i tipi di rottura

Vi sono poi delle grandezze di output che variano a seconda della normativa
selezionata, come ad esempio, per l'EC2-2004:

� 1.3 Beam/Column Capacity Ratios: rapporti di resistenza trave-pilastro
ampli�cati per la sovraresistenza

� Column/Beam Capacity Ratios: rapporti di resistenza pilastro-trave

� Joint Shear Reinforcing: armatura a taglio per i nodi trave-pilastro

� Joint Shear Capacity Ratios: rapporti di capacità a taglio per i nodi
trave-pilastro

In alternativa i risultati possono essere esportati in forma tabellare attraverso
il comando Display > Show Tables > DESIGN DATA scegliendo fra le
opzioni:

� Column Summary Data: dettagli relativi al progetto dei pilastri
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� Beam Summary Data: dettagli relativi al progetto delle travi

� Joint Summary Data: dettagli relativi al progetto dei nodi trave-pilastro

All'interno di tali tabelle sono riportate, in forma condensata, tutte le informa-
zioni visualizzabili a schermo sul modello coi metodi visti inprecedenza.

2.4 Sequenza di progetto per elementi piani in c.a.

Viene di seguito riportata la procedura di calcolo dell'armatura longitudinale
di elementi piani in c.a.. Attraverso tali passaggi sarà possibile progettare cor-
rettamente l'armatura di setti, solette e qualsiasi altro elemento soggetto a forze
membranali e �essione fuori piano.

� Costruire il modello, assegnare la procedura di progetto alle sezioni di tipo
area (come descritto al paragrafo 5.3) ed eseguire l'analisi dell'edi�cio.

� Una volta completata l'analisi entrare nel menu Display > Show Forces
Stresses > Shells, selezionare la combinazione di interesse e alla voce
�Component Type� scegliere �Concrete Design�.

� Nel riquadro �Component� selezionare quale fra i possibili output si vuole
visualizzare.

2.5 Visualizzazione dei risultati di progetto per
elementi piani in c.a.

All'interno del menu Display > Show Forces Stresses > Shells sele-
zionando la voce �Concrete Design� è possibile scegliere fra i seguenti output a
video:

� N11, N22: forze assiali equivalenti, per unità di lunghezza, agenti sugli
strati esterni nelle due direzioni del piano della shell

� N12: forza membranale di taglio, per unità di lunghezza, nel piano della
shell

� NMax, NMin: forze membranali principali massime e minime, per unità
di lunghezza, agenti sugli strati esterni

� NDes1, NDes2: forze di progetto, per unità di lunghezza, sulle armature
nelle due direzioni del piano della shell

� ASt1, ASt2: area di armatura, per unità di lunghezza, richiesta lungo le
due direzioni del piano della shell

23



Parte I Veri�ca elementi in calcestruzzo

� Fc, Sc: forze e tensioni di compressione principali sugli strati esterni
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Capitolo 3

Progetto secondo Eurocodice

2 ed Eurocodice 8

Nel presente capitolo verranno descritte le procedure di calcolo implementate
all'interno di SAP2000 per la veri�ca degli elementi in cemento armato secondo
l'Eurocodice 2-2004 integrato con le prescrizioni sismiche presenti nell'Eurocodice
8-2004. Per semplicità, tutte le equazioni riportate nel presente capitolo sono
espresse in Newton-millimetri-secondi, salvo dove diversamente speci�cato.

3.1 Notazioni

Tutte le notazioni ed i simboli usati nel presente capitolo sono di seguito ri-
portati:

Ac Area di calcestruzzo per la resistenza a taglio, mm2

Ag Area del solo calcestruzzo, mm2

Ak Area e�cace per la torsione, mm2

As Area armatura longitudinale tesa, mm2

A′
s Area armatura longitudinale compressa, mm2

Asl Area armatura longitudinale a torsione, mm2

At/s Area armatura trasversale a torsione per unità di lunghezza,
mm2/mm

Asw/s Area armatura trasversale a taglio per unità di lunghezza,
mm2/mm
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Ec Modulo di elasticità del calcestruzzo, MPa

Es Modulo di elasticità dell'acciaio, pari a 200000MPa

Ig Momento d'inerzia della sezione di calcestruzzo, al netto delle
armature, rispetto agli assi baricentrici, mm4

M01 Minimo momento fattorizzato all'estremità di un pilastro, Nmm

M02 Massimo momento fattorizzato all'estremità di un pilastro,
Nmm

MEd Momento di calcolo, comprensivo degli e�etti del secondo ordine
da considerare in fase di progetto, Nmm

M0Ed Momento equivalente del primo ordine (EC2 5.8.8.2), Nmm

M2 Momento del secondo ordine calcolato col metodo della
Curvatura Nominale (EC2 5.8.8), Nmm

M22 Momento fattorizzato del primo ordine attorno all'asse 2, Nmm

M33 Momento fattorizzato del primo ordine attorno all'asse 3, Nmm

NB Carico assiale di instabilità, N

NEd Carico assiale fattorizzato, N

TEd Momento torcente fattorizzato, Nmm

VEd Sforzo di taglio fattorizzato, N

VRd,c Resistenza a taglio in assenza di armatura trasversale, N

VRd,max Resistenza a taglio delle bielle compresse in calcestruzzo, N

a Altezza dello stress-block, mm

amax Altezza massima consentita per lo stress-block, mm

b Larghezza della sezione, mm

bf Larghezza e�ettiva dell'ala/�angia (travi a T), mm

bw Larghezza dell'anima (travi a T), mm

d Distanza dal lembo compresso all'armatura tesa, mm

d′ Distanza dal lembo compresso all'armatura compressa, mm

ds Spessore dell'ala/�angia (travi a T), mm

e2 Freccia dovuta alla curvatura per il metodo della curvatura
nominale (EC2 5.8.8), mm

ei Eccentricità dovuta alle imperfezioni geometriche (EC2 5.2),
mm
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emin Eccentricità minima (EC2 6.1), mm

fcd Resistenza a compressione di progetto del calcestruzzo (EC2
3.1.6), MPa

fctm Resistenza a trazione media del calcestruzzo, MPa

fyd Tensione di snervamento di progetto dell'acciaio (EC2 3.2),
MPa

h Altezza della sezione del pilastro, mm

l0 Lunghezza libera di in�essione dell'elemento, mm

lu Distanza fra i vincoli di estremità dell'elemento, mm

r Raggio giratore della sezione del pilastro, mm

tef Spessore e�ettivo delle pareti della sezione per la torsione, mm

u Perimetro esterno della sezione, mm

uk Perimetro esterno dell'area Ak, mm

x Profondità dell'asse neutro, mm

αcc Coe�ciente riduttivo delle resistenza a compressione del
calcestruzzo per gli e�etti a lungo termine (EC2 3.1.6)

αct Coe�ciente riduttivo delle resistenza a trazione del calcestruzzo
per gli e�etti a lungo termine (EC2 3.1.6)

αlcc Coe�ciente riduttivo delle resistenza a compressione dei
calcestruzzi leggeri per gli e�etti a lungo termine (EC2 11.3.5)

αlct Coe�ciente riduttivo delle resistenza a trazione dei calcestruzzi
leggeri per gli e�etti a lungo termine (EC2 11.3.5)

εc Deformazione nel calcestruzzo

εcu2 Deformazione ultima nel calcestruzzo (0.0035mm/mm)

εs Deformazione nell'acciaio

γc Coe�ciente parziale di sicurezza per il calcestruzzo (EC2 2.4.2.4)

γs Coe�ciente parziale di sicurezza per l'acciaio (EC2 2.4.2.4)

λ Coe�ciente moltiplicativo per l'altezza e�ettiva dello stress-
block (EC2 3.1.7)

η Coe�ciente moltiplicativo per la resistenza e�ettiva dello stress-
block (EC2 3.1.7)

θ Angolo fra le bielle di calcestruzzo e l'asse dell'elemento nel
meccanismo reistente a traliccio per il taglio
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θi Inclinazione dovuta alle imperfezioni geometriche (EC2 5.2)

θ0 Inclinazione base dovuta alle imperfezioni geometriche (EC2 5.2)

3.2 Assunti e limitazioni

I seguenti assunti e limitazioni sono presenti nella corrente implementazione
dell'Eurocodice 2-2004:

� Il progetto di sezioni non armate o debolmente armate non è implementato

� Il progetto di sezioni precompresse non è implementato

� Gli stati limite di esercizio non sono implemetati

� Il progetto per la resistenza al fuoco non è implementato

� Di default le veri�che vengono condotte con i coe�cienti parziali dei ma-
teriali relativi a situazioni di progetto �Persistenti e Transitorie� (EC2
2.4.2.4). Per situazioni di progetto diverse occorre intervenire modi�cando
le opzioni di progetto prede�nite

� Si assume che la struttura da progettare sia un Edi�cio. Strutture speciali
o di altro tipo, quali ponti, piattaforme o�-shore, serbatoi in pressione ecc...
devono essere investigate autonomamente

� Si assume che le azioni considerate siano conformi alle prescrizioni contenute
nell'Eurocodice 1

� Il programma utilizza la resistenza cilindrica piuttosto che la resistenza
cubica

� Il programma non esegue il controllo delle prescrizioni geometriche sulle
dimensioni e�caci delle sezioni (EC2 5.3.1 - 5.3.2)

� Si assume che l'utente utilizzi resistenze e copriferri in accordo coi limiti
imposti dalla normativa (EC2 3.1.2(3) EC2 4.4.1.2)

� Il modulo di elasticità dell'acciaio è assunto pari a 200 GPa (EC2 3.2.7(4))

3.3 Combinazioni di carico di progetto

Le combinazioni di carico di progetto rappresentano le combinazioni delle
azioni per le quali la struttura deve essere veri�cata. L'Eurocodice 0-2002 pre-
vede che le combinazioni statiche di progetto possano essere de�nite sulla base
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delle equazioni 6.10, 6.10a e 6.10b dell'EC0; mentre le combinazioni di carico
comprendenti azioni sismiche sono generate con riferimento all'equazione 6.12b
dell'EC0:

∑
j≥1

γG,jGk,j + γPP + γQ,1Qk,1 +
∑
i>1

γQ,iψ0,iQk,i (EC0 Eq. 6.10)

∑
j≥1

γG,jGk,j + γPP + γQ,1ψ0,1Qk,1 +
∑
i>1

γQ,iψ0,iQk,i (EC0 Eq. 6.10a)

∑
j≥1

ξjγG,jGk,j + γPP + γQ,1Qk,1 +
∑
i>1

γQ,iψ0,iQk,i (EC0 Eq. 6.10b)

∑
j≥1

Gk,j + P +AEd +
∑
i≥1

ψ2,iQk,i (EC0 Eq. 6.12b)

Per esempio, se una struttura risultasse soggetta all'azione di un carico per-
manente (D), un carico variabile (L), un carico da vento (V) ed un carico sismico
(E) le combinazioni generate sarebbero le seguenti:

� Combinazioni statiche nel caso si speci�chi l'utilizzo dell'equazione 6.10:

γG,supD

γGsupD + γQL

γG,sup ± γQW
γG,inf ± γQW

γG,sup + γQL± γQψ0,WW

γG,sup + γQψ0,LL± γQW
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Parte I Veri�ca elementi in calcestruzzo

� Combinazioni statiche nel caso si speci�chi l'utilizzo delle equazioni 6.10a,b:

γG,supD

ξγG,supD

γGsupD + γQψ0,LL

ξγGsupD + γQL

γG,sup ± γQψ0,WW

γG,inf ± γQψ0,WW

ξγG,sup ± γQW
γG,inf ± γQW

γG,sup + γQψ0,LL± γQψ0,WW

ξγG,inf + γQL± γQψ0,WW

ξγG,inf + γQψ0,LL± γQW

� Combinazioni sismiche:

D ± E
D + ψ2,LL± E

Per i coe�cienti parziali delle azioni e i coe�cienti di combinazione vengono
utilizzati i seguenti valori:

γG,sup = 1.35

γG,inf = 1.00

γQ = 1.5

ψ0,L = 0.7 (carico variabile, non deposito)

ψ0,W = 0.3

ξ = 0.85

ψ2,L = 0.3 (carico variabile per u�ci o residenze)
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3.4 Progetto di pilastri

SAP2000 può essere usato sia per il progetto che per la veri�ca di pilastri in
c.a.. In entrambi i casi è necessario che la posizione delle barre di armatura nella
sezione sia stata compiutamente de�nita. La procedura seguita dal programma
in questa fase è di seguito risportata:

� Generazione delle super�ci di interazione biassiale per tutte le sezioni di tipo
pilastro de�nite nel modello. Qualora l'elemento debba essere progettato,
il programma calcola una serie di super�ci di interazione facendo variare
l'armatura da un minimo dello 0.2% �no ad un massimo del 4% (EC2 9.5.2).

� Progetto/Veri�ca a presso-tenso �essione biassiale: nel primo caso il pro-
gramma calcola l'area di armatura longitudinale da suddividere omogenea-
mente nelle posizioni speci�cate, in modo che il massimo fattore di uti-
lizzo dell'elemento sia pari al valore limite (tipicamente 1); nel secondo
caso il programma calcola il fattore di utilizzo corrispondente all'armatura
longitudinale speci�cata.

� Progetto dell'armatura a taglio.

I seguenti paragra� descrivono nel dettaglio le varie fasi sopra indicate.

3.4.1 Generazione delle super�ci di interazione biassiale

Il dominio resistente di un pilastro rappresenta gli stati di presso-tenso �essio-
ne biassiale che possono essere ripresi dall'elemento stesso. Il volume del dominio
resistente viene calcolato a partire da una serie di punti discreti che giacciono
sulla super�cie di contorno dello stesso. Tali punti vengono calcolati facendo
ruotare un piano a deformazione lineare nelle tre dimensioni sulla sezione del
pilastro, come mostrato in 3.1.

I diagrammi delle deformazioni utilizzati limitano la deformazione del calce-
struzzo all'estremità del lembo compresso al 3.5�così come previsto nell'EC2
tab. 3.1. Un esempio di super�cie di interazione relativa ad un pilastro è mo-
strato in 3.2. La formulazione utilizzata nel calcolo è conforme ai principi della
progettazione agli stati limite ultimi (EC2 6.1).

La tensione nelle barre di armatura è data dal prodotto della deformazione
dell'acciaio per il modulo di elasticità dello stesso, εsEs ed è limitata alla tensione
di snervamento di progetto fyd (EC2 3.2.7). L'area associata a ciascuna barra di
armatura è concentrata nel baricentro della stessa e il programma non assume
alcuna limitazione al posizionamento delle barre sulla sezione.

La distribuzione di tensioni nel calcestruzzo è schematizzata attraverso l'uso
di uno stress-block rettangolare, con una resistenza e�ettiva pari a ηfcd (EC2
3.1.7) ed un'altezza complessiva pari a λx, come mostrato in 3.3.
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Parte I Veri�ca elementi in calcestruzzo

Figura 3.1: distribuzione delle deformazioni per il calcolo dei punti di contorno
del dominio di resistenza
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Figura 3.2: esempio di super�cie di interazione biassiale di un pilastro

Figura 3.3: distribuzione degli sforzi e delle deformazioni all'interno della sezione
del pilastro
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Parte I Veri�ca elementi in calcestruzzo

Il coe�ciente di riduzione η è assunto pari a:

η = 1.0 per fck ≤ 50MPa (EC2 Eq. 3.21)

η = 1.0− (fck − 50)

200
per 50 < fck ≤ 90MPa (EC2 Eq. 3.22)

mentre il fattore λ vale:

λ = 0.8 per fck ≤ 50MPa (EC2 Eq. 3.19)

η = 0.8− (fck − 50)

400
per 50 < fck ≤ 90MPa (EC2 Eq. 3.20)

L'altezza totale dello stress block è pertanto espressa dalla relazione:

a = λx

in cui x è l'altezza totale della zona compressa. L'algoritmo di calcolo è inoltre
dotato di un meccanismo di correzione per tener conto dell'area di calcestruzzo
compresso occupata dalle barre di armatura.

Gli e�etti dei coe�cienti di sicurezza dei materiali, γc e γs, e gli e�etti dei
coe�cienti riduttivi per gli e�etti a lungo termine, αcc, αct, αlcc e αlct, sono
tenuti in considerazione nella generazione delle super�ci di interazione. I valori
di tali parametri sono quelli di default ma possono essere cambiati in qualsiasi
momento all'interno del menu Design > Concrete Frame Design > View
Revise Preferences.

3.4.2 Progetto/Veri�ca a presso-tenso �essione biassiale

I fattori di utilizzo P-M-M vengono calcolati, elemento per elemento, per ogni
stazione di progetto e per ogni combinazione di carico. La procedura consta dei
seguenti passi:

� Determinazione, dalle combinazioni di carico considerate, delle forze e dei
momenti del primo ordine fattorizzati: NEd, M22 e M33.

� Eventuale ampli�cazione dei momenti dovuti agli e�etti locali del secon-
do ordine attraverso una delle procedure prede�nite descritte al paragrafo
3.4.2.2

� Calcolo dei momenti di progetto

� Determinazione del fattore di utilizzo in funzione della posizione del punto
sollecitante nello spazio del dominio resistente
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3.4.2.1 Determinazione dei momenti del primo ordine

I valori NEd, M22 ed M33 delle sollecitazioni corrispondenti ad una data
combinazione forniscono la base di partenza per il progetto/veri�ca dell'elemento.
I valori dei momenti così ottenuti sono ulteriormente incrementati per tener conto
della possibile eccentricità ei dovuta ad imperfezioni geometriche:

ei = θi
l0
2

(EC2 Eq. 5.2)

in cui l0 è la lunghezza libera di in�essione dell'elemento e θi rappresenta l'incli-
nazione di imperfezione pari a:

θi = θ0αhαm (EC2 Eq. 5.1)

con:

θ0 inclinazione di base, de�nita come rap-
porto e sovrascrivibile nelle preferenze di
progettazione

αh = 2/
√
l coe�ciente di riduzione relativo all'altezza

l lunghezza dell'elemento in esame

αm =
√

0.5(1 + 1/m) coe�ciente di riduzione relativo al numero
di elementi

m numero degli elementi verticali che contri-
buiscono all'e�etto totale

Deve inoltre risultare:

ei ≥ emin = h/30 ≥ 20mm (EC2 6.1)

con h altezza della sezione del pilastro nella direzione in esame.
I momenti totali del primo ordine, includenti gli e�etti delle imperfezioni geome-
triche, sono quindi calcolati come:

M22 = M22 + ei2NEd

M33 = M33 + ei3NEd

I momenti del primo ordine generati dalla presenza delle imperfezioni geometriche
o dalla eccentricità minima, se maggiore, sono considerati agenti in una direzione
alla volta.

3.4.2.2 Determinazione dei momenti del secondo ordine

Ai �ni della valutazione degli e�etti del secondo ordine si assume che:
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Parte I Veri�ca elementi in calcestruzzo

� Gli e�etti Globali sulla struttura siano stati inclusi in fase di analisi me-
diante:

� Un'analisi elastica del secondo ordine (P-∆)

� Applicando delle forze orizzontali �ttizie come espresso nell'allegato H
ell'EC2

L'utente può condurre un'analisi lineare del primo ordine priva di non li-
nearità geometriche qualora la condizione espressa al 5.8.3.3(1) dell'EC2
risultasse soddisfatta.

� Gli e�etti Locali sugli elementi vengano inclusi scegliendo fra una delle
seguenti opzioni nelle preferenze di veri�ca:

� �Metodo della rigidezza nominale� (EC2 5.8.7)

� �Metodo della curvatura nominale� (EC2 5.8.8)

� �None� nel caso in cui anche gli e�etti locali del secondo ordine sia-
no stati inclusi nell'analisi, oppure la snellezza dell'elemento risulti
inferiore al valore limite (EC2 5.8.3.1(1))

3.4.2.2.1 Metodo della rigidezza nominale

Secondo il metodo della rigidezza nominale, il momento totale di progetto,
comprensivo degli e�etti locali del secondo ordine, può essere espresso attraverso
la relazione:

MEd = M0Ed

1 +
β

NB
NEd

− 1

 (EC2 Eq. 5.28)

in cui:

M0Ed momento del primo ordine equivalente pari a
M0Ed = 0.6M02 + 0.4M01 ≥ 0.4M02 (EC2 Eq.
5.32)

M01 e M02 momenti di estremità del pilastro, con il rispettivo
segno, tali che |M02| ≥ |M01|

β =
π2

c0
coe�ciente che dipende dalla distribuzione dei
momenti del primo e del secondo ordine

c0 coe�ciente che dipende dalla distribuzione dei
momenti del primo ordine assunto, in favore di
sicurezze, pari a 8 (momento �ettente costante
sull'elemento)
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NB =
π2EI

l20
carico critico basato sulla rigidezza nominale

EI = 0.3EcIg rigidezza nominale dell'elemento (EC2 5.8.7.2(3))

Ec valore di progetto del modulo di elsaticità del
calcestruzzo

Ig momento d'inerzia della sola sezione di calcestruz-
zo nella direzione in esame

l0 lunghezza libera di in�essione dell'elemento lun-
go la direzione in esame (calcolato come visto al
paragrafo 5.8)

Il metodo della rigidezza nominale viene applicato, separatamente, per en-
trambe le due direzioni del piano.
N.B.Il valore della rigidezza nominale utilizzato non tiene conto degli e�etti
viscosi e potrebbe risultare in sfavore di sicurezza nel caso questi ultimi siano di
entità rilevante (EC2 Eq. 5.26).

3.4.2.2.2 Metodo della curvatura nominale

Secondo il metodo della curvatura nominale, il momento totale di progetto,
comprensivo degli e�etti locali del secondo ordine, può essere espresso attraverso
la relazione:

MEd = M0Ed +M2 (EC2 Eq. 5.31)

in cui:

M0Ed momento del primo ordine equivalente pari a
M0Ed = 0.6M02 + 0.4M01 ≥ 0.4M02 (EC2 Eq.
5.32)

M2 = NEde2 momento aggiuntivo del secondo ordine

NEd sforzo assiale di progetto

e2 =

(
1

r

)
l20
2

in�essione dovuta alla curvatura

1

r
= KrKφ

1

r0
curvatura

Kr coe�ciente correttivo che dipende dal carico as-
siale, assunto in favore di sicurezza pari ad 1 (EC2
Eq. 5.36)

37



Parte I Veri�ca elementi in calcestruzzo

Kφ coe�ciente che tiene conto della viscosità, assunto
pari a 1

1

r0
=

εyd

0.45d
curvatura di base

Il metodo della curvatura nominale viene applicato, separatamente, per en-
trambe le due direzioni del piano.
N.B. Il valore di Kφ utilizzato non tiene conto degli e�etti viscosi e potrebbe
risultare in sfavore di sicurezza nel caso questi ultimi siano di entità rilevante
(EC2 Eq. 5.37).

3.4.2.3 Calcolo del coe�ciente di utilizzo

Qualora nelle impostazioni di sezione si sia speci�cato che il pilastro debba es-
sere veri�cato, il programma procede al calcolo del relativo coe�ciente di utilizzo
per ogni stazione ed ogni combinazione di progetto. Il coe�ciente di utilizzo for-
nisce una misura dello stato di sollecitazione dell'elemento rispetto alle capacità
resistenti dello stesso.

Il calcolo del coe�ciente di utilizzo avviene plottando nello spazio delle solle-
citazioni le terne NEd, MEd2 ed MEd3 (calcolati coi metodi visti in precedenza)
e veri�cando se esse siano interne od esterne al volume del dominio resistente.
Nel primo caso l'elemento risulta veri�cato, nel secondo caso l'elemento risulta
sovraccaricato. Il valore numerico del coe�ciente di utilizzo è dato dal rapporto
fra la distanza OL, che rappresenta la distanza fra il punto sollecitante e l'origine
dello spazio delle sollecitazioni, e la distanza OC fra la proiezione, lungo OL,
del punto L sulla super�cie di rottura e l'origine dello spazio delle sollecitazioni.
A�nché l'elemento risulti veri�cato occorre che si abbia OL/OC ≤ 1.

Il fattore di utilizzo globale di un pilastro è dato dal massimo valore del fattore
di utilizzo delle sue stazioni relativo a tutte le combinazioni di carico di progetto.

3.4.2.4 Progetto dell'armatura longitudinale

Qualora nelle impostazioni di sezione si sia speci�cato che il pilastro debba
essere progettato, il programma calcola l'area di armatura in grado di produrre
un rapporto di utilizzo massimo pari al limite �ssato nelle preferenze di progetto.
Tale area è suddivisa uniformemente nelle posizioni speci�cate nella de�nizione
della sezione.

3.4.3 Progetto dell'armatura a taglio

L'armatura a taglio è calcolata, per ogni combinazione di progetto, per en-
trambe le direzioni del piano della sezione. La procedura di progetto dell'arma-
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Figura 3.4: rappresentazione geometrica del coe�ciente di utilizzo di un pilastro

tura a taglio di un particolare pilastro, per una particolare combinazione, in una
data direzione, include i seguenti passaggi:

� Determinazione delle azioni di progetto agenti sulla sezione: NEd e VEd.

� Determinazione della resistenza dell'elemento privo dell'armarura a taglio:
VRd,c.

� Determinazione del massimo taglio che può essere ripreso dalle bielle com-
presse in calcestruzzo: VRd,max.

� Determinazione dell'armatura a taglio per unità di lunghezza richiesta:
Asw/s.

I paragra� seguenti descriveranno nel dettaglio le fasi di calcolo, che verranno
ripetute indipendentemente per le entrambe le direzioni del piano della sezione. È
importante sottolineare che la procedura di progetto per azioni taglianti, essendo
basata sullo schema resistente a traliccio, è valida solamente per sezioni di forma
�canonica� quali sezioni rettangolari e sezioni circolari. Per sezioni generiche
pertanto, la progettazione non può prescindere da un calcolo diretto da parte
dell'utente attraverso schemi sempli�cati. Alla luce di quanto detto, tutte le
espressioni utilizzate nel calcolo si basano sulle seguenti ipotesi:
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Parte I Veri�ca elementi in calcestruzzo

� Per sezioni rettangolari, bw rappresenta la larghezza della sezione, d l'altez-
za utile e Ac è l'area e�cace a taglio, data dal prodotto bwd.

� Per sezioni circolari bw viene sostituito con D, che rappresenta il diametro
esterno del pilastro, d è sostituito con 0.8D e Ac è espresso dall'area πD2/4.

� Per sezioni di forma generica il programma si di riconduce ad una sezione
rettangolare equivalente calcolando i valori di bw e d in funzione delle di-
mensioni del minimo rettangolo inscrivente la sezione. In quest'ultimo caso
l'a�dabilità della procedura deve essere attentamente valutata da parte
dell'utente.

3.4.3.1 Determinazione del taglio di progetto

Le forze di progetto, NEd e VEd, per un dato elemento dovute ad una par-
ticolare combinazione di carico, sono ottenute fattorizzando i vari casi di carico
presenti in combinazione attraverso i corrispondenti moltiplicatori.

3.4.3.2 Determinazione della resistenza a taglio di elementi non ar-
mati

Date le sollecitazioni di progetto NEd e VEd, la massima forza di taglio che
può essere ripresa in assenza di un'armatura speci�ca è data da:

VRd,c =
[
CRd,ck (100ρlfck)

1/3
+ k1σcp

]
bwd (EC2 Eq. 6.2a)

con un minimo di:

VRd,c = (νmin + k1σcp) bwd (EC2 Eq. 6.2b)

in cui fck è espressa in MPa mentre k, ρl e σcp sono calcolati come:

k = 1 +

√
200

d
≤ 2 con d espresso in mm (EC2 6.2.2(1))

ρl =
As
bwd
≤ 0.02 (EC2 6.2.2(1))

σcp =
NEd
Ac

< 0.2fcd (EC2 6.2.2(1))

L'area di calcestruzzo resistente al taglio, Ac, è calcolata sulla base delle ipotesi
fatte in precedenza. I fattori k1,CRd,c e νmin sono espressi dalle relazioni:

k1 = 0.15 (EC2 6.2.2(1))

CRD,c =
0.18

γc
(EC2 6.2.2(1))

νmin = 0.0035k3/2f
1/2
ck (EC2 Eq. 6.3N)
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3.4.3.3 Determinazione della massima resistenza a taglio

La forza di progetto a taglio, VEd, è limitata al valore VRd,max, corrispon-
dente alla rottura per schiacciamento delle bielle di calcestruzzo compresse del
meccanismo resistente. Se il valore di VEd supera tale limite, il programma resti-
tuisce un messaggio di errore. La resistenza a �taglio-compressione� è calcolata
attraverso la relazione:

VRd,max = αcwbwzν1fcd

(
1

cot θ + tan θ

)
(EC2 Eq. 6.9)

in cui:

αcw coe�ciente che tiene conto dell'interazione fra
la tensione nel corrente compresso e qualsiasi
tensione di compressione assiale. Tale valore è
assunto pari a 1, che è il valore raccomandato
per strutture prive di presollecitazione.

ν1 = 0.6

[
1− fck

250

]
coe�ciente di riduzione della resistenza che
tiene conto dello stato di fessurazione del
alcestruzzo (EC2 Eq. 6.6N).

z = 0.9d braccio della coppia interna.

θ angolo compreso fra il puntone compresso di
calcestruzzo e l'asse della trave. Tale valore
viene, per i pilastri, assunto cutelativamente
pari a 45°.

3.4.3.4 Determinazione dell'armatura a taglio

Qualora VEd risulti maggiore di VRd,c e minore di VRd,max, l'armatura a taglio
necessaria, espressa come area per unità di lunghezza, Asw/s, viene calcolata
attraverso la relazione:

Asw
s

=
VEd

zfywd cot θ
(EC2 Eq. 6.8)

Alla �ne del processo di progettazione viene riportato, per ogni stazione e per
ognuna delle due direzioni del piano della sezione, il massimo fra tutti i valori del
rapporto Asw/s, calcolati per le varie combinazioni di carico.

È importante sottolineare che il calcolo delle armature a taglio è basato pura-
mente su criteri di resistenza, pertanto non viene e�ettuato nessun controllo su
eventuali minimi quantitativi di armatura previsti dalla normativa.
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Parte I Veri�ca elementi in calcestruzzo

3.5 Progetto di travi

Durante la fase di progetto di una trave in c.a. il programma calcola e riporta
l'area di armatura necessaria per la �essione, il taglio e la torsione basandosi sui
momenti �ettenti, il taglio e la torsione derivanti dalle combinazioni di progetto.
Tutte le travi sono calcolate per �essione attorno all'asse forteM3, taglio associato
V2 e torsione T . Eventuali e�etti dovuti ad azioni assiali o a �essioni lungo l'asse
debole M2 devono essere investigati a parte dall'utente. la procedura di progetto
di una trave in c.a. consta dei seguenti passaggi:

� Progetto dell'armatura longitudinale.

� Progetto dell'armatura a taglio.

� Progetto dell'armatura a torsione.

3.5.1 Progetto dell'armatura longitudinale

L'armatura longitudinale superiore ed inferiore delle travi è progettata per
tutte le stazioni di output impostate. I momenti �ettenti di calcolo vengono ri-
cavati direttamente dalle combinazioni di carico di progetto de�nite. Momenti
�ettenti positivi generano armatura inferiore, in tal caso la sezione è progettata
come sezione rettangolare o sezione a T; viceversa momenti negativi produco-
no armatura superiore, in tal caso la sezione è sempre progettata come sezione
rettangolare.

Nel calcolo dell'armatura longitudinale, il programma determina sia l'arma-
tura tesa che l'armatura compressa. Quest'ultima viene calcolata solamente nel
caso in cui il momento di progetto superi la capacità massima della sezione in sem-
plice armatura. in tal caso viene aggiunto un quantitativo di armatura compressa
nell'ipotesi che il momento addizionale venga ripreso dall'armatura compressa e
dalla corrispondente aggiunta di armatura tesa. L'utente può evitare la necessità
di utilizzare armatura compressa aumentando l'altezza utile, la larghezza della
sezione oppure la classe del calcestruzzo. L'algoritmo di progetto è basato su
una distribuzione sempli�cata delle tensioni nel calcestruzzo (EC2 3.1.7(3)), co-
me mostrato in �gura 3.5.1.1. L'e�ettiva altezza λx e resistenza ηfcd dello stress
block utilizzato sono date dalle relazioni:

λ = 0.8 per fck ≤ 50MPa (EC2 Eq. 3.19)

η = 0.8− (fck − 50)

400
per 50 < fck ≤ 90MPa (EC2 Eq. 3.20)
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η = 1.0 per fck ≤ 50MPa (EC2 Eq. 3.21)

η = 1.0− (fck − 50)

200
per 50 < fck ≤ 90MPa (EC2 Eq. 3.22)

Gli e�etti dei coe�cienti di sicurezza dei materiali, γc e γs, e gli e�etti dei
coe�cienti riduttivi per gli e�etti a lungo termine, αcc, αct, αlcc e αlct, sono tenuti
in considerazione nella procedura di progettazione. I valori di tali parametri sono
quelli di default ma possono essere cambiati in qualsiasi momento all'interno del
menu Design > Concrete Frame Design > View Revise Preferences.

Il valore limite dell'altezza dell'asse neutro, espresso come rapporto (x/d)lim,
è dato dalle relazioni:(x

d

)
lim

=
δ − k1
k2

per fck ≤ 50MPa (EC2 Eq. 5.10a)

(x
d

)
lim

=
δ − k3
k4

per 50 < fck ≤ 90MPa (EC2 Eq. 5.10b)

in cui:

k1 = 0.44 (EC2 5.5(4))

k2 = 1.25

(
0.6 +

0.0014

εcu2

)
(EC2 5.5(4))

k3 = 0.54 (EC2 5.5(4))

k2 = 1.25

(
0.6 +

0.0014

εcu2

)
(EC2 5.5(4))

εcu2 = 0.0035 per fck ≤ 50MPa (EC2 Table 3.1)

εcu2 = 2.6 + 35

[
(90− fck)

100

]4
per 50 < fck ≤ 90MPa(EC2 Table 3.1)

δ è, in�ne, un coe�ciente che tiene conto dell'eventuale ridistribuzione dei mo-
menti �ettenti. Poiché non è stata ipotizzata alcuna ridistribuzione si ha δ =
1.

3.5.1.1 Calcolo dell'armatura longitudinale per travi rettangolari

Per sezioni rettangolari, in base allo schema di calcolo mostrato in �gura
3.5.1.1, il momento di progetto normalizzato, m, e il momento resistente massimo
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Parte I Veri�ca elementi in calcestruzzo

nel caso di semplice armatura, mlim, sono dati dalle relazioni:

m =
MEd

ηfcdbd2

mlim = λ
(x
d

)
lim

[
1− λ

2

(x
d

)
lim

]

Figura 3.5: progetto dell'armatura longitudinale di una trave rettangolare

L'area di armatura longitudinale necessaria è calcolata distinguendo il
caso di momento sollecitante minore del momento limite da quello di momento
sollecitante maggiore:

� Se m ≤ mlim, la trave può essere progettata in semplice armatura. Il
rapporto meccanico di armatura ω e l'area di armatura richiesta As sono
calcolati attraverso le relazioni:

ω = 1−
√

1− 2m

As = ω

(
ηfcdbd

fyd

)
Tale area va disposta nella parte inferiore della sezione se il momento m è
positivo, viceversa nella parte superiore se m è negativo.

� Sem > mlim, è necessario inserire dell'armatura A′s anche in zona compres-
sa. Il calolo dei rapporti meccanici di armatura ωlim, ω′ e ω è e�ettuato
attraverso le relazioni:

ωlim = λ
(x
d

)
lim

= 1−
√

1− 2mlim
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ω′ =
m−mlim

1− d′/d
ω = ωlim + ω′

In cui d′ è il copriferro dell'armatura compressa. Le aree totali di armatura,
compressa A′s, e tesa As sono date dalle relazioni:

A′s = ω′
(
ηfcdbd

f ′s

)

As = ω

(
ηfcdbd

fyd

)
in cui f ′s è la tensione nell'armatura compressa:

f ′s = Esεc

[
1− d′

xlim

]
≤ fyd

As va disposta nella parte inferiore della sezione ed A′s nella parte superiore
se il momento m è positivo; viceversa As va posta nella parte superiore ed
A′s nella parte inferiore se m è negativo.

3.5.1.2 Calcolo dell'armatura longitudinale per travi a T

Per sezioni a T, lo schema di calcolo è mostrato in �gura 3.5.1.2. Se la trave
è soggetta a momento negativo, la �angia è in tensione e viene perciò ignorata.
In questo caso quindi il progetto è del tutto analogo a quello visto per sezioni
rettangolari.

Nel caso di momento sollecitante positivo il programma applica un'analisi
preliminare dell'ampiezza dello stress block:

� Se l'ampiezza della zona compressa è inferiore allo spessore della �angia,
la sezione viene progettata come una sezione rettangolare di larghezza pari
alla larghezza della �angia bf .

� Se la zona compressa si estende anche all'interno dell'anima, la procedura
di calcolo viene modi�cata come di seguito speci�cato.

Per sezioni a T soggette a momento positivo, il momento normalizzato m, e il
momento resistente massimo nel caso di semplice armatura mlim, sono dati dalle
relazioni:

m =
MEd

ηfcdbfd2

mlim = λ
(x
d

)
lim

[
1− λ

2

(x
d

)
lim

]
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Parte I Veri�ca elementi in calcestruzzo

Figura 3.6: progetto dell'armatura longitudinale di una trave a T

La sezione viene pertanto inizalmente progettata come sezione rettangolare di
larghezza bf . Vengono poi calcolati i rapporti meccanici di armatura come:

ωlim = λ
(x
d

)
lim

ω = 1−
√

1− 2m

e i valori delle altezze dell'asse neutro limite, amax, ed e�ettiva, a:

amax = ωlimd

a = ωd

La procedura viene quindi di�erenziata a seconda che l'asse neutro sia compreso
o meno all'interno della �angia della trave:

� Nel caso in cui a ≤ hf il procedimento di calcolo è il medesimo visto per
le travi rettangolari in cui, in luogo della larghezza b, viene utilizzata la
larghezza della �angia della trave bf . L'armatura compressa è richiesta
solamente nel caso in cui a > amax. Le quantià di armatura così ottenute,
As ed A′s, sono da inserire, rispettivamente, nella parte inferiore e superiore
della sezione.

� Nel caso in cui a > hf , il calcolo dell'armatura tesa As avviene in 2 fasi:

� calcolo dell'armatura necessaria al bilanciamento della forza di com-
pressione nelle zone laterali della �angia As2:

As2 =
(bf − bw)hfηfcd

fyd
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M2 = As2fyd

(
d− hf

2

)
� calcolo dell'armatura necessaria alla sezione rettangolare di larghezza
bw per resistere alla quota di momento rimanente M1 = MEd −M2:

m1 =
M1

ηfcdbwd2

l'area necessaria As1, ed eventualmente il suo corrispondente com-
presso A′s, sono quindi determinate coi metodi visti per le sezioni
rettangolari.

L'area totale di armatura tesa, da inserire inferiormente, è quindi data
da As = As1 + As2 mentre l'eventuale armatura compressa, da inserire
superiormente, è data da A′s = A′s1.

3.5.1.3 Massimi e minimi di armatura longitudinale

Il minimo quantitativo di armatura longitudinale, As,min, richiesto per una
trave è dato dal massimo dei seguenti valori:

As,min = 0.26

(
fctm
fyk

)
btd (EC2 Eq. 9.1N)

As,min = 0.0013btd

dove bt è la larghezza media della zona tesa, corrispondente alla larghezza del-
l'anima per travi a T, e fctm è il valore medio della resistenza a trazione del
calcestruzzo, calcolata come:

fctm = 0.30f
2/3
ck per fck ≤ 50Mpa (EC2 Tab. 3.1)

fctm = 2.12 ln

(
1 +

fcm
10

)
per > 50Mpa (EC2 Tab. 3.1)

Il massimo quantitativo di armatura longitudinale impiegabile, sia in zona tesa
che compressa, As,max, è dato dalla relazione:

As,max = 0.04Ac (EC2 9.2.1.1(3))

in cui Ac è l'area della sezione in calcestruzzo.
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3.5.2 Progetto dell'armatura a taglio

L'armatura a taglio è calcolata, per ogni combinazione di progetto, con rife-
rimento alla direzione dell'asse locale 2 dell'elemento. La procedura di progetto
dell'armatura a taglio di una particolare trave, per una particolare combinazione,
include i seguenti passaggi:

� Determinazione del taglio sollecitante: VEd.

� Determinazione della resistenza dell'elemento privo dell'armarura a taglio:
VRd,c.

� Determinazione del massimo taglio che può essere ripreso dalle bielle com-
presse in calcestruzzo: VRd,max.

� Determinazione dell'armatura a taglio per unità di lunghezza richiesta:
Asw/s.

L'armatura a taglio è calcolata sotto forma di sta�e verticali. L'utilizzo di even-
tuali ferri piegati non è implementato. I paragra� seguenti descriveranno nel det-
taglio le fasi di calcolo, che verranno ripetute indipendentemente per le entrambe
le direzioni del piano della sezione.

3.5.2.1 Determinazione del taglio di progetto

La forza di taglio di progetto, VEd, per un dato elemento dovuta ad una
particolare combinazione di carico, è ottenuta fattorizzando i vari casi di carico
presenti in combinazione attraverso i corrispondenti moltiplicatori.

3.5.2.2 Determinazione della resistenza a taglio di elementi non ar-
mati

Date le sollecitazioni di progetto NEd e VEd, la massima forza di taglio che
può essere ripresa in assenza di un'armatura speci�ca è data da:

VRd,c =
[
CRd,ck (100ρlfck)

1/3
+ k1σcp

]
bwd (EC2 Eq. 6.2a)

con un minimo di:

VRd,c = (νmin + k1σcp) bwd (EC2 Eq. 6.2b)

in cui fck è espressa in MPa mentre k e ρl sono calcolati come:

k = 1 +

√
200

d
≤ 2 con d espresso in mm (EC2 6.2.2(1))
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ρl =
As
bwd
≤ 0.02 (EC2 6.2.2(1))

Poiché l'in�uenza dello sforzo assiale sulla resistenza a taglio è trascurato si as-
sume che risulti sigmacp = 0. L'area di calcestruzzo resistente al taglio è pari
a:

Ac = bwd

I fattori k1,CRd,c e νmin sono espressi dalle relazioni:

k1 = 0.15 (EC2 6.2.2(1))

CRD,c =
0.18

γc
(EC2 6.2.2(1))

νmin = 0.0035k3/2f
1/2
ck (EC2 Eq. 6.3N)

3.5.2.3 Determinazione della massima resistenza a taglio

La forza di progetto a taglio, VEd, è limitata al valore VRd,max, corrispon-
dente alla rottura per schiacciamento delle bielle di calcestruzzo compresse del
meccanismo resistente. Se il valore di VEd supera tale limite, il programma resti-
tuisce un messaggio di errore. La resistenza a �taglio-compressione� è calcolata
attraverso la relazione:

VRd,max = αcwbwzν1fcd

(
1

cot θ + tan θ

)
(EC2 Eq. 6.9)

in cui:

αcw coe�ciente che tiene conto dell'interazione fra
la tensione nel corrente compresso e qualsiasi
tensione di compressione assiale. Tale valore è
assunto pari a 1, che è il valore raccomandato
per strutture prive di presollecitazione.

ν1 = 0.6

[
1− fck

250

]
coe�ciente di riduzione della resistenza che
tiene conto dello stato di fessurazione del
alcestruzzo (EC2 Eq. 6.6N).

z = 0.9d braccio della coppia interna.

θ angolo compreso fra il puntone compresso di
calcestruzzo e l'asse della trave.
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Per le travi il valore di θ è ottimizzato attraverso la relazione:

cot (θ) + tan (θ) =
0.9αcwν1fcd

νEd

in cui:

21.8◦ ≤ θ ≤ 45◦

νEd =
VEd
bwd

Nel caso di combinazioni sismiche oppure nel caso di signi�cativi sforzi di torsione,
θ viene assunto pari a 45°. Per signi�cativo sforzo di torsione si intende una
torsione TEd tale che:

TEd > TRd,c

(
1− |VEd|

VRd,c

)
in cui TRd,c rappresenta il momento torcente di fessurazione così come de�nito
nel seguito.

3.5.2.4 Determinazione dell'armatura a taglio

Qualora VEd risulti maggiore di VRd,c e minore di VRd,max, l'armatura a taglio
necessaria, espressa come area per unità di lunghezza, Asw/s, viene calcolata
attraverso la relazione:

Asw
s

=
VEd

zfywd cot θ
(EC2 Eq. 6.8)

Alla �ne del processo di progettazione viene riportato, per ogni stazione e per
ognuna delle due direzioni del piano della sezione, il massimo fra tutti i valori del
rapporto Asw/s, calcolati per le varie combinazioni di carico.

L'armatura così calcolata deve risultare maggiore del valore minimo pari a:

ρw,min = 0.08

√
fck
fyk

(EC2 Eq. 9.5N)

3.5.3 Progetto dell'armatura a torsione

L'armatura a torsione è calcolata, per ogni combinazione di progetto e per
tutte le stazioni di output impostate. La procedura di progetto dell'armatura
a torsione di una particolare trave, per una particolare combinazione, include i
seguenti passaggi:

� Determinazione del momento torcente sollecitante: TEd.
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� Determinazione delle proprietà torsionali della sezione.

� Determinazione del momento torcente di fessurazione: TRd,c.

� Determinazione dell'armatura a torsione per unità di lunghezza richiesta:
At/s.

3.5.3.1 Determinazione del momento torcente di progetto

Il momento torcente di progetto, TEd, per un dato elemento dovuto ad una
particolare combinazione di carico, è ottenuto fattorizzando i vari casi di carico
presenti in combinazione attraverso i corrispondenti moltiplicatori.

3.5.3.2 Determinazione delle proprietà torsionali della sezione

Per il progetto a torsione di una determinata trave, è necessario de�nire pre-
liminarmente le seguenti proprietà speci�che, che de�niscono compiutamente il
modello di calcolo:

Ak area racchiusa dalla �bra media delle pareti esterne della
sezione. La �bra media è collocata ad una distanza pari a
tef/2 dal perimetro esterno della sezione

tef spessore e�cace delle pareti esterne della sezione

u perimetro esterno della sezione

uk perimetro dell'area Ak

zi lunghezza del lato i-esimo dell'area Ak, de�nita dalla
distanza fra i punti di intersezione con le pareti adiacenti

Per le travi a T si assume che le eventuali armature a torsione inserite nella
�angia siano ine�caci. Conseguentemente a tale assunzione, la �angia viene
ignorata nel calcolo delle armature, ma viene comunque considerata nel calcolo
delle proprietà torsionali. Le proprietà torsionali per le sezioni rettangolari sono
così calcolate:

A = bh

Ak = (b− tef ) (h− tef )

u = 2b+ 2h

uk = 2 (b− tef ) + 2 (h− tef )

Le proprietà torsionali per le sezioni a T sono de�nite dalle relazioni:

A = bwh+ (bf − bw) ds
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Ak = (b− tef ) (h− tef )

u = 2bf + 2h

uk = 2 (b− tef ) + 2 (h− tef )

Tutte le grandezze che compaiono nelle precedenti espressioni sono de�nite in
�gura 3.7.

Figura 3.7: armatura e�cace e geometria della sezione per la resistenza a torsione

3.5.3.3 Determinazione del momento torcente di fessurazione

L'e�etto della torsione sulla resistenza della sezione può essere ignorato, pre-
vedendo solo le armature minime da normativa (EC2 9.2.1.1), se la seguente
condizione è soddisfatta:

TEd
TRd,c

+
VEd
VRd,c

≤ 1 (EC2 Eq. 6.31)

in cui TRd,c è il momento torcente di fessurazione, determinato dalla relazione:

TRd,c = fctdtef2Ak

con:

tef =
A

u
(EC2 6.3.2(1))

fctd = αct
fctk0.05
γc

(EC2 Eq. 3.16)
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dove A e u sono i medesimi de�niti in precedenza, mentre αct è un coe�cente,
assunto pari a 1, che tiene conto degli e�etti a lungo termine. In�ne fctk0.05 è
calcolato come:

fctk0.05 = 0.7fctm (EC2 Table 3.1)

3.5.3.4 Determinazione dell'armatura a torsione

Se la condizione espressa dalla relazione EC2 Eq. 6.31 è soddisfatta, la tor-
sione può essere trascurata (EC2 6.3.2(5)). In tal caso il programma riporta che
nessuna armatura a torsione è richiesta. Viceversa, se tale relazione non risulta
soddisfatta, si assume che la resistenza a torsione sia fornita dal meccanismo a
traliccio spaziale composto da barre longitudinali, sta�e chiuse verticali e puntoni
di calcestruzzo compressi.
La quantità di sta�e necessarie è determinata attraverso la relazione:

At
s

=
2Vt

zfywd cot θ

in cui Vt rappresenta il taglio dovuto alla torsione agente sui lati verticali della
sezione:

Vt = (h− tef )

[
(TEd − Tcon)

2Ak

]
(EC2 Eq. 6.27)

con:

Tcon =

(
1− VEd

VRd,c

)
TRd,c (EC2 Eq. 6.3.2(5))

L'area di armatura longitudinale necessaria allo sviluppo del meccanismo resi-
stente è calcolata come:

Asl =
TEd
2Ak

cot θ
uk
fyd

(EC2 Eq. 6.28)

in cui θ rappresenta l'angolo di inclinazione delle bielle compresse di calcestruzzo.
Conservativamente nel calcolo si assume θ=45° anche se la normativa permette
di utilizzare qualsiasi valore compreso fra 21.8° e 45° (EC2 6.2.3(2)).
In�ne viene veri�cata la capacità portante delle bielle compresse controllando che
risulti:

TEd
TRd,max

+
VEd

VRd,max
≤ 1 (EC2 Eq. 6.29)

in cui:

TRd,max = 2ναcwfcdAktef sin θ cos θ (EC2 Eq. 6.30)
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Il valore di ν è de�nito, analogamente a quanto visto per la resistenza a taglio,
dalla relazione EC2 Eq. 6.6N.
Qualora la combinazione di taglio e torsione fosse tale da non soddisfare la
precedente relazione verrà visualizzato un messaggio d'errore e la sezione di
calcestruzzo deve essere incrementata in dimensioni.

Il programma riporta i massimi valori di At/s ed Asl corrispondenti alle varie
combinazioni. È importante sottolineare che il calcolo delle armature a torsione
è basato puramente su criteri di resistenza, pertanto non viene e�ettuato nessun
controllo su eventuali minimi quantitativi di armatura previsti dalla normativa.

3.6 Prescrizioni sismiche

I seguenti paragra� forniranno una descrizione dettagliata delle procedure
di calcolo implementate con riferimento alla norma �EN 1998-1:2004-Eurocodice
8: Progettazione delle strutture per la resistenza sismica�. Una volta impostato
l'Eurocodice 2-2004 come codice di veri�ca, tutte le seguenti prescrizioni vengono
automaticamente controllate per tutte le combinazioni di progetto contenenti
carichi sismici.
Le seguenti notazioni verranno nel seguito utilizzate:

Ash Area totale delle sta�e orizzontali presenti in un generico nodo
trave-pilastro, mm2

Asv,i Area totale delle barre longitudinali verticali comprese fra due
barre d'angolo in una data direzione di un nodo, mm2∑

MRb Somma dei momenti resistenti di progetto delle travi convergenti
in un nodo nella direzione di interesse, Nmm∑

MRc Somma dei momenti resistenti di progetto dei pilastri
convergenti in un nodo nella direzione di interesse, Nmm

Mi,d Momento all'estremità i di una trave o di una colonna per il
calcolo della gerarachia a taglio, Nmm

MRb,i Momento resistente di progetto all'estremità i di una trave
generica, Nmm

MRc,i Momento resistente di progetto all'estremità i di un pilastro
generico, Nmm

VEd,max Massima forza di taglio agente alle estremità di una data trave
per il criterio di gerarchia delle resistenze, N

VEd,min Minima forza di taglio agente alle estremità di una data trave
per il criterio di gerarchia delle resistenze, N

h Altezza di una generica sezione, mm
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hc Altezza di una generica sezione di un pilastro nella direzione di
interesse, mm

hjc Distanza fra gli strati di armatura estremi di un pilastro in una
data direzione, mm

hjw Distanza fra l'armatura superiore ed inferiore di una trave, mm

lcl Lunghezza netta di una trave o di un pilastro

q0 Valore base del fattore di struttura

α1 Moltiplicatore dell'azione sismica corrispondente alla formazione
della prima cerniera plastica sulla struttura

αu Moltiplicatore dell'azione sismica corrispondente alla formazione
del cinematismo plastico globale della struttura

γRd Fattore di sovraresistenza

ξ Rapporto VEd,min/VEd,max fra il taglio minimo e massimo agenti
alle estremità di una trave

µφ Duttilità di curvatura

µδ Duttilità di spostamento

ρ Rapporto di armatura

3.6.1 Tipologie strutturali

All'interno delle preferenze di progetto è possibile scegliere fra le seguenti
tipologie strutturali:

� Struttura a telaio in classe di duttilità alta DCH-MRF (EC8 5.5)

� Struttura a telaio in classe di duttilità media DCH-MRF (EC8 5.4)

� Struttura a telaio in classe di duttilità bassa DCL-MRF (EC8 5.3)

� Secondaria (nessuna prescrizione sismica)

Tali tipologie strutturali possono essere assegnate, sotto forma di sovrascritture,
in maniera indipendente per tutti i diversi elementi della struttura. In tal mo-
do sarà possibile escludere determinati elementi dalla veri�ca delle prescrizioni
sismiche relative.

3.6.2 Strutture a telaio in CDA

Per strutture a telaio in classe di duttilità alta (CDA), per tutte le combina-
zioni sismiche, vengono veri�cate le seguenti condizioni aggiuntive.
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3.6.2.1 Sollecitazioni di progetto per le travi

I valori di progetto dei momenti �ettenti sono quelli derivanti dall'analisi cor-
rispondenti alle diverse combinazioni sismiche. Il valore delle forze di taglio di
progetto viene invece calcolato sulla base del criterio di gerarchia delle resistenza
in accordo al punto EC8 5.5.2.1.
Nelle travi principali i tagli di progetto vengono determinati calcolando l'equili-
brio della trave sotto l'azione di:

� Carichi distribuiti in condizioni sismiche

� Momenti di estremità Mi,d corrispondenti alla formazione delle cerniere
plastiche. Le cerniere plastiche possono formarsi alle estremità della trave
oppure alle estremità dei pilastri verticali connessi alle estremità della trave
(EC8 5.5.2.1, EC8 5.4.2.2(1)P)

La condizione sopra descritta è stata così implementata (5.5.2.1, EC8 5.4.2.2(2)P,
EC8 5.4.2.2(3)P): all'estremo i possono essere calcolati due valori della forza di
taglio, VEd,max e VEd,min, corrispondenti ai possibili versi dei momenti plastici
di estremità (vedi �gura 3.8):

VEd,max =
M−i,d +M+

j,d

lcl
+ VG+ψ2Q

VEd,min =
M+
i,d +M−j,d
lcl

+ VG+ψ2Q

nelle quali i momenti di estremità Mi,d sono calcolati come:

Mi,d = γRdMRb,i min

(
1,

∑
MRc∑
MRb

)
(EC8 Eq. 5.8)

in cui:

γRd fattore di sovraresistenza pari a 1.2 per travi in CDA.

MRb,i momento resistente di progetto della trave all'estremo i∑
MRc somma dei momenti resistenti dei pilastri incidenti nel

nodo. Il valore di tali momenti deve tener conto
dell'interazione dello sforzo assiale presente∑

MRb somma dei momenti resistenti delle travi incidenti nel nodo

All'estremità di travi sorrette indirettamente da altre travi, il momento Mi,d

è assunto pari al momento �ettente agente nelle combinazioni sismiche.
Il rapporto ζi = VEd,min/VEd,max è inoltre utilizzato nel dimensionamento delle
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armature a taglio delle travi come indicatore dell'inversione della forza di taglio
(analogamente avviene per l'estremo j).

È opportuno sottolineare che i momenti resistenti di estremità delle travi sono
calcolati con l'armatura derivante dal progetto delle stesse. A�nché il progetto a
gerarchia venga condotto nella maniera corretta, risulta dunque opportuno speci-
�care l'esatto valore delle armature presenti alle estremità della trave all'interno
della �nestra Concrete Reinforcement raggiungibile dal menu di de�nizione
della sezione.

Figura 3.8: calcolo dei tagli di gerarchia per una trave

3.6.2.2 Sollecitazioni di progetto per i pilastri

I valori di progetto dei momenti �ettenti e degli sforzi assiali sono quelli de-
rivanti dall'analisi corrispondenti alle diverse combinazioni sismiche. Il valore
delle forze di taglio di progetto viene invece calcolato sulla base del criterio di
gerarchia delle resistenza in accordo al punto EC8 5.5.2.2.
Nelle pilastri principali i tagli di progetto vengono determinati calcolando l'e-
quilibrio del pilastro sotto l'azione dei momenti di estremità Mi,d corrispondenti
alla formazione delle cerniere plastiche. Le cerniere plastiche possono formarsi
alle estremità della trave oppure alle estremità dei pilastri verticali connessi alle
estremità della trave (EC8 5.5.2.1, EC8 5.4.2.2(1)P).
La condizione sopra descritta è stata così implementata (5.5.2.1, EC8 5.4.2.2(2)P,
EC8 5.4.2.2(3)P): il taglio all'estremo all'estremo i è dato da (vedi �gura 3.9):

VCD,c =
M−i,d +M+

j,d

lcl
+ VG+ψ2Q

nella quale i momenti di estremità Mi,d sono calcolati come:

Mi,d = γRdMRc,i min

(
1,

∑
MRb∑
MRc

)
(EC8 Eq. 5.9)
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Parte I Veri�ca elementi in calcestruzzo

in cui:

γRd fattore di sovraresistenza pari a 1.3 per pilastri in CDA.

MRb,i momento resistente di progetto della trave all'estremo i∑
MRc somma dei momenti resistenti delle colonne incidenti

nel nodo. Il valore di tali momenti deve tener conto
dell'interazione dello sforzo assiale presente∑

MRb somma dei momenti resistenti delle travi incidenti nel nodo

Figura 3.9: calcolo dei tagli di gerarchia per un pilastro
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3.6.2.3 Progetto di travi e pilastri

La resistenza a �essione delle travi ed a presso-tenso �essione dei pilastri è cal-
colata in accordo con la norma EN1992-1-1:2004-Eurocodice 2 (EC8 5.5.3.1.1(1)P
e EC8 5.5.3.2.1(1)P). Pertanto tutte le considerazioni viste nei paragra� 3.5.1 e
3.4.2 restano valide. Per i pilastri, in aggiunta, deve essere veri�cato che lo sforzo
assiale normalizzato νEd risulti:

νEd =
NEd
fcdAg

≤ 0.55 (EC8 5.5.3.2.1(3))

La resistenza a taglio delle travi è calcolata in accordo con la norma EN1992-
1-1:2004-Eurocodice 2 con le seguenti integrazioni (EC8 5.5.3.1.1):

� Nelle zone critiche delle travi principali l'inclinazione θ delle bielle compres-
se del meccanismo resistente viene assunta pari a 45°.

� Nelle zone critiche delle travi principali, in corrispondenza dell'intersezio-
ne con un pilastro, con riferimento alla resistenza delle armature a taglio
devono essere distinti i seguenti casi, in funzione del valore del rapporto
ζ = VEd,min/VEd,max (EC8 5.5.3.1.2(3)):

� Se ζ ≥ −0.5, la resistenza a taglio delle armature trasversali è calcolata
in accordo con l'Eurocodice 2.

� Se ζ < −0.5 e |VE |max ≤ (2 + ζ) fctdbwd (EC8 Eq. 5.27), la resi-
stenza a taglio delle armature trasversali è calcolata in accordo con
l'Eurocodice 2.

� Se ζ < −0.5 e |VE |max > (2 + ζ) fctdbwd, in aggiunta alle sta�e devono
essere previste opportune armature inclinate tali da assorbire almeno
il 50% del taglio di progetto:

0.5VEd ≤ 2Asfyd sinα (EC8 Eq. 5.28)

in cui As rappresenta l'area delle armature inclinate in una data dire-
zione che attraversano il piano di scorrimento, e α è l'angolo di incli-
nazione delle armature. È importante sottolineare che il programma
non gestisce il calcolo delle armature inclinate perciò, anche in que-
st'ultimo caso, le armature a taglio saranno calcolate unicamente sotto
forma di sta�e.

La resistenza a taglio dei pilastri è calcolata in accordo con la norma EN1992-
1-1:2004-Eurocodice 2.
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Parte I Veri�ca elementi in calcestruzzo

3.6.2.4 Progetto del nodo trave-pilastro

Al �ne di assicurarsi che il nodo trave-pilastro abbia una adeguata resistenza
nei confronti delle sollecitazioni di taglio, il programma e�ettua il calcolo del
nodo in accordo al criterio della gerarchia delle resistenze. Vengono progettati
solamente i nodi che hanno un pilastro sottostante. Le proprietà dei materiali
costituenti il nodo sono assunte pari a quelle del pilastro ad esso sottostante. I
passaggi della procedura di progetto per un generico nodo sono:

� Calcolo del taglio sollecitante, Vjhd

� Calcolo dell'area e�cace del nodo

� Progetto delle armature a taglio del nodo

Figura 3.10: forze agenti sul nodo trave-pilastro

La �gura 3.10 illustra la tipica condizione sollecitante di un nodo trave-
pilastro; le forze agenti sul nodo sono:

� Lo sforzo assiale agente nel pilastro superiore derivante dall'analisi, NEd
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� I momenti momenti resistenti delle travi incidenti nel nodo incrementati
del fattore di sovraresistenza γRd pari a 1.2 (EC8 5.5.2.3(2)), MR

Ed e M
L
Ed

� Lo sforzo di taglio agente nei pilastri in seguito al raggiungimento dei
momenti plastici nelle travi, VC

La forza orizzontale totale agente nel nodo, Vjhd, è calcolata scomponendo
ognuno dei momenti resistenti delle travi in una coppia di forze equivalenti, CR−
TR e CL − TL, di braccio pari a z = 0.9d. Poiché CR = TR e CL = TL risulta:

Vjhd = TL + TR − VC

in cui VC è calcolata assumendo come punto di inversione dei momenti la mezzeria
dei pilastri:

VC =
ML
Ed +ML

Ed

H

Se non sono presenti pilastri al di sopra del nodo VC viene assunto pari a 0.
Il valore di Vjhd viene calcolato considerando tutte le possibili combinazioni di
verso dei momenti �ettenti agenti (vedi �gura 3.11) ed il progetto viene condotto
con riferimento alla condizione più sfavorevole.

Il progetto del nodo viene condotto per entrambe le direzioni principali del
pilastro. Il programma è inoltre in grado di eseguire il progetto di nodi con travi
incidenti non ortogonali agli assi principali del pilastro: in tal caso il momento
resistente della generica trave viene proiettato lungo le direzioni principali del
pilastro ed il progetto viene eseguito sommando i contributi delle proiezioni di
tutte le travi costituenti il nodo.

L'area e�cace del nodo viene calcolata assumendo sempre una sezione resi-
stente rettangolare. Le dimensioni di tale rettangolo corrispondono alle dimensio-
ni principali della colonna sottostante il nodo, a meno che le dimensioni delle travi
incidenti non siano eccessivamente ridotte. In particolare, la larghezza dell'area
e�cace è limitata ai seguenti valori:

bj = min {bc, (bw + 0.5hc)} se bc > bw (EC8 Eq. 5.34(a))

bj = min {bw, (bc + 0.5hc)} se bc < bw (EC8 Eq. 5.34(a))

con:

bc larghezza della colonna ortogonalmente alla direzione in
esame

bw larghezza dell'anima della trave

hc altezza della sezione nella direzione in esame
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L'altezza della sezione resistente del nodo è assunta pari ad hc. La sezione
resistente così de�nita viene calcolata per ognuna delle direzioni principali del
pilastro. È importante notare che, se le travi incidenti sono eccentriche rispetto
al pilastro, le precedenti espressioni per il caclolo della larghezza e�cace non sono
conservative e l'utente dovrà provvedere autonomamente al calcolo del nodo.

Figura 3.11: calcolo della sollecitazione di progetto del nodo trave-pilastro

Una volta determinate le sollecitazioni e le proprietà della sezione resistente
del nodo, il programma e�ettua il progetto dell'armatura di con�namento ne-
cessaria. A tal �ne viene prima veri�cata la capacità portante del calcestruzzo
attraverso la relazione:

Vjhd ≤


ηfcd

√
1− νd

η
bjhjc per nodi interni

0.8ηfcd

√
1− νd

η
bjhjc per nodi esterni

(EC8 Eq. 5.33)

dove:
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η = 0.6 (1− fck/250)

hjc distanza fra gli strati di armatura estremi della colonna nella
direzione in esame

bj come de�nita in EC8 Eq. 5.34(a,b)

νd sforzo normale normalizzato nel pilastro superiore

Qualora la precedente relazione non fosse veri�cata il programma restituisce un
messaggio di errore e le dimensioni degli elementi del nodo devono necessaria-
mente essere riviste.

Nel caso in cui la EC8 Eq. 5.33 sia veri�cata, il programma procede al calcolo
delle sta�e di con�namento orizzontali Ash del nodo attraverso la relazione:

Ash =


(
Vjhd
bjhjc

)2

fctd + νdfcd
− fctd

 bjhjwfywd
(EC8 Eq. 5.35)

in cui i simboli hanno il medesimo signi�cato visto in precedenza.

Le sta�e di con�namento orizzontali devono essere distribuite uniformemente
lungo l'altezza hjw determinata dagli strati di armatura inferiori e superiori delle
travi incidenti. Per nodi esterni le cerchiature devono includere le estremità delle
barre delle travi piegate verso il nodo (EC8 5.5.3.3(5)).

È importante sottolineare che il calcolo delle sta�e di con�namento del nodo
è basato puramente su cruteri di resistenza, pertanto non viene e�ettuato nessun
controllo riguardo percentuali minime di armatura previste dalla normativa (EC8
5.5.3.3(1)-(7) e 5.4.3.2.2(8)-(11)).

3.6.2.5 Rapporti di capacità trave-colonna

In corrispondenza dei nodi trave-colonna, per strutture a telaio in CDA, è
necessario veri�care che risulti (EC8 5.2.3.3(2)):∑

1.3Mb,Rd∑
Mc,Rd

≤ 1

in cui:
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∑
Mc,Rd è la somma dei momenti resistenti dei pilastri incidenti

nel nodo, calcolati in corrispondenza delle facce del nodo
e trenendo conto dell'interazione con lo sforzo assiale
presente∑

Mb,Rd
è la somma dei momenti resistenti dele travi incidenti nel
nodo, calcolati in corrispondenza delle facce del nodo

Tali rapporti vengono calcolati trascurano eventuali fattori di sovrarestistenza per
le armature. Vengono prese in considerazione tutte le possibili combinazioni di
segno dei momenti ed il rapporto è de�nito dal maggiore dei valori così calcolati.

Per travi incidenti nel pilastro con direzione arbitraria, i momenti resistenti
vengono scomposti lungo le direzioni principali del pilastro e poi sommati a quelli
delle altre travi.

Il programma e�ettua il calcolo dei rapporti di capacità trave-colonna per
ogni nodo strutturale in cui sono presenti un pilastro superiore ed uno inferiore.

3.6.2.6 Massimi e minimi quantitativi di armatura

La minima armatura longitudinale da inserire in una trave è limitata al
seguente valore (EC8 5.5.3.1.3(5)):

ρmin = 0.5

(
fctm
fyk

)
L'armatura longitudinale totale di un pilastro deve essere compresa entro i se-
guenti limiti:

ρmin = 0.01 (EC8 5.4.3.2.2(1))

ρmax = 0.04 (EC8 5.4.3.2.2(1))

Eventuali altre limitazioni di armatura presenti nella normativa devono essere
controllati in maniera indipendente dall'utente.

3.6.3 Strutture a telaio in CDM

Per strutture a telaio in classe di duttilità media (CDM), per tutte le combi-
nazioni sismiche, vengono veri�cate le seguenti condizioni aggiuntive.

3.6.3.1 Sollecitazioni di progetto per le travi

I valori di progetto dei momenti �ettenti sono quelli derivanti dall'analisi cor-
rispondenti alle diverse combinazioni sismiche. Il valore delle forze di taglio di
progetto viene invece calcolato sulla base del criterio di gerarchia delle resistenza
in accordo al punto EC8 5.4.2.2.
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Nelle travi principali i tagli di progetto vengono determinati calcolando l'equili-
brio della trave sotto l'azione di:

� Carichi distribuiti in condizioni sismiche

� Momenti di estremità Mi,d corrispondenti alla formazione delle cerniere
plastiche. Le cerniere plastiche possono formarsi alle estremità della trave
oppure alle estremità dei pilastri verticali connessi alle estremità della trave
(EC8 5.4.2.2(1)P)

La condizione sopra descritta è stata così implementata (EC8 5.4.2.2(2)P, EC8
5.4.2.2(3)P): all'estremo i possono essere calcolati due valori della forza di ta-
glio, VEd,max e VEd,min, corrispondenti ai possibili versi dei momenti plastici di
estremità (vedi �gura 3.8):

VEd,max =
M−i,d +M+

j,d

lcl
+ VG+ψ2Q

VEd,min =
M+
i,d +M−j,d
lcl

+ VG+ψ2Q

nelle quali i momenti di estremità Mi,d sono calcolati come:

Mi,d = γRdMRb,i min

(
1,

∑
MRc∑
MRb

)
(EC8 Eq. 5.8)

in cui:

γRd fattore di sovraresistenza pari a 1.0 per travi in CDM.

MRb,i momento resistente di progetto della trave all'estremo i∑
MRc somma dei momenti resistenti dei pilastri incidenti nel

nodo. Il valore di tali momenti deve tener conto
dell'interazione dello sforzo assiale presente∑

MRb somma dei momenti resistenti delle travi incidenti nel nodo

All'estremità di travi sorrette indirettamente da altre travi, il momento Mi,d

è assunto pari al momento �ettente agente nelle combinazioni sismiche.

È opportuno sottolineare che i momenti resistenti di estremità delle travi sono
calcolati con l'armatura derivante dal progetto delle stesse. A�nché il progetto a
gerarchia venga condotto nella maniera corretta, risulta dunque opportuno speci-
�care l'esatto valore delle armature presenti alle estremità della trave all'interno

65



Parte I Veri�ca elementi in calcestruzzo

della �nestra Concrete Reinforcement raggiungibile dal menu di de�nizione
della sezione.

3.6.3.2 Sollecitazioni di progetto per i pilastri

I valori di progetto dei momenti �ettenti e degli sforzi assiali sono quelli de-
rivanti dall'analisi corrispondenti alle diverse combinazioni sismiche. Il valore
delle forze di taglio di progetto viene invece calcolato sulla base del criterio di
gerarchia delle resistenza in accordo al punto EC8 5.4.2.3.
Nelle pilastri principali i tagli di progetto vengono determinati calcolando l'e-
quilibrio del pilastro sotto l'azione dei momenti di estremità Mi,d corrispondenti
alla formazione delle cerniere plastiche. Le cerniere plastiche possono formarsi
alle estremità della trave oppure alle estremità dei pilastri verticali connessi alle
estremità della trave (EC8 5.4.2.2(1)P e EC8 5.4.2.3(1)P).
La condizione sopra descritta è stata così implementata (EC8 5.4.2.3): il taglio
all'estremo all'estremo i è dato da (vedi �gura 3.9):

VCD,c =
M−i,d +M+

j,d

lcl
+ VG+ψ2Q

nella quale i momenti di estremità Mi,d sono calcolati come:

Mi,d = γRdMRc,i min

(
1,

∑
MRb∑
MRc

)
(EC8 Eq. 5.9)

in cui:

γRd fattore di sovraresistenza pari a 1.1 per pilastri in CDM.

MRb,i momento resistente di progetto della trave all'estremo i∑
MRc somma dei momenti resistenti delle colonne incidenti

nel nodo. Il valore di tali momenti deve tener conto
dell'interazione dello sforzo assiale presente∑

MRb somma dei momenti resistenti delle travi incidenti nel nodo

3.6.3.3 Progetto di travi e pilastri

La resistenza a �essione delle travi ed a presso-tenso �essione dei pilastri è cal-
colata in accordo con la norma EN1992-1-1:2004-Eurocodice 2 (EC8 5.5.3.1.1(1)P
e EC8 5.5.3.2.1(1)P). Pertanto tutte le considerazioni viste nei paragra� 3.5.1 e
3.4.2 restano valide. Per i pilastri, in aggiunta, deve essere veri�cato che lo sforzo
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assiale normalizzato νEd risulti:

νEd =
NEd
fcdAg

≤ 0.65 (EC8 5.4.3.3.2.1(3))

La resistenza a taglio di travi e pilastri è calcolata in accordo con la norma
EN1992-1-1:2004-Eurocodice 2.

3.6.3.4 Rapporti di capacità trave-colonna

In corrispondenza dei nodi trave-colonna, per strutture a telaio in CDM, è
necessario veri�care che risulti (EC8 5.2.3.3(2)):∑

1.3Mb,Rd∑
Mc,Rd

≤ 1

in cui:∑
Mc,Rd è la somma dei momenti resistenti dei pilastri incidenti

nel nodo, calcolati in corrispondenza delle facce del nodo
e trenendo conto dell'interazione con lo sforzo assiale
presente∑

Mb,Rd
è la somma dei momenti resistenti dele travi incidenti nel
nodo, calcolati in corrispondenza delle facce del nodo

Tali rapporti vengono calcolati trascurano eventuali fattori di sovrarestistenza
per le armature. Vengono prese in considerazione tutte le possibili combinazioni
di segno dei momenti ed il rapporto è de�nito dal maggiore dei valori così calcolati.

Per travi incidenti nel pilastro con direzione arbitraria, i momenti resistenti
vengono scomposti lungo le direzioni principali del pilastro e poi sommati a quelli
delle altre travi.

Il programma e�ettua il calcolo dei rapporti di capacità trave-colonna per
ogni nodo strutturale in cui sono presenti un pilastro superiore ed uno inferiore.

3.6.3.5 Massimi e minimi quantitativi di armatura

La minima armatura longitudinale da inserire in una trave è limitata al
seguente valore (EC8 5.4.3.1.2(5)):

ρmin = 0.5

(
fctm
fyk

)
L'armatura longitudinale totale di un pilastro deve essere compresa entro i se-
guenti limiti:

ρmin = 0.01 (EC8 5.4.3.2.2(1))
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ρmax = 0.04 (EC8 5.4.3.2.2(1))

Eventuali altre limitazioni di armatura presenti nella normativa devono essere
controllati in maniera indipendente dall'utente.

3.6.4 Strutture a telaio in CDB

Per strutture a telaio in classe di duttilità bassa (CDB), fatta eccezione per
le prescrizioni sui materiali presenti al paragrafo EC8 5.3.2, non sono necessarie
alcune veri�che aggiuntive rispetto a quelle condotte in accordo con l'EC2 2004.

3.7 Preferenze di veri�ca

Viene di seguito riportato il signi�cato di tutte le diverse preferenze di pro-
gettazione che possono essere impostate dall'utente una volta selezionata la nor-
mativa EC2-2004. Con riferimento alla �gura 3.12 si ha:

1. Design Code: indica il codice di veri�ca selezionato

2. Country: indica il paese di riferimento per l'impostazione dei parametri di
progetto speci�ci per i vari paesi

3. Combinations Equation: indica l'equazione dell'EC0 cui far riferimento per
la generazione delle combinazioni automatiche di progetto

4. Reliability Class: classe di a�dabilità, utilizzata nella generazione delle
combinazioni di progetto per Danimarca, Finlandia e Svezia

5. Second Order Method: metodo di calcolo degli e�etti locali del secondo
ordine, è possibile scegliere fra il metodo della curvatura nominale (Nominal
Curvature), il metodo della rigidezza nominale (Nominal Sti�ness) oppure,
qualora si sia tenuto conto di tali e�etti in sede di analisi, nessuno

6. Multi-Response Case Design: de�nisce la procedura di progetto per analisi
con risposta multipla (analisi time history, analisi statiche non lineari e
analisi multi-step statiche). È possibile scegliere fra:

� Envelopes: considera l'inviluppo per le analisi time-history e le analisi
multi-step statiche e lo stato �nale per le analisi non lineari statiche

� Step by step: considera tutti gli step per le analisi time-history e le
analisi multi-step statiche e lo stato �nale per le analisi non lineari
statiche

� Last step: considera solo lo stato �nale per le analisi time-history, le
analisi multi-step statiche e le analisi non lineari statiche
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� Envelopes-All: considera l'inviluppo per le analisi time-history, le
analisi multi-step statiche e le analisi non lineari statiche

� Step by step-All: considera tutti gli step per le analisi time-history, le
analisi multi-step statiche e le analisi non lineari statiche

È opportuno sottolineare che le opzioni Step by step e Step by step-All
vengono automaticamente convertite alle corrispondenti Envelope qualora
più di un caso di analisi a risposta multipla sia presente in combinazione

7. Number of Iteration Curves: numero di punti della sezione per i quali
vengono generate le curve di interazione P -M2-M3

8. Number of Iteration Points: numero di punti per ogni curva di interazione
P -M2-M3

9. Consider Minimum Eccentricity?: permette di includere od escludere dal
calcolo dei pilastri l'eccentricità minima

10. θ0 : valore di base dell'inclinazione per il calcolo delle imperfezioni geome-
triche (vedi EC2 5.2)

11. γs : coe�ciente parziale di sicurezza relativo all'acciaio da c.a.

12. γc : coe�ciente parziale di sicurezza relativo al calcestruzzo

13. αCC : coe�ciente che tiene conto degli e�etti a lungo termine sulla resi-
stenza a compressione del calcestruzzo

14. αCT : coe�ciente che tiene conto degli e�etti a lungo termine sulla resi-
stenza a trazione del calcestruzzo

15. αLCC : coe�ciente che tiene conto degli e�etti a lungo termine sulla resi-
stenza a compressione dei calcestruzzi alleggeriti

16. αLCT : coe�ciente che tiene conto degli e�etti a lungo termine sulla resi-
stenza a trazione dei calcestruzzi alleggeriti

17. Pattern Live Load Factor: quota di carico variabile che viene ripartita
secondo lo schema di semplice appoggio per il progetto delle travi

18. Utilization Factor Limit: valore limite per l'accettabilità dei rapporti di
capacità

69



Parte I Veri�ca elementi in calcestruzzo

Figura 3.12: preferenze di progettazione per l'EC2-2004
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3.8 Sovrascritture

Viene di seguito riportato il signi�cato delle possibili sovrascritture assegnabili
a travi e pilastri. Le sovrascritture possono essere assegnate, una volta selezio-
nato l'elemento, attraverso il comando Design > Concrete Frame Design >
View/Rewise Overwrites.

3.8.1 Sovrascritture per le travi

Con riferimento alla �gura 3.13 si ha:

1. Current Design Section: indica qual'è la sezione di progetto assegnata alla
data trave

2. Framing Type: è possibile de�nire la struttura di cui fa parte l'elemento.
È possibile scegliere fra:

� DC High: trave facente parte di una struttura a telaio in classe di
duttilità alta

� DC Medium: trave facente parte di una struttura a telaio in classe di
duttilità media

� DC Low: trave facente parte di una struttura a telaio in classe di
duttilità bassa

� Secondary: elemento secondario (non vengono controllate le prescri-
zioni sismiche)

3. Live Load Reduction Factor: moltiplicatore per i carichi variabili �riducibili�
(reducible live)

4. Unbraced Length Ratio (Major): rapporto fra la distanza dei punti di
vincolo in direzione di massima inerzia e la lunghezza dell'elemento

5. Unbraced Length Ratio (Minor): rapporto fra la distanza dei punti di
vincolo in direzione di minima inerzia e la lunghezza dell'elemento

6. Correction Factor, kr: fattore di correzione, funzione dello sforzo assiale
agente, per il metodo della curvatura nominale (EC2 Eq. 5.36)

7. Creep Factor, kϕ: coe�ciente che tiene conto degli e�etti viscosi nel metodo
della curvatura nominale (EC2 Eq. 5.37)
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Figura 3.13: Sovrascritture travi
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3.8.2 Sovrascritture per i pilastri

Con riferimento alla �gura 3.14 si ha:

1. Current Design Section: indica qual'è la sezione di progetto assegnata al
dato pilastro

2. Framing Type: è possibile de�nire la struttura di cui fa parte l'elemento.
È possibile scegliere fra:

� DC High: pilastro facente parte di una struttura a telaio in classe di
duttilità alta

� DC Medium: pilastro facente parte di una struttura a telaio in classe
di duttilità media

� DC Low: pilastro facente parte di una struttura a telaio in classe di
duttilità bassa

� Secondary: elemento secondario (non vengono controllate le prescri-
zioni sismiche)

3. Live Load Reduction Factor: moltiplicatore per i carichi variabili �riducibili�
(reducible live)

4. Unbraced Length Ratio (Major): rapporto fra la distanza dei punti di
vincolo in direzione di massima inerzia e la lunghezza dell'elemento

5. Unbraced Length Ratio (Minor): rapporto fra la distanza dei punti di
vincolo in direzione di minima inerzia e la lunghezza dell'elemento

6. E�ective Length Factor (βmajor): coe�ciente di lunghezza e�cace lungo
l'asse maggiore

7. E�ective Length Factor (βminor): coe�ciente di lunghezza e�cace lungo
l'asse minore

8. Moment coe�cient (Cmmajor): non utilizzato

9. Moment coe�cient (Cmminor): non utilizzato

10. NonSway Moment Factor (Dnsmajor): non utilizzato

11. NonSway Moment Factor (Dnsminor): non utilizzato

12. Sway Moment Factor (Dsmajor): non utilizzato

13. Sway Moment Factor (Dsminor): non utilizzato

14. Correction Factor (kr): fattore di correzione, funzione dello sforzo assiale
agente, per il metodo della curvatura nominale (EC2 Eq. 5.36)
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15. Creep Factor (kϕ): coe�ciente che tiene conto degli e�etti viscosi nel
metodo della curvatura nominale (EC2 Eq. 5.37)

Figura 3.14: Sovrascritture pilastri

74



3.9 Output di progetto

Viene di seguito riportato l'output fornito da SAP con riferimento al proget-
to di travi e pilastri in accordo con l'EC2-2004. Le �nestre di dettaglio sono
raggiungibili, una volta e�ettuato il progetto della struttura, cliccando col tasto
destro sull'elemento da interrogare.

3.9.1 Output di progetto per le travi

Cliccando col tasto destro su una qualunque trave della struttura è possibile
accedere ai dettagli di progetto. La �nestra riassuntiva che compare (�gura 3.15)
riporta le informazioni di progetto per tutte le output station della trave con
riferimento alle varie combinazioni di progetto de�nite.

Figura 3.15: �nestra riassuntiva di progetto per le travi

Selezionando una stazione ed una data combinazione di progetto, cliccando
sul pulsante �Details� è possibile avere accesso ai dettagli di progetto relativi
alla stazione selezionata con riferimento alla data combinazione. Le informazioni
sono riportate in forma ordinata e sequenziale. Con riferimento alla �gura 3.16
si possono individuare 4 aree speci�che:

� Area A: nella parte superiore della �nestra di dettaglio sono riportate le
informazioni relative alla trave in esame, alla corrispondente sezione nonché
i dettagli riguardanti la stazione di output, la combinazione di progetto e i
coe�cienti di sicurezza dei materiali

� Area B: in tale area vengono esplicitati i calcoli del progetto a �essione
attorno all'asse 3 della trave. Sono riportati i momenti �ettenti di proget-
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to positivi (�bre tese inferiori) e negativi (�bre tese superiori) e i relativi
dettagli di progetto:

� Required Rebar: area di armatura totale di progetto da disporre su-
periormente (Top) ed inferiormente (Bottom). Tale area è data dal
massimo valore fra quelli delle colonne successive

� +Moment Rebar: area di armatura da disporre superiormente (Top)
ed inferiormente (Bottom) relativamente al momento di progetto po-
sitivo

� -Moment Rebar: area di armatura da disporre superiormente (Top) ed
inferiormente (Bottom) relativamente al momento di progetto negativo

� Minimum Rebar: area di armatura minima da disporre superiormente
(Top) ed inferiormente (Bottom) secondo le prescrizioni normative

� Area C: in tale area vengono esplicitati i calcoli del progetto a taglio lungo
l'asse 2 della trave:

� Rebar Asw/s: area di armatura a taglio per unità di lunghezza da
disporre sull'elemento

� Shear VEd: taglio sollecitante di progetto

� Shear VRdc: resistenza a taglio per elementi non armati

� Shear VRds: resistenza a taglio fornita dalle armature

� Area D: in tale area vengono esplicitati i calcoli del progetto a torsione
della trave:

� Rebar At/s: area di armatura trasversale per unità di lunghezza da
disporre sull'elemento (da sommare alla Asw/s)

� Rebar Asl: area di armatura longitudinale necessaria al meccanismo
resistente

� Torsion TEd: momento torcente di progetto

� Critical T: momento torcente massimo, oltre il quale la sezione deve
essere ridimensionata

� Area Ak: area e�cace della sezione resistente a torsione

� Perimeter uk: perimetro e�cace della sezione resistente
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Figura 3.16: �nestra di dettaglio per il progetto di travi
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3.9.2 Output di progetto per i pilastri

Cliccando col tasto destro su un qualunque pilastro della struttura è possibile
accedere ai dettagli di progetto. La �nestra riassuntiva che compare (�gura 3.17)
riporta le informazioni di progetto per tutte le output station del pilastro con
riferimento alle varie combinazioni di progetto de�nite.

Figura 3.17: �nestra riassuntiva di progetto per i pilastri

Selezionando una stazione ed una data combinazione di progetto, cliccando
sul pulsante �Details� è possibile avere accesso ai dettagli di progetto relativi
alla stazione selezionata con riferimento alla data combinazione. Le informazioni
sono riportate in forma ordinata e sequenziale. Con riferimento alla �gura 3.18
si possono individuare 6 aree speci�che:

� Area A: nella parte superiore della �nestra di dettaglio sono riportate le
informazioni relative al pilastro in esame, alla corrispondente sezione nonché
i dettagli riguardanti la stazione di output, la combinazione di progetto e i
coe�cienti di sicurezza dei materiali

� Area B: in tale area vengono esplicitati i calcoli di progetto/veri�ca a
presso-tenso �essione biassiale:

� Capacity Ratio/Rebar Area: rappresenta il coe�ciente di utilizzo del
pilastro, qualora sia stato speci�cato che il pilastro debba essere veri-
�cato, oppure rappresenta il valore di armatura da disporre omogena-
mente nelle posizioni prestabilite, qualora sia stato speci�cato che il
pilastro debba essere progettato

� Design NEd: rappresenta lo sforzo normale di progetto
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� Design MEd2: rappresenta il momento �ettente di progetto attor-
no all'asse 2 comprensivo di e�etti del secondo ordine ed eccentricità
accidentali

� Design MEd3: rappresenta il momento �ettente di progetto attor-
no all'asse 3 comprensivo di e�etti del secondo ordine ed eccentricità
accidentali

� Minimum M2: rappresenta il momento �ettente minimo da consi-
derare in direzione 2 (dato dal prodotto dello sforzo normale per
l'eccentricità accidentale)

� Minimum M3: rappresenta il momento �ettente minimo da consi-
derare in direzione 3 (dato dal prodotto dello sforzo normale per
l'eccentricità accidentale)

� M0Ed Moment: rappresenta il momento �ettente equivalente del pri-
mo ordine calcolato secondo EC2 Eq. 5.32

� Madd Moment: momento aggiuntivo del secondo ordine (calcolato
secondo il metodo speci�cato nelle preferenze)

� Minimum Ecc: eccentricità minima

� Beta Factor: coe�ciente di vincolo (corrispondente all'e�ective length
factor)

� L: lunghezza dell'elemento

� Area D: in tale area vengono esplicitati i calcoli aggiuntivi relativamente
alle prescrizioni sismiche derivanti dall'EC8:

� AXIAL COMPRESSION RATIO: controllo del valore di sforzo nor-
male adimensionale

� JOINT SHEAR DESIGN: progetto a taglio del nodo

* Joint Shear Ash: area totale di sta�e orizzontali da disporre nel
nodo

* Shear VEd, Top: taglio sollecitante di progetto agente sulla co-
lonna superiore del nodo

* Shear Vjhd: taglio sollecitanete di progetto agente nel nodo

* Shear Vrd,Conc: taglio resistente massimo (se il taglio di progetto
è superiore occorre ridimensionare il nodo)

* Joint Area: area resistente del nodo

� 1.3 BEAM/COLUMN CAPACITY RATIOS: controllo dei rapporti
di resistenza trave-colonna sia in direzione maggiore (asse 3) che in
direzione minore (asse 2)
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Figura 3.18: �nestra di dettaglio per il progetto di pilastri
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Capitolo 4

Esempio di calcolo: Telaio in

CDA

Nel presente capitolo verrà illustrata la procedura di calcolo, in accordo con
l'Eurocodice 2 ed Eurocodice 8, di una struttura a telaio in c.a. in classe di
duttilità alta. I parametri di veri�ca verranno settati in accordo con il documento
di applicazione nazionale italiano, in modo da rendere le veri�che pienamente
conformi alle prescrizioni nazionali.

4.1 De�nizione della struttura

La struttura in esame rappresenta un telaio piano in c.a. a 4 piani e 4 campate.
L'ampiezza delle campate è pari a 5 metri, mentre l'interpiano è pari a 3 metri,
per un'altezza totale di 12 metri. Travi e pilastri hanno sezioni rettangolari così
de�nite:

� travi: sezione 30x40 (�gura 4.1)

� pilastri piano 1 e piano 2: sezione 30x50 (�gura 4.2)

� pilastri piano 2 e piano 3: sezione 30x40 (�gura 4.3)

La geometria globale della struttura è riportata in �gura 4.4. Tutte le sezioni in
c.a. sono costituite da calcestruzzo C25/30 con armatura di tipo B450C, aventi
le caratteristiche riportate in �gura 4.5.
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(a) de�nizione della geometria
della sezione

(b) de�nizione dei parametri di
progetto della sezione

Figura 4.1: travi 30x40

(a) de�nizione della geometria
della sezione

(b) de�nizione dei parametri di
progetto della sezione

Figura 4.2: pilastri 30x40
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(a) de�nizione della geometria
della sezione

(b) de�nizione dei parametri di
progetto della sezione

Figura 4.3: pilastri 30x50

Figura 4.4: geometria globale del telaio
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(a) (b)

Figura 4.5: de�nizione dei materiali

4.2 Analisi dei carichi

Alla struttura sono stati applicati i seguenti carichi statici:

� peso proprio degli elementi strutturali: DEAD

� carichi permanenti di piano: g2k = 3.5kN/m2

� carichi accidentali di piano: qAk = 2.0kN/m2

Supponendo una larghezza di in�uenza dei vari telai pari a 5 metri, le travi sono
state caricate come illustrato in �gura 4.6 ed in �gura 4.7. Per quanto riguarda
i carichi sismici è stato de�nito uno spettro di risposta allo SLV in accordo con
la normativa italiana. Il fattore di struttura assunto è pari a 3.9, valore coerente
con la tipologia strutturale in esame e la classe di duttilità adottata (vedi �gura
4.8).
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Figura 4.6: distribuzione dei carichi permanenti

Figura 4.7: distribuzione dei carichi variabili
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Figura 4.8: spettro di risposta allo SLV impiegato nell'analisi

Ad ognuno dei carichi de�niti è stato associato un load case come mostrato
in �gura 8.8.

Figura 4.9: casi di analisi
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4.3 Combinazioni di progetto

Le combinazioni di progetto impiegate nel calcolo sono 2, riportate in �gura
8.9:

� SLU: combinazione agli stati limite ultimi

� QKE: combinazione sismica allo SLV

(a) (b)

Figura 4.10: combinazioni di progetto

4.4 Impostazione dei parametri di progetto

I parametri di progetto sono stati impostati come mostrato in �gura 4.11 in ac-
cordo con le prescrizioni contenute nelle norme italiane NTC2008. Le combinazio-
ni precedentemente create sono state quindi impostate come uniche combinazioni
di progetto, vedi �gura 4.12.
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Figura 4.11: preferenze di progetto

Figura 4.12: impostazione delle combinazioni di progetto
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4.5 Progetto delle travi

Per prima cosa, ai �ni del progetto del telaio, occorre e�ettuare il dimensiona-
mento a �essione delle varie travi. È infatti necessario conoscere preventivamente
l'armatura longitudinale di estremità delle travi per poter e�ettuare il progetto a
taglio delle stesse ed il progetto a presso�essione dei pilastri. Si procede pertanto
assegnando il numero delle stazioni di output alle varie travi (Assign > Frame >
Output Stations) e lanciando il processo di design attraverso il comando Design
> Concrete Frame Design > Start Design/Check of Structure. I risultati ottenuti
dopo questa prima fase di progettazione saranno validi unicamente per stabilire
le armature longitudinali delle travi, pertanto tutte le altre grandezze verranno
ignorate. Al �ne di visualizzare le armature di progetto è su�ciente eseguire il
comando Design > Concrete Frame Design > Display Design Info > Design Out-
put > Longitudinal Reinforcing. I risultati ottenuti sono riportati in �gura 4.13
con riferimento alle stazioni di estremità e di mezzeria delle travi. Per conoscere
i risultati dettagliati, relativi alle singole sottostazioni, è su�ciente cliccare col
tasto destro su una qualsiasi trave della struttura.

Figura 4.13: armatura longitudinale di progetto delle travi

In base ai risultati ottenuti si evince come, per le stazioni di estremità delle
travi, sia necessario prevedere un'armatura superiore pari ad almeno 859 mmq
ed un'armatura inferiore pari a 404 mmq. Una delle possibili con�gurazioni
che soddisfano tali condizioni è data da un'armatura inferiore pari a 2 φ 16 ed
un'armatura superiore pari a 2 φ 16 + 2 φ 18. Ipotizzando di utilizzare tale
disposizione occorre sovrascrivere le armature di estremità delle varie travi come
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mostrato in �gura 4.14. Una volta impostato l'esatto valore di armatura per le
estremità delle travi è possibile rilanciare il progetto dell'intera struttura.

Figura 4.14: inserimento delle armature di estremità delle travi

A questo punto è possibile visualizzare l'output di progetto completo rela-
tivo alle varie travi. In particolare, oltre alle armature longitudinali, invariate
rispetto ai risultati visti in precedenza, è possibile visualizzare l'armatura a taglio
necessaria per le varie stazioni. A tal proposito è su�ciente accedere al menu
Design > Concrete Frame Design > Display Design Info > Design Output >
Shear Reinforcing. Dall'analisi dei risultati (riportati in �gura 4.15) si evince che
la quantità minima di armatura a taglio necessaria per le travi sia pari a 0.765
mm2/mm alle estremità e 0.526 mm2/mm in mezzeria. Delle sta�e φ 10 a passo
10 cm alle estremità e 20 cm in mezzeria soddisfano il criterio di resistenza.
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Figura 4.15: armatura a taglio di progetto delle travi

4.6 Progetto dei pilastri

Una volta completato il progetto delle travi è possibile e�ettuare il proget-
to dei pilastri in accordo coi criteri di resistenza e gerarchia. Analogamente a
quanto visto per le travi, dopo aver lanciato la veri�ca della struttura è possibile
visualizzare le armature longitudinali di progetto corrispondenti ai vari pilastri.
I valori ottenuti, riportati in �gura 4.16, permettono di stabilire l'esatta quan-
tità di armatura da disporre nelle posizioni prestabilite (vedi �gure 4.2 e 4.3).
In particolare, delle barre di diametro 14 mm soddisfano i requisiti di resistenza
speci�cati.
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Figura 4.16: armatura longitudinale di progetto dei pilastri

Analogamente a quanto visto per le travi, anche per quanto riguarda il pro-
getto a taglio dei pilastri occorre de�nire esattamente la quantità di armatura
longitudinale presente, in modo che i valori dei momenti resistenti vengano cal-
colati opportunamente. A tal proposito, nella scheda di de�nizione delle sezioni
occorre speci�care l'esatta dimensione delle barre (in questo caso 14 mm) e se-
lezionare la voce �Reinforcement to be Checked�. Lanciando successivamente la
veri�ca della struttura si otterranno i risultati di progetto de�nitivi.

4.7 Gerarchia delle resistenze trave-pilastro

Durante il progetto della stazione di sommità dei pilastri, qualora vi sia
almeno una trave incidente, viene condotta la veri�ca di gerarchia a �essione
trave-pilastro. I risultati possono essere visualizzati attraverso il menu Design >
Concrete Frame Design > Display Design Info > (1.3) Beam/Column Capacity
Ratio, opppure entrando nella scheda di dettaglio relativa all'ultima stazione del
pilastro. Dall'analisi della �gura 4.17, si evince come il criterio sia rispettato per
tutti i pilastri della struttra ad eccezione di quelli dell'ultimo piano per i quali,
comunque, la veri�ca non risulta necessaria.
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Figura 4.17: veri�ca gerarchia trave-pilastro

4.8 Progetto del nodo trave-pilastro

Durante il progetto della stazione di sommità dei pilastri, qualora vi sia al-
meno una trave incidente, viene condotto il progetto a taglio del nodo. I risultati
possono essere visualizzati attraverso il menu Design > Concrete Frame Design
> Display Design Info > Joint Shear Reinforcing, opppure entrando nella scheda
di dettaglio relativa all'ultima stazione del pilastro. Dall'analisi della �gura 4.18,
si evince come sia necessario disporre delle sta�e di area complessiva pari ad al-
meno 1575 mmq in ogni nodo, per un'altezza compresa fra lo strato di armatura
superiore ed inferiore delle travi. Delle sta�e φ 12 a passo 5 cm soddisfano il
criterio appena descritto.

93



Parte I Veri�ca elementi in calcestruzzo

Figura 4.18: progetto dell'armatura orizzontale del nodo trave-pilastro
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Capitolo 5

Informazioni generali

Nel presente capitolo verranno introdotti i concetti di base ed evidenziati i
passi fondamentali che compongono il processo di progettazione e veri�ca degli
elementi in acciaio.

All'interno di SAP2000 sono presenti degli algoritmi molto potenti in grado
di e�ettuare la progettazione e l'ottimizzazione di strutture in acciaio in base a
criteri di:

� Resistenza

� Deformabilità

� Target di periodo strutturale fondamentale

SAP2000 integra inoltre un post processore in grado di fornire risultati com-
pleti per quanto riguarda:

� Veri�che di resistenza agli stati limite ultimi di membrature in acciaio

� Veri�che allo stato limite di deformabilità di membrature in acciaio

5.1 Normativa di riferimento

La normativa di riferimento per il progetto/veri�ca degli elementi strutturali
deve essere determinata all'interno del menu Design > Steel Frame Design
> View/Revise Preferences. È possibile scegliere una normativa di progetto
qualsiasi da applicare ad una qualunque analisi di carico. Nella medesima esecu-
zione della procedura progettuale non è possibile progettare alcuni elementi se-
guendo una normativa ed altri seguendone un'altra, tuttavia è possibile realizzare
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esecuzioni progettuali diverse utilizzando normative di�erenti senza rilanciare le
analisi.

La descrizione dettagliata delle procedure di progetto/veri�ca implementa-
te per le varie normative è consultabile attraverso il menu Help > Docu-
mentation > Design > Steel Frame Design e speci�cando la normativa
desiderata.

5.2 Unità di misura

Per la progettazione di aste in acciaio, può essere utilizzato come input un set
qualsiasi di unità consistenti. Convenzionalmente, i codici progettuali sono basati
su uno speci�co set di unità (ad es. Newton - millimetri - secondi per l'EC2) ma
è comunque possibile utilizzare un qualunque sistema di unità di misura per
de�nire e progettare un edi�cio, come anche cambiare in qualsiasi momento il
sistema di unità che si sta utilizzando.

5.3 Assegnazione della procedura di progetto

Prima di procedere al progetto od alla veri�ca degli elementi strutturali oc-
corre associare agli stessi una determinata procedura di progetto. L'assegnazione
delle procedure di progetto ai vari elementi viene fatta a livello di de�nizione
della sezione.

In particolare, per elementi frame, de�nendo una sezione attraverso le libre-
rie prede�nite presenti all'interno del menu De�ne > Section properties >
Frame Sections e speci�cando come materiale un determinato acciaio, tutti gli
elementi cui verrà associata tale sezione verranno progettati e veri�cati come ele-
menti in acciaio. Per sezioni de�nite attraverso Section Designer occorre invece
spuntare, nella �nestra di de�nizione, l'opzione �General Steel Section�. È inoltre
possibile escludere taluni elementi dal processo di veri�ca assegnando, attraverso
il comando Design > Overwrite Frame Design Procedure, l'opzione No
Design.

5.4 Combinazioni di carico di progetto

Il programma crea automaticamente un numero di combinazioni di carico di
progetto in base alla normativa selezionata. E' possibile aggiungere combinazioni
personalizzzate oppure modi�care o cancellare le combinazioni di default del pro-
gramma. Le combinazioni di carico da includere nel processo di progetto/veri�ca
possono essere speci�cate attraverso il menu Design > Steel Frame Design
> Select Design Combos.
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Tutti i codici di calcolo prevedono la combinazione dei carichi e delle azioni
attraverso l'uso di fattori moltiplicativi. I fattori utilizzati ed il modo in cui ca-
richi e le azioni vengono combinati dipendono dal codice di calcolo selezionato.
Più in dettaglio i fattori di combinazione vengono applicati alle forze ed ai mo-
menti corrispondenti alle analisi dei singoli casi di carico. I valori così ottenuti
vengono poi sommati per ottenere le forze ed i momenti relativi alla combinazio-
ne di carico. Eseguendo l'analisi ad elementi �niti per i singoli casi di carico e
poi sommando i risultati moltiplicati per i fattori di carico, è possibile de�nire le
varie cambinazioni anche dopo aver lanciato l'analisi della struttura.

Per combinazioni di carico che comprendono analisi a spettro di risposta,
analisi time history, analisi a carichi mobili, e combinazioni del tipo invilup-
po, srss, somma dei valori assoluti... dove pertanto ogni corrispondenza fra le
quantità interagenti viene persa, il programma crea automaticamente le
sottocombinazioni multiple usando permutazioni di massimi/minimi
delle quantità interagenti. La procedura di permutazione appena descritta
genera quindi otto scenari di veri�ca distinti per ogni combinazione.

Nota: non sono richieste combinazioni separate con fattori negativi per i casi di
carico a spettro di risposta poiché il valore derivante dall'analisi viene automati-
camente assunto sia con segno positivo che negativo.

Come anticipato, per le combinazioni di carico standard che includono cari-
chi statici (come carichi permanenti, carichi variabili, carico da vento e carico
da sisma) e/o carichi dinamici (come il carico sismico generato da uno spettro di
risposta), il programma è dotato di una procedura per la generazione di combina-
zioni di default. Tali combinazioni sono basate sulle raccomandazioni contenute
nel relativo codice di progetto. Le combinazioni di carico di default assumo-
no come presupposto che tutti gli schemi di carico dichiarati come permanenti
(DEAD) siano addittivi. Allo stesso modo, tutti gli schemi di carico dichiarati
come variabili (LIVE) sono considerati addittivi. Ogni schema di carico statico
dichiarato come da vento (WIND) o da sisma (QUAKE), o i casi di carico a
spettro di risposta, sono considerati non addittivi fra di loro e danno luogo a
combinazioni di carico laterale multiple (nel caso di carichi da vento e carico da
sisma statico anche con permutazione di segno).

Qualora le combinazioni generate automaticamente non siano corrette, e/o
qualora vi sia la necessità di inserire altri scenari di carico non inclusi, l'utente
deve intervenire correggendo e/o inserendo manualmente le combinazioni.

5.5 Stazioni di progetto

Per ogni combinazione di carico, ogni elemento viene progettato e/o veri�cato
in un numero prede�nito di stazioni distribuite in modo equidistante su tutta la
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sua lunghezza. Il numero di stazioni per ogni elemento frame può essere impostato
dall'utente, prima di e�ettuare l'analisi della struttura, attraverso il menuAssign
> Frame > Output Stations.

5.6 Gerarchia delle resistenze

I più importanti codici normativi a livello internazionale prevedono che la
progettazione sismica delle strutture sia basata sul criterio della gerarchia delle
resistenze. SAP2000 integra pienamenente tali indicazioni e�ettuando, per tutte
le combinazioni sismiche selezionate, una progettazione in grado di garantire il
soddisfacimento delle prescrizioni sismiche con riferimento alle seguenti tipologie
strutturali:

� strutture a telaio

� strutture con controventi concentrici

� strutture con controventi eccentrici

Le modalità di controllo dei criteri di gerarchia sopra citati sono funzione
della normativa di calcolo selezionata. Tutti i dettagli relativi alle procedure
implementate per i diversi codici sono reperibili all'interno del percorso Help >
Documentation > Design > Steel Frame Design.

5.7 E�etti del secondo ordine

Le normative richiedono solitamente che gli e�etti del secondo ordine ven-
gano considerati quando si progettano telai in acciaio. Gli e�etti del secondo
ordine hanno origine da due fonti: la traslazione laterale globale del telaio e la
deformazione locale dei singoli elementi del telaio.

Si consideri l'elemento asta mostrato nella �gura 5.1 facente parte di una
data struttura: il drift globale fra le estremità dell'elemento è indicato con ∆,
viceversa la deformazione locale dello stesso è indicata con δ. Gli e�etti totali
del secondo ordine nell'elemento sono determinati sia da ∆ che da δ.

SAP2000 è in grado di cogliere l'in�uenza di entrambi gli aspetti sul com-
portamento globale della struttura attraverso un'analisi non lineare P-Delta o
in grandi spostamenti. A�nché il contributo dello sbandamento locale dell'ele-
mento venga colto in maniera corretta è necessario che lo stesso sia �sicamente
suddiviso in più elementi intermedi.

Al �ne di impostare un'analisi di tipo P-Delta o in grandi spostamenti è
necessario de�nire un caso di analisi di tipo statico non lineare o di tipo time
history non lineare e scegliere fra i possibili parametri di non linearità geometrica:
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Figura 5.1: e�etti del secondo ordine su un elemento

� P-Delta: in tal caso la matrice di rigidezza degli elementi viene costruita
tenendo conto dell'interazione fra l'azione assiale e �ettente. Così facendo
viene correttamente modellato l'e�etto instabilizzante dei carichi assiali di
compressione e quello stabilizzante dei carichi assiali di trazione sul com-
portamento �ettente degli elementi. La matrice di rigidezza diventa perciò
funzione dello stato sollecitante e deve essere calcolata attraverso un pro-
cesso iterativo. Per carichi assiali di compressione molto elevati, vicini
ai carichi critici degli elementi, potrebbe essere necessario intervenire sui
parametri di convergenza dell'analisi

� P-Delta più grandi spostamenti: scegliendo tale opzione, in aggiunta all'a-
nalisi P-Delta, si assume che la struttura sia soggetta a grandi spostamenti
e, pertanto, l'ipotesi di riferire le equazioni di equilibrio alla con�gurazione
indeformata non abbia signi�cato. Il sistema risolvente viene pertanto as-
semblato a partire dalla con�gurazione deformata della struttura seguendo
un processo iterativo. Il primo passo consiste nell'applicare i carichi alla
struttura e calcolare la soluzione in termini di spostamenti tenendo con-
to dell'e�etto P-Delta. La con�gurazione deformata così ottenuta sarà la
con�gurazione cui verranno riferite le equazioni di equilibrio al passo suc-
cessivo. In sostanza la soluzione al passo i-esimo viene calcolata tenendo
conto dell'e�etto P-Delta applicato alle matrici delle proprietà strutturali
relative al passo i-1. La procedura descritta è quindi doppiamente iterativa:
vi è un'iterazione �principale� per il calcolo della con�gurazione cui riferire
le matrici delle proprietà strutturali, ed un'iterazione �secondaria�, all'in-
terno del generico passo, per il calcolo della matrice di rigidezza che tiene
conto dell'interazione assiale. Il processo termina quando le con�gurazio-
ni corrispondenti a due passi successivi di�ersicono meno della tolleranza
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speci�cata. Alla luce di quanto detto, un'analisi P-Delta in grandi sposta-
menti risulta molto più sensibile ai parametri di convergenza rispetto ad
una semplice analisi P-Delta

In generale quindi, al �ne di rappresentare correttamente gli e�etti del secondo
ordine su una data struttura, occorre de�nire gli opportuni casi di analisi non
lineare. Nella stragrande maggioranza dei casi pratici è su�ciente fare riferimento
ad analisi P-Delta mentre le analisi in grandi spostamenti si rendono necessarie
solo per particolari tipologie strutturali. Trattandosi di analisi non lineari, in
linea di principio, occorrerebbe de�nire un'analisi diversa per ogni combinazione
strutturale in quanto il principio di sovrapposizione degli e�etti non risulta più
valido.

Nella pratica progettuale tuttavia, è solitamente possibile e�ettuare un'uti-
le sempli�cazione de�nendo un unico caso non lineare P-Delta, comprendente i
carichi verticali più signi�cativi, e lanciare le successive analisi lineari a partire
dalla rigidezza corrispondente al caso P-Delta de�nito. In tal modo sarà possi-
bile cogliere gli e�etti instabilizzanti sulla struttura e allo stesso tempo costruire
combinazioni di carico basate sul principio di sovrapposizione degli e�etti. La
rigidezza corrispondente al caso di analisi P-Delta può essere usata anche come
rigidezza di partenza per un'analisi modale in modo da considerare opportu-
namente gli e�etti del secondo ordine anche nelle eventuali analisi a spettro di
risposta.

Come anticipato, le analisi P-Delta vengono solitamente utilizzate allo sco-
po di cogliere gli e�etti globali sulla struttura mentre gli eventuali e�etti locali
vengono tenuti in considerazione attraverso procedure sempli�cate basate sulla
snellezza degli elementi. Qualora si sia utilizzata un'analisi P-Delta e gli elementi
siano stati opportunamente suddivisi allo scopo di cogliere sia gli e�etti globali
che gli e�etti locali, è opportuno disabilitare tutte le procedura di ampli�cazione
delle sollecitazioni per la valutazione degli e�etti del secondo ordine in fase di
veri�ca.

5.8 Lunghezze libere di in�essione degli elementi

Le lunghezze di libera in�essione degli elementi sono necessarie per la deter-
minazione mediante metodi approssimati degli e�etti locali del secondo ordine
agenti sugli stessi. Tali quantità sono espresse come prodotto dei termini:

Lii = lii · kii · L

in cui:
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Lii lunghezza libera di in�essione secondo l'asse i-i
lii rapporto fra la distanza dei punti di supporto dell'elemento e

la lunghezza dell'elemento in esame (Unbraced Lenght Ratio)
kii coe�ciente di lunghezza e�ettiva per lo sbandamento secondo

l'asse i-i (E�ective Lenght Factor)
L lunghezza dell'elemento

Il signi�cato dei termini appena introdotti può essere facilmente interpretato
considerando l'esempio riportato in 5.2.

SAP2000 è dotato di algoritmi per la determinazione automatica dei parame-
tri lii e kii. Il primo viene determinato attraverso il rapporto fra la distanza dei
punti di ritegno del generico elemento e la sua lunghezza, viceversa il secondo
viene calcolato in funzione del rapporto fra la rigidezza �essionale dell'elemento e
quella degli elementi di ritegno laterale. Tale procedura, descritta compiutamen-
te al paragrafo 5.9, è valida per strutture continue a nodi spostabili per le quali
il valore del parametro kii può assumere valori superiori all'unità. Per strutture
a nodi �ssi (controventate) il parametro kii è assunto cautelativamente pari ad
1. Entrambi i valori dei parametri l e k vengono determinati indipendentemente
per entrambe le direzioni principali. Per le membrature in acciaio, in aggiunta
alle lunghezze di libera in�essione lungo i piani principali, può assumere partico-
lare rilevanza il valore della lunghezza di libera in�essione per instabilità �esso
torsionale. Tale lunghezza è, solitamente, assunta pari alla lunghezza di libera
in�essione lungo la direzione debole ma può, nei casi pratici, essere di�erente. Per
tale ragione in aggiunta ai valori di l e k corrispondenti alle direzioni principali
è possibile speci�care il valore dei parametri lLTB e kLTB relativi all'intsbilità
�esso-torsionale.

I valori dei parametri così calcolati possono essere sovrascritti in ogni mo-
mento dall'utente attraverso il comando Design > Steel Frame Design >
View/Revise Overwrites. È molto importante che, in fase di veri�ca, venga
sempre controllata la bontà dei parametri utilizzati al �ne di scongiurare even-
tuali grossolani errori di calcolo.
In particolare, in assenza di ritegni laterali ad un estremo dell'asta, il program-
ma assume che il pilastro sia controventato ed assume un valore di kii pari al-
l'unità. Sarà pertanto compito dell'utente sovrascrivere tale valore qualora il
comportamento dell'elemento fosse diverso (ad es. a mensola).

5.9 Calcolo automatico dei coe�cienti di lunghez-
za e�ettettiva (k)

Il programma determina automaticamente i fattori k per elementi asta. Que-
sti fattori k possono essere, se desiderato, sovrascritti dall'utente utilizzando
il comando Design > Steel Frame Design > View/Revise Overwrites.
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Figura 5.2: calcolo della luce libera di in�essione degli elementi
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Per alcuni utili consigli sui modi in cui il programma calcola i fattori k si dia
un'occhiata all'elenco puntato alla �ne di questa sezione.

L'algoritmo per il calcolo del fattore k è stato sviluppato per edi�ci a telaio
continuo, in cui i pilastri sono verticali e le travi orizzontali, per le quali il calcolo
del fattore k risulta relativamente complesso. Ai �ni del calcolo dei fattori k, gli
elementi sono identi�cati come pilastri, travi e controventi. Tutti gli elementi
paralleli all'asse Z vengono classi�cati come pilastri. Tutti gli elementi paralleli
al piano X-Y vengono classi�cati come travi. I rimanenti sono controventi. Alle
travi ed ai pilastri sono assegnati fattori k unitari. Nel calcolo dei fattori k per
un pilastro, il programma esegue per prima cosa le seguenti quattro somme per
ogni nodo nel modello strutturale:

Scx =
∑(

Ec Ic
Lc

)
x

Sbx =
∑(

Eb Ib
Lb

)
x

Scy =
∑(

Ec Ic
Lc

)
y

Sby =
∑(

Ec Ic
Lc

)
y

dove i pedici x e y corrispondono alle direzioni globali X e Y e i pedici c e b
si riferiscono a pilastro e trave. I termini, locali 2-2 e 3-3, EI22/L22 e EI33/I33
vengono ruotati per dare i componenti lungo le direzioni globali X e Y a for-
mare i valori (EI/L)x e (EI/L)y. Quindi per ogni pilastro, le somme nel nodo
all'estremità I e J dell'elemento vengono trasformati all'indietro nel sistema di
coordinate locali 1-2-3 del pilastro e i valori G per gli estremi I e J dell'elemento
vengono calcolati secondo le direzioni 2-2 e 3-3 come segue:

GI22 =
SIc22
SIb22

GJ22 =
SJc22
SJb22

GI33 =
SIc33
SIb33

GJ33 =
SJc33
SJb33

Se esiste un rilascio torsionale in una particolare estremità (e direzione) di un
elemento, il corrispondente valore è impostato a 10.0. Se tutti i gradi di libertà
di un particolare nodo vengono cancellati, il valore G per tutti gli elementi che
si connettono in quel nodo verrà impostato a 1.0 per l'estremità dell'elemento
che si connette a quel nodo. In�ne, se GI e GJ sono noti per una particolare
direzione, il fattore k del pilastro per la direzione corrispondente viene calcolato
risolvendo la seguente relazione per α:

α2GI GJ − 36

6 (GI +GJ)
=

α

tanα

da cui k = π/α . Questa relazione è la formulazione matematica per la valuta-
zione dei fattori k per telai resistenti a momento assumendo che lo sbandamento
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laterale (sidesway) non sia inibito. Per altre strutture, ad esempio strutture a
telaio controventato, i fattori k, per tutti gli elementi, sono usualmente unitari e
dovrebbero essere impostati così dall'utente.

I seguenti aspetti associati all'algoritmo del fattore k per i pilastri, rivestono
una certa importanza:

� Un elemento che ha una cerniera (pin) nel nodo in considerazione non entra
nella sommatoria delle rigidezze riportata sopra. Un elemento che ha una
cerniera (pin) nell'estremità più lontana rispetto al nodo in considerazione
contribuirà solamente per il 50% al valore calcolato di EI. Inoltre, gli
elementi trave che non hanno elementi pilastro nell'estremità più lontana
dal nodo in considerazione, come ad esempio le mensole, non entreranno
nella sommatoria delle rigidezze.

� Se non ci sono travi che si uniscono in un elemento pilastro in una deter-
minata direzione, il valore G associato sarà in�nito. Se il valore G in una
qualunque estremità del pilastro per una particolare direzione è in�nito, il
fattore k corrispondente in quella direzione è impostato all'unità.

� Se i rilasci torsionali esistono in entrambe le estremità dell'elemento per
una particolare direzione, il corrispondente fattore k è impostato all'unità.

� La procedura di calcolo automatico del fattore k può occasionalmente ge-
nerare valori arti�cialmente alti di k, speci�catamente quando vi sono travi
in varie direzioni oppure condizioni di supporto �sso o ancora in altre con-
dizioni in cui il programma potrebbe avere di�coltà a riconoscere che gli
elementi sono supportati lateralmente e che devono essere usati fattori k
unitari.

� Tutti i fattori k generati dal programma possono essere sovrascritti dall'u-
tente. Questi valori dovrebbero essere revisionati e ogni valore inacettabile
dovrebbe essere rimpiazzato.

� Alle travi e ai controventi vengono assegnati valori di k unitari.

5.10 Sezioni di analisi e sezioni di progetto

La procedura di progetto/veri�ca integrata all'interno di SAP2000 è forte-
mente interattiva e permette all'utente di variare numerosi dei parametri in gioco
senza dover ripetere l'analisi completa del modello. In particolare, in fase di post
processamento, è possibile assegnare in qualsiasi momento ad un dato elemen-
to una sezione diversa da quella utilizzata nell'analisi. In tal modo è possibile
rilanciare unicamente il processo di veri�ca in modo da avere una rapida stima
dell'e�etto della variazione apportata.
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Il comando per assegnare ad un elemento una determinata sezione di proget-
to è raggiungibile dal menu Design > Steel Frame Design > View/Revise
Overwrites. Alla voce Current Design Section è possibile imporre che la sezione
di progetto sia la medesima utilizzata in fase di analisi, opzione Program Deter-
mined, oppure assegnare come sezione di progetto una qualunque delle sezioni
de�nite.

È importante sottolineare che l'assegnazione di una sezione di�erente da quel-
la utilizzata per l'analisi comporta, in generale, anche una ridistribuzione degli
sforzi sui vari elementi a seguito della variazione di rigidezza introdotta. Risulta
pertanto fondamentale, una volta e�ettuate le modi�che in fase di post processa-
mento, ripetere l'intero processo di analisi e veri�ca utilizzando le sezioni correnti.
Per individuare l'eventuale presenza di elementi con sezione di analisi e progetto
diverse è su�ciente eseguire il comando Design > Steel Frame Design >
Verify Analysis vs Design Sections.
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Capitolo 6

Procedure di progetto e

veri�ca per elementi in acciaio

In questo capitolo viene descritto il processo di base da seguire per progetta-
re o veri�care membrature in acciaio utilizzando SAP2000. Sebbene i passaggi
esatti da seguire possano, in generale, variare da caso a caso, i passi fondamentali
per la progettazione dovrebbero essere simili a quelli descritti di seguito.
Il post processore per il progetto di elementi in acciaio può progettare o veri�-
care sia strutture a telaio continuo che strutture controventate (con controventi
eccentrici o concentrici).

6.1 Veri�ca di elementi frame in acciaio

Vengono di seguito riportati i passi fondamentali per la corretta veri�ca di
elementi asta in acciaio. Come anticipato la sequenza o il numero delle assegna-
zioni potrà variare da caso a caso ma, in generale, la procedura descritta sarà
su�ciente per eseguire il progetto/veri�ca di un qualunque elemento strutturale.

1. Creare il modello dell'edi�cio.

2. Assegnare agli elementi frame la procedura di progettazione. Nel caso si
utilizzino le sezioni parametriche prede�nite in SAP, la procedura di proget-
to è assegnata automaticamente in funzione del materiale scelto, viceversa
per sezioni de�nite tramite Section Designer è necessario speci�care il tipo
di progettazione.

3. Eseguire l'analisi dell'edi�cio.
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4. Speci�care il codice di veri�ca, scegliendo tra quelli presenti all'interno
del menu Design > Steel Frame Design > View/Revise Preferen-
ces, e de�nire i parametri generali ad esso associati (se diversi da quelli di
Deafult).

5. De�nire le combinazioni di carico da veri�care attraverso il menuDesign >
Steel Frame Design > Select Design Combos. È possibile scegliere
se utilizzare o meno le combinazioni di default previste per il codice di
calcolo selezionato, inoltre è sempre possibile inserire manualmente delle
combinazioni di carico create dall'utente.

6. Eseguire il progetto/veri�ca degli elementi attraverso il comando Design
> Steel Frame Design > Start Design/Check of Structure.

7. Revisionare i risultati del progetto attraverso il menu Design > Steel
Frame Design > Display Design Info. Attraverso tale comando è
possibile visualizzare a schermo i risultati corrispondenti a tutti gli elementi
frame in acciaio presenti nel modello. Cliccando col pulsante destro su
un qualunque elemento verrà aperta la �nestra dei dettagli di progetto
attraverso cui sarà possibile avere accesso alle procedure di calcolo relative
a tutte le stazioni dell'elemento e corrispondenti a tutte le combinazioni di
carico speci�cate.

8. Assegnare, se necessario, le sovrascritture agli elementi in acciaio i cui pa-
rametri di progetto non fossero risultati coerenti con le ipotesi fatte. A
tal �ne è possibile operare in due modi: selezionare gli elementi ed asse-
gnare le sovrascritture attraverso il menu Design > Steel Frame Desi-
gn > View/Revise Overwrites, oppure accedere alla �nestra di detta-
glio del singolo elemento e speci�care le sovrascritture cliccando sul tasto
�Overwrites�.

9. Qualora fosse necessario, assegnare una diversa sezione di progetto agli ele-
menti non veri�cati attraverso il comandoDesign > Steel Frame Design
> Change Design Section.

10. Ripetere i passi dal 6 al 9 �nché tutti gli elementi vengono correttamente
progettati o veri�cati.

11. Una volta soddisfatti dei risultati ottenuti, veri�care che tutte le sezioni di
progetto coincidano con le sezioni di analisi attraverso il comando Design
> Steel Frame Design > Verify Analysis vs Design Section. In
caso a�ermativo la procedura di progetto può considerarsi conclusa, in caso
contrario occorre ristabilire la congruenza fra sezioni di progetto e sezioni di
analisi, rilanciare l'analisi della struttura e ripetere la procedura di progetto
dal punto 6 al punto 10 �no ad ottenere dei risultati soddisfacenti e la totale
coincidenza fra sezioni di analisi e sezioni di progetto.
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È importante notare che questo tipo di progettazione è un processo iterativo.
Le sezioni utilizzate nell'analisi originale non sono solitamente le stesse di quelle
ottenute alla �ne del processo di progettazione. È consigliabile eseguire sempre
l'analisi dell'edi�cio utilizzando le sezioni de�nitive delle aste e quindi eseguire
un controllo sul progetto utilizzando le forze corrispondenti.

6.2 Veri�che interattive di elementi frame in ac-
ciaio

L'algoritmo di veri�ca interattivo permette all'utente di intervenire in tem-
po reale sui risultati in modo da valutare, istantaneamente, gli e�etti provocati
da una qualunque modi�ca nei parametri di veri�ca di un dato elemento. At-
traverso tale procedura è infatti possibile assegnare una qualsiasi sovrascrittura
all'elemento ed ottenere istantaneamente i risultati aggiornati.

A�nché la modalità di veri�ca interattiva sia disponibile, deve essere sta-
to precedentemente eseguito il comando Design > Steel Frame Design >
Start Design Check of Structure. Completata la procedura, una volta che
i risultati vengono visualizzati a schermo, per intervenire interattivamente è suf-
�ciente cliccare col tasto destro del mouse su un qualunque elemento frame. Se
i risultati della veri�ca non sono correntemente visualizzati (ma la veri�ca è co-
munque stata eseguita), è necessario accedere al menu Design > Steel Frame
Design > Interactive Steel Frame Design e quindi cliccare col tasto destro
sull'elemento da modi�care interattivamente. In entrambi i casi si aprirà una
�nestra di dettaglio attraverso la quale sarà possibile accedere alle sovrascritture
dell'elemento attraverso il tasto �Overwrites� (vedi �gura 6.2). Modi�cando uno
qualunque di tali parametri, il programma aggiornerà di conseguenza la veri�ca
dell'elemento.
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Figura 6.1: progettazione interattiva degli elementi frame

6.3 Progetto e ottimizzazione di elementi frame
in acciaio

SAP2000 integra un algoritmo molto potente che permete di e�ettuare in au-
tomatico il progetto e l'ottimizzazione di elementi frame in acciaio secondo criteri
di resistenza e deformabilità. In particolare, in aggiunta ai criteri di resistenza,
è possibile imporre il soddisfacimento di determinati limiti deformativi o �ssare
dei target di periodo strutturale. SAP2000 sceglierà in automatico le sezioni che,
ottimizzando il peso strutturale, riescono a garantire il soddisfacimento di tutti
gli obbiettivi di progetto. Il processo descritto è iterativo e consta dei seguenti
passaggi:

1. occorre preliminarmente inserire l'elenco delle sezioni fra cui il programma
può scegliere la sezione di progetto. A tal �ne è necessario de�nire, per le
varie tipologie strutturali (travi, colonne, controventi di falda ecc...) delle
liste di sezioni potenziali. Tale procedimento può essere e�ettuato attra-
verso il menu De�ne > Section Properties > Frame Sections > Add New
Property > Steel e selezionando la voce �Auto Select List�. Ad una generica
lista possono essere associate un generico numero di sezioni fra quelle de�-
nite in precedenza (vedi �gura 6.2). È inoltre necessario speci�care quale
sezione della lista debba essere presa come sezione di partenza per la prima
analisi della struttura.

2. una volta de�niti gli elenchi occorre associare alle varie tipologie di elementi
la lista corrispondente. Questa operazione può essere condotta attraverso
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Figura 6.2: de�nizione delle liste di sezioni

il comando Assign > Frame > Frame Sections.

3. completata l'assegnazione delle sezioni può essere lanciata l'analisi del mo-
dello strutturale. Le sezioni che verrannno impiegate dal programma sa-
ranno le sezioni di partenza corrispondenti alle varie liste de�nite.

4. prima di iniziare la procedura di ottimizzazione occorre de�nire gli obbiet-
tivi di progetto. In particolare possono essere de�niti:

� target di resistenza: le membrature devono essere conformi ai criteri
di resistenza imposti dal codice di veri�ca impostato nel menu Desi-
gn > Steel Frame Design > View/Revise Preferences. A�nché tale
criterio venga imposto come obbiettivo di progetto occorre speci�care
le combinazioni di carico all'interno del menu Design > Steel Frame
Design > Select Design Combos

� target di spostamento: è possibile imporre come obbiettivo di proget-
to il non superamento di determinati limiti di spostamento per de-
terminate condizioni di carico. Tale condizione può essere impostata
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attraverso il menu Design > Steel Frame Design > Set Displacements
Target speci�cando condizione di carico e spostamento limite

� target di periodo strutturale: speci�cando dei periodi limite per i vari
modi di vibrare attraverso il menu Design > Steel Frame Design >
Set Time Period Target.

5. �ssati gli obbiettivi di progetto è possibile de�nire dei gruppi omogenei di
elementi che abbiano la medesima sezione. Questa opzione è molto utile
per condizionare la progettazione ed ottenere risultati ingegneristicamente
consistenti. A tal �ne occorre creare i gruppi di elementi attraverso il co-
mando De�ne > Groups, selezionare gli elementi che si vuole appartengano
ad un dato gruppo ed associarli mediante il comando Assign > Assign to
Group.

6. a questo punto è possibile lanciare l'analisi del modello strutturale. Il pro-
gramma procederà al calcolo delle sollecitazioni utilizzando come sezioni
di partenza le sezioni di base de�nite per le varie liste. Una volta com-
pletata l'analisi può essere lanciato il progetto della struttura attraverso il
comando Design > Steel Frame Design > Start Design/Check of Structure.
Il programma procederà al calcolo delle sezioni che soddisfano i criteri di
progetto imposti sulla base dei risultati ottenuti dall'analisi. Alla �ne del
processo di calcolo verranno mostrate, accanto ai vari elementi, le sezioni
di progetto così determinate.

7. ovviamente le sezioni di progetto così calcolate, in generale, di�eriranno
da quelle utilizzate in fase di analisi. Per veri�care la congruenza fra le
sezioni di analisi e di progetto è su�ciente eseguire il comando Design >
Steel Frame Design > Verify Analysis vs Design Section. Qualora siano
presenti elementi con sezione di analisi di�erente dalla sezione di progetto
occorre sbloccare il modello e rilanciare l'analisi. In questa successiva analisi
le sezioni utilizzate saranno quelle derivanti dal processo di progettazione
precedente. Conclusa l'analisi è possibile condurre nuovamente la procedura
di progetto e veri�care nuovamente la congruenza fra sezioni di analisi e di
progetto. I passi appena descritti vanno condotti �nché, al termine della
progettazione, viene ottenuta una perfetta corrispondenza fra sezioni di
analisi e sezioni di progetto.

6.4 Visualizzazione dei risultati di progetto/veri�ca
per elementi frame in acciaio

I risultati del processo di veri�ca degli elementi frame in acciaio possono
essere visualizzati direttamente a schermo oppure in forma tabellare. Nel primo
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caso è su�cente accedere al menu Design > Steel Frame Design > Display
Design Info. È possibile scegliere se visualizzare i dati relativi all'input oppure
all'output di progetto. Le informazioni di input visualizzabili sono:

� Design Sections: sezioni di progetto

� Design Framing Type: tipo di struttura di cui l'elemento fa parte (telaio
continuo, struttura a controventi eccentrici o concentrici...)

� Unbraced Length Ratios: rapporto fra la distanza dei punti di supporto
e la lunghezza dell'elemento (vedi paragrafo 5.8)

� E�ective Lenght Factors: coe�ciente di vincolo (vedi paragrafo 5.8)

� altri fattori dipendenti dalla normativa selezionata

Le informazioni relative all'output sono invece:

� P-M Ratio Colors & Values: visualizzazione numerica e gra�ca dei
fattori di utilizzo a presso�essione attraverso un'opportuna scala cromatica

� P-M Colors/Shear Ratio Values: visualizzazione gra�ca dei fatto-
ri di utilizzo a presso�essione attraverso un'opportuna scala cromatica e
rappresentazione numerica dei coe�cienti di utilizzo a taglio

� P-M Ratio Colors no Values: visualizzazione gra�ca dei fattori di
utilizzo a presso�essione attraverso un'opportuna scala cromatica

� P-M Ratio Colors no Values: visualizzazione gra�ca dei fattori di
utilizzo a presso�essione attraverso un'opportuna scala cromatica

� Identify P-M Failure: identi�cazione degli elementi non veri�cati per
l'interazione P-M

� Identify Shear Failure: identi�cazione degli elementi non veri�cati a
taglio

� Identify All Failure: identi�cazione degli elementi non veri�cati

In alternativa i risultati possono essere esportati in forma tabellare attraverso
il comando Display > Show Tables > DESIGN DATA > Steel Frame
scegliendo fra le opzioni:

� Steel Summary Data: tabella riassuntiva delle veri�che di resistenza
condotte sugli elementi frame contenente, per ogni elemento, il fattore di
utilizzo massimo e la corrispondente combinazione

� Steel Detail Data: tabelle di dettaglio relative a tutte le veri�che di
resistenza e gerarchia condotte sugli elementi frame in acciaio

All'interno di tali tabelle sono riportate, in forma condensata, tutte le informa-
zioni visualizzabili a schermo sul modello coi metodi visti in precedenza.

115



Parte II Veri�ca elementi in acciaio

116



Capitolo 7

Progetto secondo Eurocodice

3 ed Eurocodice 8

Nel presente capitolo verranno descritte le procedure di calcolo implementate
all'interno di SAP2000 per la veri�ca degli elementi in acciaio secondo l'Euroco-
dice 3-2004 integrato con le prescrizioni sismiche presenti nell'Eurocodice 8-2004.
Per semplicità, tutte le equazioni riportate nel presente capitolo sono espresse in
Newton-millimetri-secondi, salvo dove diversamente speci�cato.

7.1 Assi di riferimento

L'Eurocodice 3 è basato sulla coppia di assi y-y e z-z, tali assi corrispondono,
rispettivamente, agli assi 2-2 e 3-3 di SAP2000.

7.2 Notazioni

Tutte le notazioni ed i simboli usati nel presente capitolo sono di seguito ri-
portati:

A Area della sezione, mm2

Anet Area netta della sezione, mm2

Av Area e�cace per il taglio, mm2

Aw Area dell'anima, mm2

b Larghezza della sezione, mm
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C1 Coe�ciente di momento

E Modulo di elasticità dell'acciaio, N/mm2

fu Tensione ultima dell'acciaio, N/mm2

fy Tensione di snervamento dell'acciaio, N/mm2

fyw Tensione di snervamento dell'anima, N/mm2

h Altezza della sezione, mm

hw Altezza dell'anima, mm

I Momento d'inerzia, mm4

kyy, kzz, kyz, kzy Fattori di interazione

Lcr Lunghezza libera di in�essione, mm

Mb,Rd Momento resistente per instabilità �esso torsionale, Nmm

Mc,Rd Momento resistente della sezione, Nmm

MEd Momento sollecitante di progetto, Nmm

Mel,Rd Momento resistente elastico della sezione, Nmm

Mpl,Rd Momento resistente plastico della sezione, Nmm

MRk Momento resistente caratteristico, Nmm

MV,Rd Momento resistente ridotto per l'interazione col taglio, Nmm

Nb,Rd Resistenza a compressione per instabilità piana, N

Ncr Carico critico euleriano, N

Nc,Rd Resistenza a compressione della sezione, N

NEd Sforzo normale di progetto, N

Npl,Rd Resistenza plastica a compressione della sezione, N

NRk Resistenza caratteristica a compressione della sezione, N

Nt,Rd Resistenza a trazione della sezione, N

Nu,Rd Resistenza ultima a trazione della sezione, N

tf Spessore della �angia, mm

tw Spessore dell'anima, mm

Vc,Rd Taglio resistente della sezione, N

Vb,Rd Taglio resistente per instabilità del pannello d'anima, N

Vbf,Rd Contributo della �angia alla resistenza a taglio per instabilità,
N
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Vbw,Rd Contributo dell'anima alla resistenza a taglio per instabilità, N

VEd Taglio sollecitante di progetto, N

Vpl,Rd Taglio resistente plastico, N

Wel,min Modulo resistente elastico minimo della sezione, mm3

Wpl Modulo resistente plastico della sezione, mm3

α, αLT Fattori di imperfezione

χ Fattori di riduzione della resistenza per instabilità piana

χLT Fattore di riduzione della resistenza per instabilità �esso-
torsionale

ε Coe�ciente dipendente da fy

φ Parametro per il calcolo del fattore χ

φLT Parametro per il calcolo del fattore χLT

γM0 Coe�ciente di parziale di sicurezza per l'acciaio usato nel calcolo
della resistenza della sezione

γM1 Coe�ciente di parziale di sicurezza per l'acciaio usato nel calcolo
della resistenza per instabilità

γM2 Coe�ciente di parziale di sicurezza per l'acciaio usato nel calcolo
della resistenza ultima a trazione

η Coe�ciente per l'area resistente a taglio

λ̄ Snellezza adimensionale per instabilità piana

¯λLT Snellezza adimensionale per instabilità �esso-torsionale

λ̄w Snellezza adimensionale per instabilità a taglio

ρ Fattore di riduzione della resistenza per e�etto del taglio

ψ Rapporto fra i momenti �ettenti di estremità di un elemento

7.3 Assunti e limitazioni

Vengono di seguito riportati gli assunti e le limitazioni presenti all'interno
dell'algoritmo di progetto in accordo con l'Eurocodice 3-2005. Tutti gli assun-
ti e le limitazioni devono essere attentamente analizzati dagli utenti prima di
intraprendere il processo di progettazione.
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7.3.1 Assunti

I seguenti assunti sono alla base del procedimento di progetto generale:

� la geometria del modello di analisi, le sue proprietà ed i carichi assegnati
rappresentano adeguatamente la struttura per il caso limite in esame (EC3
5.11)

� si assume che gli acciai impiegati siano conformi a quanto prescritto nella
tabella 3.1 dell'EC3 o alle appendici nazionali speci�che

� le combinazioni di carico automatiche sono basate sullo stato limite ultimo
di resistenza (STR) e sullo stato limite di esercizio con riferimento alla
condizione quasi permanente

I seguenti assunti sono alla base della veri�ca degli elementi per azioni assiali:

� le sezioni tubolari laminate a caldo sono ipotizzate essere ri�nite a caldo
per la scelta della curva di instabilità corrispondente (EC3 Tabella 6.2).
Questa ipotesi è non conservativa qualora il pro�lo sia laminato a freddo

� per sezioni scatolari saldate, se b/tf < 30 e h/tw < 30 si assume che lo
spessore della saldatura risulti maggiore di 0.5tf (EC3 Tabella 6.2)

I seguenti assunti sono alla base della veri�ca degli elementi per azioni �ettenti:

� il carico è ipotizzato applicato al centro di taglio dell'elemento per il calcolo
del momento critico di instabilità. Qualunque momento parassita dovuto
ad una diversa posizione del carico non viene considerato nel calcolo

I seguenti assunti sono alla base della veri�ca degli elementi per azioni taglianti:

� la resistenza è calcolata tenendo conto delle risorse plastiche della sezione
in accordo con quanto prescritto al paragrafo 6.2.6(2) dell'EC3

� ai �ni della veri�ca di instabilità si suppone che gli irrigidimenti trasversali
siano presenti solo alle estremità dell'elemento e costituiscano un vincolo
non rigido. Non viene considerata la presenza di irrigidimenti intermedi

� il contributo delle �ange è conservativamente ignorato nel calcolo della
resistenza all'instabilità

I seguenti assunti sono alla base della veri�ca degli elementi per azioni combinate
di �essione e sforzo assiale:

� per le sezioni non conformi a quelle decritte al punto 6.2.9 dell'EC3, l'intera-
zione di �essione e sforzo assiale è calcolata secondo la relazione conservativa
presente al paragrafo 6.2.1(7) dell'EC3
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7.3.2 Limitazioni

Le seguenti limitazioni sono alla base del procedimento di progetto generale:

� sezioni aventi parti di spessore inferiore a 3 mm non vengono veri�cate
(EC3 1.1.2(1)). Le regole di progetto speci�che per sezioni formate a freddo
presenti nella norma EN 1993-1-3 non sono implementate nella procedura
di calcolo

� la tensione di snervamento del materiale è indipendente dallo spessore del-
l'elemento. Per tener conto di tale variazione occorre de�nire materiali
di�erenti con il relativo valore di resistenza

� gli e�etti della torsione non sono inclusi nel processo di veri�ca

� le prescrizioni speciali per acciai di grado superiore ad S460 (EN 19931-12)
non sono implementate nella procedura di calcolo

� le prescrizioni paricolari presenti nella norma EN 1993-1-6 per sezioni cir-
colari cave non sono implementate nella procedura di calcolo

Le seguenti limitazioni sono presenti nella veri�ca degli elementi per azioni assiali:

� l'area netta del pro�lo non è determinata in modo automatico. Tale valo-
re può essere speci�cato per ogni elemento della struttura sotto forma di
rapporto fra l'area netta e l'area lorda, attraverso una sovrascrittura

Le seguenti limitazioni sono presenti nella veri�ca degli elementi per azioni com-
binate:

� la norma consente il calcolo di sezioni aventi anima di classe 3 e ali di
classe 2 come sezioni di classe 2 aventi un'area e�cace dell'anima calcolata
in accordo col punto 6.2.2.4 dell'EC3. Il programma conservativamente
ignora tale prescrizione veri�cando la sezione come sezione di classe 3

7.4 Parametri generali di progetto

7.4.1 Materiali e coe�cienti di sicurezza

I valori caratteristici di resistenza a snervamento fy e di resistenza ultima
fu impiegati nel calcolo sono quelli nominali inseriti all'interno della �nestra di
de�nizione del materiale. Il programma assume che tali matriali siano conformi
a quanto prescritto nella tabella 3.1 dell'EC3 o, in caso contrario, che la loro
idoneità con i limiti imposti dalla norma sia stata opportunamente veri�cata.
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I coe�cienti parziali di sicurezza per la riduzione della resistenza caratteristica
degli acciai sono assunti, di default, pari a :

γM0 = 1

γM1 = 1

γM2 = 1.25

Tali valori possono essere in qualsiasi momento sovrascritti dall'utente nelle pre-
ferenze di progetto.

7.4.2 Combinazioni di carico di progetto

Le combinazioni di carico di progetto rappresentano le combinazioni delle
azioni per le quali la struttura deve essere veri�cata. SAP2000 è in grado di
generare in automatico una serie di combinazioni di progetto per gli stati limite
ultimi e per gli stati limite di esercizio sulla base delle indicazioni contenute
nell'Eurocodice 0. L'Eurocodice 0-2002 prevede che le combinazioni statiche di
progetto agli stati limite ultimi possano essere de�nite sulla base delle equazioni
6.10, 6.10a e 6.10b dell'EC0; mentre le combinazioni di carico comprendenti azioni
sismiche sono generate con riferimento all'equazione 6.12b dell'EC0:

∑
j≥1

γG,jGk,j + γPP + γQ,1Qk,1 +
∑
i>1

γQ,iψ0,iQk,i (EC0 Eq. 6.10)

∑
j≥1

γG,jGk,j + γPP + γQ,1ψ0,1Qk,1 +
∑
i>1

γQ,iψ0,iQk,i (EC0 Eq. 6.10a)

∑
j≥1

ξjγG,jGk,j + γPP + γQ,1Qk,1 +
∑
i>1

γQ,iψ0,iQk,i (EC0 Eq. 6.10b)

∑
j≥1

Gk,j + P +AEd +
∑
i≥1

ψ2,iQk,i (EC0 Eq. 6.12b)

Per esempio, se una struttura risultasse soggetta all'azione di un carico per-
manente (D), un carico variabile (L), un carico da vento (V) ed un carico sismico
(E) le combinazioni generate sarebbero le seguenti:
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� Combinazioni statiche nel caso si speci�chi l'utilizzo dell'equazione 6.10:

γG,supD

γGsupD + γQL

γG,sup ± γQW
γG,inf ± γQW

γG,sup + γQL± γQψ0,WW

γG,sup + γQψ0,LL± γQW

� Combinazioni statiche nel caso si speci�chi l'utilizzo delle equazioni 6.10a,b:

γG,supD

ξγG,supD

γGsupD + γQψ0,LL

ξγGsupD + γQL

γG,sup ± γQψ0,WW

γG,inf ± γQψ0,WW

ξγG,sup ± γQW
γG,inf ± γQW

γG,sup + γQψ0,LL± γQψ0,WW

ξγG,inf + γQL± γQψ0,WW

ξγG,inf + γQψ0,LL± γQW

� Combinazioni sismiche:

D ± E
D + ψ2,LL± E
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Per i coe�cienti parziali delle azioni e i coe�cienti di combinazione vengono
utilizzati i seguenti valori:

γG,sup = 1.35

γG,inf = 1.00

γQ = 1.5

ψ0,L = 0.7 (carico variabile, non deposito)

ψ0,W = 0.3

ξ = 0.85

ψ2,L = 0.3 (carico variabile per u�ci o residenze)

Per quanto riguarda gli stati limite di esercizio le combinazioni generate in
automatico sono basate sulla codizione caratteristica:

D (EC0 Eq. 6.10a)

D + L (EC0 Eq. 6.10a)

7.5 Classi�cazione delle sezioni

L'Eurocodice 3-2005 classi�ca le sezioni in 4 classi distinte, che identi�ca-
no quanto i fenomeni di instabilità locale condizionino le capacità resistenti e
rotazionali della sezione. Le varie classi all'interno di SAP2000 sono de�nite
come:

� classe 1: la sezione è in grado di garantire lo sviluppo di una cerniera
plastica con adeguata capacità rotazionale per l'analisi plastica

� classe 2: la sezione è in grado di garantire lo sviluppo di una cerniera
plastica, ma la sua capacità rotazionale risulta limitata

� classe 3: la sezione è in grado di garantire il raggiungimento della tensione di
snervamento nella �bra esterna maggiormante compressa, ma i fenomeni di
instabilità locale ne pregiudicano la capacità di sviluppare risorse plastiche

� classe 4: la sezione è soggetta a fenomeni di instabilità locale prima che la
tensione di compressione raggiunga il valore di snervamento in una o più
parti della sezione

� troppo snella: la sezione non soddisfa i requisiti di appartenenza alle classi
1, 2, 3 o 4. Ciò accade quando lo spessore di una o più delle sue parti è
inferiore a 3 mm
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L'appartenenza alle varie classi è stabilita in funzione del valore dei rapporti lar-
ghezza spessore delle parti compresse della sezione. Le seguenti tabelle illustrano
le procedure di classi�cazione impiegate in funzione del tipo di sezione e della
sollecitazione agente. I vari parametri impiegati nel calcolo sono de�niti come:

ε =
√

235/fy (EC3 Tab. 5.2)

ψ = −
(

1 + 2
NEd
Afy

)
(EC3 Tab. 5.2)

per sezioni ad I e C:

α =
1

c

[
h

2
− 1

2

NEd
twfy

− (tf − r)
]

(EC3 Tab. 5.2)

per sezioni scatolari e sezioni a doppia C:

α =
1

c

[
h

2
− 1

4

NEd
twfy

− (tf − r)
]

(EC3 Tab. 5.2)

Forma Parte Rapporto Classe 1 Classe 2 Classe 3

I, C Anima c/t 33ε 38ε 42ε

Flangia c/t 9ε 10ε 14ε

T
Anima,
Flangia

c/t 9ε 10ε 14ε

Angolari,
Angolari
doppi

Lato
h/t e

(b+ h)/2t
N/A N/A 15ε e 11.5ε

Scatolare
Anima,
Flangia

c/t 33ε 38ε 42ε

Tubolare Parete d/t 50ε2 70ε2 90ε2

Barre N/A Assunte in classe 2

Generica,
Section
Designer

N/A Assunte in classe 3

Tabella 7.2: rapporti larghezza spessore per elementi compressi
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Forma Parte Rapporto Classe 1 Classe 2 Classe 3

I, C Anima c/t
396ε

(13α− 1)

456ε

(13α− 1)

42ε

(0.67 + 0.33ψ)

se α > 0.5 se α > 0.5 se ψ > −1

36ε

α

41.5ε

α
62ε(1− ψ)

√
−ψ

se α ≤ 0.5 se α ≤ 0.5 se ψ ≤ −1

Flangia c/t
estremità
compressa:

estremità
compressa:

21ε
√
kσ

9ε/α 10ε/α

estremità
tesa:

estremità
tesa:

9ε

α
√
α

10ε

α
√
α

T Anima c/t
estremità
compressa:

estremità
compressa:

21ε
√
kσ

9ε/α 10ε/α

estremità
tesa:

estremità
tesa:

9ε

α
√
α

10ε

α
√
α

Flangia c/t 9ε 10ε 14ε

Scatolare
Anima,
Flangia

c/t
396ε

(13α− 1)

456ε

(13α− 1)

42ε

(0.67 + 0.33ψ)

se α > 0.5 se α > 0.5 se ψ > −1

36ε

α

41.5ε

α
62ε(1− ψ)

√
−ψ

se α ≤ 0.5 se α ≤ 0.5 se ψ ≤ −1

Tubolare Parete d/t 50ε2 70ε2 90ε2

Barre N/A Assunte in classe 2

Generica,
Section
Designer

N/A Assunte in classe 3

Tabella 7.3: rapporti larghezza spessore per elementi presso-in�essi
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Forma Parte Rapporto Classe 1 Classe 2 Classe 3

I, C Anima c/t 72ε 83ε 124ε

T Anima c/t
estremità
compressa:

estremità
compressa:

21ε
√
kσ

9ε/α 10ε/α

estremità
tesa:

estremità
tesa:

9ε

α
√
α

10ε

α
√
α

Flangia c/t 9ε 10ε 14ε

Scatolare
Anima,
Flangia

c/t 72ε 83ε 124ε

Tubolare Parete d/t 50ε2 70ε2 90ε2

Barre N/A Assunte in classe 2

Generica,
Section
Designer

N/A Assunte in classe 3

Tabella 7.4: rapporti larghezza spessore per elementi inlfessi

7.6 Progetto per azioni assiali

Nei seguenti paragra� viene riportata la procedura di progetto dettagliata per
il calcolo di elementi asta in acciaio soggetti ad azioni assiali secondo l'Eurocodice
3-2005.

7.6.1 Area di calcolo

L'area utilizzata nel calcolo della resistenza per azioni assiali, A, è basata sulle
dimensioni lorde della sezione e non tiene conto di eventuali riduzioni di sezione
per e�etto di fori o aperture. L'area netta, Anet, assunta di default pari ad A,
può essere speci�cata per i singoli elementi attraverso l'opportuna sovrascrittura
raggiungibile dal menu Design > Steel Frame Design > View Revise Overwrites.

7.6.2 Veri�ca di resistenza a trazione

La veri�ca a trazione prevede che, in tutte le sottostazioni dell'elemento, sia
veri�cata la relazione:

NEd
Nt,Rd

≤ 1 (EC3 6.2.3(1))
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Parte II Veri�ca elementi in acciaio

in cui la resistenza a trazione è assunta pari al minore fra:

� la resistenza plastica della sezione lorda Npl,Rd

Npl,Rd =
Afy
γM0

(EC3 6.2.3(a))

� la resistenza ultima della sezione netta Nu,Rd

Nu,Rd =
0.9Anetfu
γM2

(EC3 6.2.3(b))

7.6.3 Veri�ca di resistenza a compressione

La veri�ca a compressione prevede che, in tutte le sottostazioni dell'elemento,
sia veri�cata la relazione:

NEd
Nc,Rd

≤ 1 (EC3 6.2.4(1))

in cui la resistenza a compressione Nc,Rd è assunta pari a:

� per sezioni di classe 1,2,3

Nc,Rd =
Afy
γM0

(EC3 6.2.4(2))

� per sezioni di classe 4

Nc,Rd =
Aefffy
γM0

(EC3 6.2.4(2))

Aeff rappresenta il valore dell'area e�cace dell'elemento di classe 4 quando sog-
getto a compressione uniforme. Il valore di Aeff è determinato sulla base delle
indicazioni contenute nella norma EN 1993-1-5 paragrafo 4.4(2), tabelle 4.1 e 4.2.

7.6.4 Veri�ca ad instabilità

La veri�ca ad instabilità prevede che, in tutte le sottostazioni dell'elemento,
sia veri�cata la relazione:

NEd
Nb,Rd

≤ 1 (EC3 6.3.1.1(1))

in cui la resistenza ad instabilità per compressione Nb,Rd è assunta pari a:
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� per sezioni di classe 1,2,3

Nc,Rd =
χAfy
γM1

(EC3 6.3.1.1(3))

� per sezioni di classe 4

Nc,Rd =
χAefffy
γM1

(EC3 6.3.1.1(3))

χ rappresenta il fattore di riduzione della resistenza per il modo di instabilità
considerato ed è calcolato come:

χ =
1

φ+
√
φ2 − λ̄2

≤ 1 (EC3 6.3.1.2(1))

Il fattore coe�ciente φ e la snellezza adimensionale λ̄ sono determinati attraverso
le relazioni:

φ = 0.5
[
1 + α

(
λ̄− 0.2

)
+ λ̄2

]
(EC3 6.3.1.2(1))

λ̄ =

√
Afy
Ncr

per sezioni di classe 1,2 e 3 (EC3 6.3.1.3(1))

λ̄ =

√
Aefffy
Ncr

per sezioni di classe 4 (EC3 6.3.1.3(1))

Il fattore di imperfezione α è calcolato sulla base delle curve riportate in EC3
tab. 6.1. Lo sforzo normale critico Ncr è basato sulle proprietà lorde della sezione
trasversale ed è assunto pari a:

Ncr =
π2EI

L2
cr

=
π2EAi2

L2
cr

in cui:

E modulo elastico dell'acciaio

I momento d'inerzia della sezione nella direzione in esame

Lcr lunghezza libera di in�essione nella direzione considerata e
clalcolata come visto al paragrafo 5.8

i raggio d'inerzia della sezione nella direzione in esame
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Parte II Veri�ca elementi in acciaio

Nel calcolo vengono considerati i modi di instabilità �essionali lungo le dire-
zioni principali (EC3 6.3.1.3), assumendo le relative caratteristiche inerziali iy ed
iz. Fanno eccezione gli angolari singoli per i quali, per tener conto del contributo
�essio torsionale nello sbandamento lungo l'asse forte, lo sforzo normale critico
viene calcolato utilizzando sempre il minimo raggio di inerzia iz della sezione.
La veri�ca a instabilità può essere ignorata qualora risulti:

λ̄ ≤ 0.2 (EC3 6.3.1.2(4))

oppure quando:

NEd
Ncr

≤ 0.02 (EC3 6.3.1.2(4))

In aggiunta, in accordo al paragrafo 6.3.1.4 dell'EC3, vengono considerati i mo-
di di intabilità torsionali e quelli �esso-torsionali. In particolare, per sezioni
doppiamente simmetriche si ha:

Ncr,T =
1

i2s

(
GIT +

π2EIω
l2T

)
Ncr,TF = Ncr,T

per sezioni a singola simmetria, simmetriche rispetto all'asse y si ha:

Ncr,TF =
i2s

2
(
i2y + i2z

)
Ncr,y +Ncr,T −

√
(Ncr,y +Ncr,T )

2 − 4Ncr,yNcr,T
i2y + i2z
i2s


viceversa se la simmetria è attorno all'asse z si ha:

Ncr,TF =
i2s

2
(
i2y + i2z

)
Ncr,z +Ncr,T −

√
(Ncr,z +Ncr,T )

2 − 4Ncr,zNcr,T
i2y + i2z
i2s


in cui:

Ncr,T sforzo normale corrispondente al modo di instabilità
puramente torsionale (ha signi�cato �sico solo per
sezioni doppiamente simmetriche)

Ncr,TF sforzo normale corrispondente al modo di instabilità
�esso torsionale attorno all'asse di simmetria della
sezione (ha signi�cato �sico solo per sezioni a singola
simmetria, per sezioni a doppia simmetria Ncr,TF =
Ncr,T )
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IT fattore torsionale di rigidezza della sezione

Iω costante di ingobbamento della sezione

i2s raggio di inerzia polare della sezione rispetto al
centro di taglio i2s = i2y + i2z + y2s + z2s

iy, iz raggi di inerzia della sezione rispetto alle direzioni
principali

ys, zs coordinate del centro di taglio della sezione nel
sistema principale baricentrico

Determinati Ncr,T e Ncr,TF viene calcolata la snellezza adimensionale per
instabilità torsionale o �esso torsionale nel seguente modo:

λ̄T = max

(√
Afy
Ncr,T

;

√
Afy
Ncr,TF

)
sez. di cl. 1,2 e 3 (EC3 Eq. 6.52)

λ̄T = max

(√
Aefffy
NcrT

;

√
Aefffy
NcrTF

)
sez. di cl. 4 (EC3 Eq. 6.53)

Il corrispondente coe�ciente di riduzione della resistenza, χ, viene determinato
sulla base di tale snellezza utilizzando le medesime relazioni viste per le instabilità
piane assumendo come curva di instabilità quella relativa all'asse z. Il valore di
Nb,Rd è assunto pari al minore fra tutti quelli calcolati.

È importante sottolineare che gli approcci appena presentati rappresentano
nel modo più completo le veri�che di instabilità per elementi compressi aventi
sezione con almeno un asse di simmetria. Per sezioni asimmetriche tutti i modi
di instabilità per compressione semplice sono di tipo �esso-torsionale e vanno
determinati in maniera indipendente dall'utente risolvendo l'equazione:

i2s (N −Ncr,y) (N −Ncr,z) (N −Ncr,T )−N2y2s (N −Ncr,z)−N2z2s (N −Ncr,y) = 0

7.7 Progetto per azioni �ettenti

Nei seguenti paragra� viene riportata la procedura di progetto dettagliata
per il calcolo di elementi asta in acciaio soggetti ad azioni �ettenti secondo
l'Eurocodice 3-2005.
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Parte II Veri�ca elementi in acciaio

7.7.1 Veri�ca di resistenza a �essione

La veri�ca a �essione prevede che, in tutte le sottostazioni dell'elemento, sia
veri�cata la relazione:

MEd

Mc,Rd
≤ 1 (EC3 6.2.5(1))

in cui la resistenza a �essione Mc,Rd è assunta pari a:

� per sezioni di classe 1 e 2

Mc,Rd = Mpl,Rd =
Wplfy
γM0

(EC3 6.2.5(2))

� per sezioni di classe 3

Mc,Rd = Mel,Rd =
Wel,minfy
γM0

(EC3 6.2.5(2))

� per sezioni di classe 4

Mc,Rd =
Weff,minfy

γM0
(EC3 6.2.5(2))

Wpl, Wel,min e Weff,min rappresentano:

Wpl modulo di resistenza plastico della sezione

Wel,min minimo modulo di resistenza elastico della sezione per
la direzione in esame

Weff,min minimo modulo di resistenza della sezione e�cace per
la direzione in esame

Il valore di Weff,min è determinato sulla base delle indicazioni contenute nella
norma EN 1993-1-5 paragrafo 4.4(2), tabelle 4.1 e 4.2.

L'interazione di elevati sforzi di taglio con la resistenza a �essione è conside-
rata qualora risulti:

VEd ≥ 0.5Vpl,Rd (EC3 6.2.8(2))

Per tener conto di tale interazione sulla resistenza a momento forte di sezioni ad
I, C, T, C accoppiati, doppi angolari e sezioni scatolari rettangolari, il momento
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resistente viene calcolato come:

My,V,Rd =

[
Wpl,y −

nρA2
w

4tw

]
fy

γM0
≤My,c,rd (EC3 6.2.8(5))

in cui:

n =


1 per sezioni a I, C e T

2 per sezioni a C accoppiati, doppi angolari

e sezioni scatolari rettangolari

(EC3 6.2.8(5))

ρ =

(
2Vz,Ed
Vz,pl,Rd

− 1

)2

(EC3 6.2.8(3))

Aw = hwtw (EC3 6.2.8(5))

Per tutte le altre sezioni, comprese le sezioni tubolari, rettangolari piene, circolari
e angolari singoli, la resistenza a �essione forte ridotta è calcolata come:

My,V,Rd = (1− ρ)My,c,rd (EC3 6.2.8(3))

Similarmente, l'interazione fra taglio e resistenza a momento lungo l'asse de-
bole, per sezioni ad I, C, T, C accoppiati, doppi angolari e sezioni scatolari
rettangolari, è tenuta in conto attraverso la relazione:

Mz,V,Rd =

[
Wpl,z −

nρA2
f

4tf

]
fy

γM0
≤Mz,c,rd (EC3 6.2.8(5))

in cui:

n =


1 per sezioni a T

2 per sezioni a I, C, doppi angolari

e sezioni scatolari rettangolari

4 per sezioni a C accoppiati

(EC3 6.2.8(5))

ρ =

(
2Vy,Ed
Vy,pl,Rd

− 1

)2

(EC3 6.2.8(3))

Af = bf tf (EC3 6.2.8(5))

Per tutte le altre sezioni, la resistenza a �essione debole ridotta è calcolata come:

Mz,V,Rd = (1− ρ)Mz,c,rd (EC3 6.2.8(3))
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Parte II Veri�ca elementi in acciaio

7.7.2 Veri�ca ad instabilità laterale

La veri�ca ad instabilità laterale prevede che, in tutte le sottostazioni dell'e-
lemento, sia veri�cata la relazione:

MEd

Mb,Rd
≤ 1 (EC3 6.3.2.1(1))

in cui la resistenza ad instabilità laterale Mb,Rd è assunta pari a:

Mb,Rd = χLTWy
fy
γM1

(EC3 6.3.2.1(3))

con Wy pari a:

Wy = Wpl,y per sezioni di classe 1, 2

Wy = Wel,y per sezioni di classe 3

Wy = Weff,y per sezioni di classe 4

Il fattore di riduzione della resistenza per instabilità laterale, χLT , è calcolato
come segue:

χLT =
1

φLT +
√
φ2LT − λ̄2LT

≤ 1 (EC3 6.3.2.2(1))

nelle quali il coe�ciente φLT e la snellezza adimensionale λ̄LT sono determinati
attraverso le relazioni:

φLT = 0.5
[
1 + αLT

(
λ̄LT − 0.2

)
+ λ̄2LT

]
(EC3 6.3.2.2(1))

λ̄LT =

√
Wyfy
Mcr

(EC3 6.3.2.2(1))

Il fattore di imperfezione αLT è determinato sulla base delle tabelle 6.3 e 6.4
dell'EC3, Wy ha il signi�cato visto in precedenza mentre Mcr rappresenta il
momento crititco elastico della sezione lorda, calcolato come:

Mcr = C1
π2EIz
L2
cr

(
Iω
Iz

+
L2
crGIT
π2EIz

)0.5

(EC3-1993 F1.1)

con:

Iz momento d'inerzia minore della sezione

Iω costante di ingobbamento

IT fattore torsionale di rigidezza della sezione

Lcr lunghezza libera per instabilità laterale

ψ =
M01

M02
rapporto fra i momenti �ettenti di estremità dell'elemento

con |M01| ≤ |M02|
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C1 = 1.88− 1.40ψ + 0.52ψ2 ≤ 2.7 (EC3-1993 F1.1(6))

Il valore di C1 è automaticamente assunto pari ad 1 qualora la lunghezza libera
per instabilità laterale venga sovrascritta. In ogni caso il valore di C1 può essere
sovrascritto elemento per elemento.

7.8 Progetto per azioni taglianti

Nei seguenti paragra� viene riportata la procedura di progetto dettagliata
per il calcolo di elementi asta in acciaio soggetti ad azioni taglianti secondo
l'Eurocodice 3-2005.

7.8.1 Area a taglio

L'area a taglio, Av, per le varie tipologie di sezione è calcolata sulla base delle
prescrizioni fornite al paragrafo 6.2.6(3) dell'EC3.

7.8.2 Veri�ca di resistenza a taglio

La veri�ca a taglio prevede che, in tutte le sottostazioni dell'elemento, sia
veri�cata la relazione:

VEd
Vc,Rd

≤ 1 (EC3 6.2.6(1))

in cui la resistenza a �essione Vc,Rd è assunta pari a:

Vc,Rd = Vpl,Rd =
Avfy√
3γM0

(EC3 6.2.6(2))

7.8.3 Veri�ca ad instabilità a taglio

La veri�ca di instabilità a taglio è condotta per le anime delle sezioni a I, C,
C accoppiati, T, angolari doppi e pro�li scatolari per le quali risulti:

hw
tw

> 72
ε

η
(EC3 6.2.6(6))

con

ε =

√
235

fy
con fy in N/mm2

η =

{
1.2 per fy ≤ 460N/mm2

1 altrimenti
vedi EC3-1-5 5.1(2)
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La resistenza a taglio per instabilità è data dalla relazione:

Vb,Rd = Vbw,Rd + Vbf,Rd (EC3-1-5 5.2(1))

in cui Vbw,Rd è il contributo dovuto all'anima, assunto pari a:

Vbw,Rd =
χwfywhwt√

3γM1

(EC3-1-5 5.2(1))

Come anticipato al paragrafo 7.3 ai �ni della veri�ca di instabilità si suppone
che gli irrigidimenti trasversali siano presenti solo alle estremità dell'elemento e
costituiscano un vincolo non rigido. Pertanto il paramtero di snellezza λ̄w ed il
fattore di taglio χw possono essere assunti pari a:

λ̄w =
hw

86.4tε
(EC3-1-5 5.3(3))

χw =

η se λ̄w < 0.83/η

0.83/η se λ̄w ≥ 0.83/η
(EC3-1-5 tab. 5.1)

Il contributo delle �ange, Vbf,Rd, è conservativamente ignorato.

7.9 Progetto per azioni composte

Nei seguenti paragra� viene riportata la procedura di progetto dettagliata
per il calcolo di elementi asta in acciaio soggetti ad azioni composte secondo
l'Eurocodice 3-2005.

7.9.1 Veri�che di resistenza per l'azione composta di �es-
sione, taglio e sforzo assiale

7.9.1.1 Sezioni di classe 1 e 2

Per sezioni di classe 1 e 2 soggette all'azione combinata di �essione taglio e
sforzo assiale le veri�che di resistenza sono così condotte:

� Sezioni a I:[
My,Ed

MN,y,Rd

]α
+

[
Mz,Ed

MN,z,Rd

]β
≤ 1 (EC3 6.2.9.1(6))

con

α = 2 (EC3 6.2.9.1(6))

β = 5n ≥ 1 (EC3 6.2.9.1(6))
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n =
NEd
Npl,Rd

(EC3 6.2.9.1(6))

MN,y,Rd = Mpl,y,Rd

(
1− n

1− 0.5a

)
(EC3 6.2.9.1(5))

MN,z,Rd =


Mpl,z,Rd per n ≤ a

Mpl,z,Rd

(
n− a
1− a

)2

per n > a
(EC3 6.2.9.1(5))

Qualora risultasse:

NEd ≤ 0.25Npl,Rd e NEd ≤ 0.5
hwtwfy
γ0

(EC3 6.2.9.1(4))

si può porre MN,y,Rd = Mpl,y,Rd.
Similarmente se:

NEd ≤
hwtwfy
γ0

(EC3 6.2.9.1(4))

si può porre MN,z,Rd = Mpl,z,Rd.
Inoltre qualora l'azione tagliante in una data direzione risultasse signi�-
cativa, VEd > 0.5Vpl,Rd, nelle precedenti, al posto delle resistenze Mpl,Rd

occorre utilizzare le resistenze ridotte MV,Rd come calcolate al paragrafo
7.7.1.

� Sezioni scatolari rettangolari:[
My,Ed

MN,y,Rd

]α
+

[
Mz,Ed

MN,z,Rd

]β
≤ 1 (EC3 6.2.9.1(6))

con

α = β =
1.66

1− 1.13n2
≤ 6 (EC3 6.2.9.1(6))

n =
NEd
Npl,Rd

(EC3 6.2.9.1(6))

MN,y,Rd = Mpl,y,Rd

(
1− n

1− 0.5aw

)
(EC3 6.2.9.1(5))

MN,z,Rd = Mpl,z,Rd

(
1− n

1− 0.5af

)
(EC3 6.2.9.1(5))

aw =
A− 2btf

A
(EC3 6.2.9.1(5))
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af =
A− 2htw

A
(EC3 6.2.9.1(5))

Qualora l'azione tagliante in una data direzione risultasse signi�cativa,
VEd > 0.5Vpl,Rd, nelle precedenti, al posto delle resistenze Mpl,Rd occorre
utilizzare le resistenze ridotte MV,Rd come calcolate al paragrafo 7.7.1.

� Sezioni a T, C, C accoppiati, Rettangolari piene, Angolari, Angolari doppi,
sezioni generiche e sezioni de�nite con Section Designer:

NEd
NRd

+
My,Ed

My,Rd
+
Mz,Ed

Mz,Rd
≤ 1 (EC3 6.2.1(7))

La resistenza assiale NRd è assunta pari a Nt,Rd oppure Nc,Rd a secon-
da che lo sforzo assiale sollecitante sia di trazione o compressione. I mo-
menti resistenti sono valutati come visto al paragrafo 7.7.1 tenendo conto
dell'eventuale in�uenza dell'azione tagliante.

� Sezioni circolari piene o cave:

NEd
NRd

+

√(
My,Ed

My,Rd

)2

+

(
Mz,Ed

Mz,Rd

)2

≤ 1 (EC3 6.2.1(7))

La resistenza assiale NRd è assunta pari a Nt,Rd oppure Nc,Rd a secon-
da che lo sforzo assiale sollecitante sia di trazione o compressione. I mo-
menti resistenti sono valutati come visto al paragrafo 7.7.1 tenendo conto
dell'eventuale in�uenza dell'azione tagliante.

7.9.1.2 Sezioni di classe 3

Per sezioni di classe 3 soggette all'azione combinata di �essione taglio e sforzo
assiale le veri�che di resistenza sono così condotte:

NEd
NRd

+
My,Ed

My,Rd
+
Mz,Ed

Mz,Rd
≤ 1 (EC3 6.2.1(7))

Per sezioni doppiamente simmetriche tale relazione coincide con la formula nor-
mativa che impone:

σx,Ed ≤
fy
γM0

(EC3 6.2.9.2(1))

Un'eccezione è prevista per le sezioni circolari cave per le quali viene utilizzata
la relazione:

NEd
NRd

+

√(
My,Ed

My,Rd

)2

+

(
Mz,Ed

Mz,Rd

)2

≤ 1 (EC3 6.2.1(7))

Nelle precedenti espressioni, i valori delle resistenze assiali e �ettenti, vengono
calcolati come riportato ai relativi paragra� per sezioni di classe 3.
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7.9.1.3 Sezioni di classe 4

Per sezioni di classe 4 soggette all'azione combinata di �essione taglio e sforzo
assiale le veri�che di resistenza sono condotte utilizzando le medesime relazioni
viste per le sezioni di classe 3 e considerando, in aggiunta, la seguente condizione:

NEd
Aefffy
γM0

+
My,Ed +NEdeNy
Weff,y,minfy

γM0

+
Mz,Ed +NEdeNz
Weff,z,minfy

γM0

≤ 1 (EC3 6.2.9.3(2))

in cui:

Aeff rappresenta l'area e�cace della sezione uniforme-
mente compressa

Weff,min rappresenta il modulo di resistenza e�cace della
sezione soggetta a �essione semplice

eN rappresenta lo spostamento del baricentro della se-
zione quando soggetta a compressione uniforme.
Qualora lo sforzo sollecitanete fosse di trazione si
considera NEd = 0 e eN = 0

Un'eccezione è prevista per le sezioni circolari piene o cave per le quali viene
utilizzata la relazione:

NEd
Aefffy
γM0

+

√√√√√√√
My,Ed +NEdeNy

Weff,y,minfy
γM0


2

+

Mz,Ed +NEdeNz
Weff,z,minfy

γM0


2

≤ 1

7.9.2 Veri�che di instabilità per l'azione composta di �es-
sione e sforzo assiale

La veri�ca di instabilità per e�etto combinato di �essione e sforzo assiale è
condotta in accordo col paragrafo 6.3.3(4) dell'EC3. Il programma e�ettua il
calcolo sotto l'ipotesi di elemento prismatico. Qualora l'elemento risultasse non
prismatico le formule impiegate nel calcolo risultano le stesse e le proprietà della
sezione vengono ricavate sulla base dell'output station in esame. In quest'ultimo
caso l'utente deve valutare personalmente l'applicabilità di tale sempli�cazione.

7.9.2.1 Sezioni di classe 1, 2 e 3

Per sezioni di classe 1, 2 e 3 soggette all'azione combinata di �essione e
sforzo assiale le veri�che di instabilità sono condotte veri�cando che le seguenti

139



Parte II Veri�ca elementi in acciaio

disuguaglianze risultino soddisfatte:

NEd
χyNRk
γM1

+ kyy
My,Ed

χLTMy,Rk

γM1

+ kyz
Mz,Ed

Mz,Rk

γM1

≤ 1

NEd
χzNRk
γM1

+ kzy
My,Ed

χLTMy,Rk

γM1

+ kzz
Mz,Ed

Mz,Rk

γM1

≤ 1

(EC3 6.3.3(4))

I valori caratteristici delle resistenze, NRk, My,Rk e Mz,Rk, sono calcolati come
visto ai paragra� 7.6.3 e 7.7.1 senza tener conto del coe�ciente γM0. I fattori di
riduzione della resistenza per e�etto dell'intabilità, χy, χz e χLT , sono calcolati
con riferimento ai paragra� 7.6.4 e 7.7.2 mentre i coe�cienti di interazione kyy,
kzz, kyz e kzy, sono calcolati in funzione del metodo speci�cato fra le preferenze
di veri�ca. In particolare è possibile scegliere fra l'approccio presente nell'allegato
A dell'EC3 (Metodo 1) oppure nell'allegato B dell'EC3 (Metodo 2).

Analogamente a quanto visto per le resistenze, la veri�ca di instabilità per se-
zioni circolari piene o cave, viene condotta sommando linearmente la componente
assiale con la SRSS dei termini �ettenti:

NEd
χyNRk
γM1

+

√√√√√√√
kyy My,Ed

χLTMy,Rk

γM1


2

+

kyz Mz,Ed

Mz,Rk

γM1


2

≤ 1

NEd
χzNRk
γM1

+

√√√√√√√
kzy My,Ed

χLTMy,Rk

γM1


2

+

kzz Mz,Ed

Mz,Rk

γM1


2

≤ 1

Le relazioni appena viste sono valide nel caso di sforzo assiale di compressione.
La veri�ca di instabilità per elementi soggetti a trazione e �essione viene condotta
con le medesime formule ponendo il termine assiale pari a zero.

7.9.2.2 Sezioni di classe 4

Per sezioni di classe 4 soggette all'azione combinata di �essione e sforzo assiale
le veri�che di instabilità sono condotte veri�cando che le seguenti disuguaglianze
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risultino soddisfatte:

NEd
χyNRk
γM1

+ kyy
My,Ed +NEdeNy

χLTMy,Rk

γM1

+ kyz
Mz,Ed +NEdeNz

Mz,Rk

γM1

≤ 1

NEd
χzNRk
γM1

+ kzy
My,Ed +NEdeNy

χLTMy,Rk

γM1

+ kzz
Mz,Ed +NEdeNz

Mz,Rk

γM1

≤ 1

(EC3 6.3.3(4))

I valori caratteristici delle resistenze, NRk, My,Rk e Mz,Rk, sono calcolati come
visto ai paragra� 7.6.3 e 7.7.1 per sezioni di classe 4 senza tener conto del coe�-
ciente γM0. I termini eNy e eNz hanno il signi�cato visto al paragrafo 7.9.2.2. I
fattori di riduzione della resistenza per e�etto dell'intabilità, χy, χz e χLT , sono
calcolati con riferimento ai paragra� 7.6.4 e 7.7.2 mentre i coe�cienti di intera-
zione kyy, kzz, kyz e kzy, sono calcolati in funzione del metodo speci�cato fra le
preferenze di veri�ca. In particolare è possibile scegliere fra l'approccio presente
nell'allegato A dell'EC3 (Metodo 1) oppure nell'allegato B dell'EC3 (Metodo 2).

Analogamente a quanto visto in precedenza, la veri�ca di instabilità per se-
zioni circolari piene o cave, viene condotta sommando linearmente la componente
assiale con la SRSS dei termini �ettenti.

Le relazioni appena viste sono valide nel caso di sforzo assiale di compressione.
La veri�ca di instabilità per elementi soggetti a trazione e �essione viene condotta
con le medesime formule ponendo il termine assiale pari a zero.

7.10 Prescrizioni sismiche

I seguenti paragra� forniranno una descrizione dettagliata delle procedure
di calcolo implementate con riferimento alla norma �EN 1998-1:2004-Eurocodice
8: Progettazione delle strutture per la resistenza sismica�. Una volta impostato
l'Eurocodice 3-2004 come codice di veri�ca, tutte le seguenti prescrizioni vengono
automaticamente controllate per tutte le combinazioni di progetto contenenti
carichi sismici.

7.10.1 Tipologie strutturali

All'interno delle preferenze di progetto è possibile scegliere fra le tipologie
strutturali riportate in tabella 7.9.

Tabella 7.9: elenco delle tipologie strutturali riconosciute

141



Parte II Veri�ca elementi in acciaio

Tipologia strutturale Id. Rif.

Struttura a telaio in cl. di duttilità alta (DCH-MRF) EC8 6.6

Struttura a telaio in cl. di duttilità media (DCH-MRF) EC8 6.6

Struttura a telaio in cl. di duttilità bassa (DCL-MRF) EC8 6.6

Struttura a controventi concentrici in classe di
duttilità alta

(DCH-CBF) EC8 6.7

Struttura a controventi concentrici in classe di
duttilità media

(DCM-CBF) EC8 6.7

Struttura a controventi concentrici in classe di
duttilità bassa

(DCL-CBF) EC8 6.7

Struttura a controventi ecconcentrici in classe di
duttilità alta

(ECH-CBF) EC8 6.8

Struttura a controventi ecconcentrici in classe di
duttilità media

(ECM-CBF) EC8 6.8

Struttura a controventi ecconcentrici in classe di
duttilità bassa

(ECL-CBF) EC8 6.8

Struttura a pendolo inverso EC8 6.9

Secondaria EC8 4.2.2

Tali tipologie strutturali possono essere assegnate, sotto forma di sovrascrit-
ture, in maniera indipendente per tutti i diversi elementi della struttura. In tal
modo sarà possibile escludere determinati elementi dalla veri�ca delle prescrizioni
sismiche relative oppure e�ettuare le veri�che per strutture con sistema resistente
misto.

7.10.2 Strutture a telaio in CDA

Per strutture a telaio in classe di duttilità alta (CDA), per tutte le combina-
zioni sismiche, vengono veri�cate le seguenti condizioni aggiuntive.

7.10.2.1 Travi

� Le sezioni di tutte le travi sismo resistenti devono essere di classe 1 (EC8
6.5.3(2), Tab. 6.3)

� Al �ne di assicurarsi che le capacità resistenti e le capacità rotazionali delle
travi non siano ridotte per e�etto di azioni di compressione o azioni taglianti
deve inoltre risultare (EC8 6.6.2(2)):

MEd

Mpl,Rd
≤ 1 (EC8 Eq. 6.2)
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NEd
Npl,Rd

≤ 0.15 (EC8 Eq. 6.3)

VEd
Vpl,Rd

≤ 0.5 (EC8 Eq. 6.4)

in cui:

VEd = VEd,G + VEd,M (EC8 Eq. 6.5)

NEd è la forza assiale di progetto derivante
dall'analisi

MEd è il momento �ettente di progetto derivante
dall'analisi

VEd è il taglio di progetto

VEd,G è il taglio derivante dall'analisi corrispon-
dente ai soli carichi statici

VEd,M è il taglio derivante dalla formazione del-
le cerniere plastiche alle estremità (A e B)
della trave:
VEd,M = (Mpl,Rd,A +Mpl,Rd,B) /L

Npl,Rd,Mpl,Rd e Vpl,Rd sono le resistenze di progetto in accordo
con le sezioni 6.2.3-6 dell'EC3

7.10.2.2 Colonne

� Le sezioni di tutte le colonne sismo resistenti devono essere di classe 1 (EC8
6.5.3(2), Tab. 6.3)

� Le colonne devono essere veri�cate con riferimento alla più sfavorebole com-
binazione di sforzo assiale e momento �ettente. Nel processo di veri�ca le
azioni sollecitanti sono calcolate come segue (EC8 6.6.3(1)):

NEd = NEd,G + 1.1γovΩNEd,E (EC8 Eq. 6.6)

MEd = MEd,G + 1.1γovΩMEd,E (EC8 Eq. 6.6)

VEd = VEd,G + 1.1γovΩVEd,E (EC8 Eq. 6.6)

in cui:
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Parte II Veri�ca elementi in acciaio

NEd,G,MEd,G e VEd,G sono le sollecitazioni derivanti dal-
l'analisi corrispondenti ai soli carichi
statici

NEd,E ,MEd,E e VEd,E sono le sollecitazioni derivanti dal-
l'analisi corrispondenti ai soli carichi
sismici

Ω = min (Ωi) con Ωi = Mpl,Rd,i/MEd,i rapporto fra il
momento plastico ed il momento di pro-
getto delle travi resistenti al sisma. È
importante sottolineare che il valore di
Ω non viene calcolato in automatico dal
programma ma deve essere speci�cato
manualmente fra le preferenze di pro-
getto oppure assegnato, elemento per
elemento, attraverso le sovrascritture.

� In aggiunta, il taglio sollecitante risultante dall'analisi VEd, deve rispettare
la condizione:

VEd
Vpl,Rd

≤ 0.5 (EC8 Eq. 6.7)

7.10.3 Strutture a telaio in CDM

Le prescrizioni aggiuntive per strutture a telaio in classe di duttilità media
(CDM), sono le stesse viste per le strutture a telaio in CDA, con le seguenti
eccezioni (EC8 6.6).

7.10.3.1 Travi

� Le sezioni di tutte le travi sismo resistenti devono essere di classe 1 o di
classe 2 (EC8 6.5.3(2), Tab. 6.3)

7.10.3.2 Colonne

� Le sezioni di tutte le colonne sismo resistenti devono essere di classe 1 o di
classe 2 (EC8 6.5.3(2), Tab. 6.3)

7.10.4 Strutture a telaio in CDB

Le strutture a telaio in classe di duttilità bassa (CDB) possono essere calcolate
unicamente in accordo all'EC3, senza prescrizioni aggiuntive.
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7.10.5 Strutture a controventi concentrici in CDA

Per strutture a controventi concentrici in classe di duttilità alta (CDA), per
tutte le combinazioni sismiche, vengono veri�cate le seguenti condizioni aggiun-
tive.

7.10.5.1 Controventi

� Le sezioni di tutti i controventi sismo resistenti devono essere di classe 1
(EC8 6.5.3(2), Tab. 6.3)

� La snellezza adimensionale, λ̄, dei controventi a X deve rispettare le seguenti
limitazioni:

1.3 ≤ λ̄ ≤ 2 (EC8 6.7.3(1))

in cui:

λ̄ =

√
Afy
Ncr

è la snellezza adimensionale

Ncr = Ncr,TF ≤ Ncr,T
Ncr,TF è lo sforzo assiale critico elastico per

instabilità �esso-torsionale

Ncr,T è lo sforzo assiale critico elastico per
instabilità torsionale

� La snellezza adimensionale, λ̄, di controventi diagonali non disposti a X
deve rispettare le seguenti limitazioni:

λ̄ ≤ 2 (EC8 6.7.3(2))

� La snellezza adimensionale, λ̄, di controventi a V deve rispettare le seguenti
limitazioni:

λ̄ ≤ 2 (EC8 6.7.3(3))

� Le limitazioni di snellezza adimensionale, λ̄, possono non applicarsi per
strutture �no a 2 piani (EC8 6.7.3(4))

� Lo sforzo assiale agente nel controvento, NEd, deve rispettare la seguente
condizione:

NEd ≤ Npl,Rd (EC8 6.7.3(5))
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Parte II Veri�ca elementi in acciaio

con

Npl,Rd =
Afy
γM0

� Per assicurare un comportamento dissipativo omogeneo nei controventi,
il massimo valore dei rapporti di sovraresistenza Ωi (come de�niti in EC8
6.7.4(1)) non deve di�erire dal valore minimo più del 25%. Tale prescrizione
deve essere veri�cata manualmente dall'utente.

7.10.5.2 Travi e colonne

� Tutte le travi e le colonne sismo resistenti devono avere sezioni di classe 1
(EC8 6.5.3(2) Tab. 6.3)

� Travi e colonne devono essere veri�cate assumendo la combinazione più
sfavorevole di �essione e forza assiale. I valori di progetto per taglio e
�essione, VEd e MEd, sono derivati dall'analisi mentre il valore dello sforzo
assiale è calcolato come:

NEd = NEd,G + 1.1γovΩNEd,E (EC8 Eq. 6.12)

NEd,G è lo sforzo assiale nella trave o nella colonna
corrispondente ai soli carichi statici

NEd,E è lo sforzo assiale nella trave o nella colonna
corrispondente ai soli carichi sismici

γov è il fattore di sovraresistenza del materiale

Ω = min (Ωi) con Ωi = Npl,Rd,i/NEd,i rapporto fra lo sforzo as-
siale plastico e lo sforzo assiale di progetto dei
controventi sismo resistenti. È importante sot-
tolineare che il valore di Ω non viene calcola-
to in automatico dal programma ma deve essere
speci�cato manualmente fra le preferenze di pro-
getto oppure assegnato, elemento per elemento,
attraverso le sovrascritture.

7.10.6 Strutture a controventi concentrici in CDM

Le prescrizioni aggiuntive per strutture a controventi concentrici in classe
di duttilità media (CDM), sono le stesse viste per le strutture a controventi
concentrici in CDA, con le seguenti eccezioni (EC8 6.7).
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7.10.6.1 Controventi

� Le sezioni di tutti i controventi sismo resistenti devono essere:

di classe 1 o 2 per 2 < q ≤ 4 (EC8 6.5.3(2), Tab. 6.3)

di classe 1, 2 o 3 per 1.5 < q ≤ 2 (EC8 6.5.3(2), Tab. 6.3)

7.10.6.2 Travi e colonne

� Tutte le travi e le colonne sismo resistenti devono avere sezioni di classe 1
(EC8 6.5.3(2) Tab. 6.3)

di classe 1 o 2 per 2 < q ≤ 4 (EC8 6.5.3(2), Tab. 6.3)

di classe 1, 2 o 3 per 1.5 < q ≤ 2 (EC8 6.5.3(2), Tab. 6.3)

7.10.7 Strutture a controventi concentrici in CDB

Le strutture a controventi concentrici in classe di duttilità bassa (CDB) posso-
no essere calcolate unicamente in accordo all'EC3, senza prescrizioni aggiuntive.

7.10.8 Strutture a controventi eccentrici in CDA

Il programma è in grado di gestire le strutture a controventi eccentrici con-
formi alle tipologie riportate in �gura 7.1.

Figura 7.1: con�gurazioni riconosciute per strutture a controventi eccentrici

Per strutture a controventi eccentrici in classe di duttilità alta (CDA), per
tutte le combinazioni sismiche, vengono veri�cate le seguenti condizioni aggiun-
tive.

147



Parte II Veri�ca elementi in acciaio

7.10.8.1 Link

� I controventi eccentrici dividono le travi dei telai in due o più parti. Ad
una di queste parti, chiamata �elemento di connessione� o �link�, è a�dato
il compito di dissipare l'energia sismica. Tali elementi vengono divisi in 3
categorie a seconda del meccanismo dissipativo sviluppato (EC8 6.8.2):

� link corti (es): che dissipano energia per snervamento a taglio

� link lunghi (el): che dissipano energia per �essione

� link intermedi (e): che dissipano energia con un meccanismo combi-
nato a taglio e �essione

� Per sezioni a I, le resistenze dei link possono essere calcolate attraverso le
relazioni:

Mp,link = fybtf (d− tf ) (EC8 Eq. 6.13)

Vp,link =
fy√

3
tw (d− tf ) (EC8 Eq. 6.14)

� Quando NEd/Npl,Rd ≤ 0.15 le resistenze dei link, ad entrambe le estremità,
devono soddisfare le relazioni (EC8 6.8.2(4)):

VEd ≤ Vp,link (EC8 Eq. 6.15)

MEd ≤Mp,link (EC8 Eq. 6.16)

in cui NEd, MEd e VEd sono le sollecitazioni derivanti dall'analisi

� Quando NEd/Npl,Rd > 0.15 le resistenze dei link, ad entrambe le estremità,
devono soddisfare le relazioni (EC8 6.8.2(5)):

VEd ≤ Vp,link

[
1−

(
NEd
Npl,Rd

)2
]0.5

(EC8 Eq. 6.17)

MEd ≤Mp,link

[
1−

(
NEd
Npl,Rd

)]
(EC8 Eq. 6.18)

� Quando NEd/Npl,Rd > 0.15 le lunghezze dei link non devono superare i
seguenti limiti (EC8 6.8.2(6)):

e ≤ 1.6
Mp,link

Vp,link
se R < 0.3 (EC8 Eq. 6.19)

e ≤ (1.15− 0.5R) 1.6
Mp,link

Vp,link
se R ≥ 0.3 (EC8 Eq. 6.20)
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in cui

R =
NEdtw (d− 2tf )

VEdA
(EC8 6.8.2(6))

� La lunghezza degli e elementi link è catalogata come segue:

link corti: e ≤ es =
1.6Mp,link

Vp,link
(EC8 Eq. 6.21)

link lunghi: e ≥ el =
3Mp,link

Vp,link
(EC8 Eq. 6.22)

link intermedi: es < e < el (EC8 Eq. 6.23)

� In funzione della tipologia, la rotazione plastica sviluppata dal link, θ, deve
risultare conforme ai seguenti limiti:

θ ≤


0.08 radianti per link corti

0.02 radianti per link lunghi

interpolato linearmente fra 0.02 e 0.08 per link intermedi

θ =
δL

e
(EC8 Fig. 6.14a)

δ = drift di piano

L = luce della campata

e = lunghezza del link

� Il massimo valore dei rapporti di sovraresistenza Ωi (come de�niti in EC8
6.8.3.1) non deve di�erire dal valore minimo più del 25%. Tale prescrizione
deve essere veri�cata manualmente dall'utente

7.10.8.2 Travi, colonne e controventi

� Le sezioni di tutte le travi, colonne e controventi devono essere di classe 1
(EC8 6.5.3(2), Tab.6.3)

� Travi, colonne e controventi devono essere veri�cati assumendo la combi-
nazione più sfavorevole di �essione e forza assiale. I valori di progetto per
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Parte II Veri�ca elementi in acciaio

taglio e �essione, VEd eMEd, sono derivati dall'analisi mentre il valore dello
sforzo assiale è calcolato come:

NEd = NEd,G + 1.1γovΩNEd,E (EC8 Eq. 6.30)

NEd,G è lo sforzo assiale nella trave o nella colonna
corrispondente ai soli carichi statici

NEd,E è lo sforzo assiale nella trave o nella colonna
corrispondente ai soli carichi sismici

γov è il fattore di sovraresistenza del materiale

Ω = min (Ωi) con Ωi = 1.5Vp,link,i/VEd,i per link corti; e Ωi =
1.5Mp,link,i/MEd,i per link intermedi e lunghi. È
importante sottolineare che il valore di Ω non vie-
ne calcolato in automatico dal programma ma
deve essere speci�cato manualmente fra le prefe-
renze di progetto oppure assegnato, elemento per
elemento, attraverso le sovrascritture.

7.10.9 Strutture a controventi eccentrici in CDM

Le prescrizioni aggiuntive per strutture a controventi eccentrici in classe di
duttilità media (CDM), sono le stesse viste per le strutture a controventi concen-
trici in CDA, con le seguenti eccezioni (EC8 6.8).

7.10.9.1 Controventi

� Le sezioni di tutti i controventi sismo resistenti devono essere:

di classe 1 o 2 per 2 < q ≤ 4 (EC8 6.5.3(2), Tab. 6.3)

di classe 1, 2 o 3 per 1.5 < q ≤ 2 (EC8 6.5.3(2), Tab. 6.3)

7.10.9.2 Travi e colonne

� Tutte le travi e le colonne sismo resistenti devono avere sezioni di classe 1
(EC8 6.5.3(2) Tab. 6.3)

di classe 1 o 2 per 2 < q ≤ 4 (EC8 6.5.3(2), Tab. 6.3)

di classe 1, 2 o 3 per 1.5 < q ≤ 2 (EC8 6.5.3(2), Tab. 6.3)
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7.10.10 Strutture a controventi eccentrici in CDB

Le strutture a controventi eccentrici in classe di duttilità bassa (CDB) possono
essere calcolate unicamente in accordo all'EC3, senza prescrizioni aggiuntive.

7.10.11 Strutture a pendolo inverso

Per strutture a pendolo inverso, per tutte le combinazioni sismiche, vengono
veri�cate le seguenti condizioni aggiuntive (EC8 6.9).

� NEd, MEd e VEd vengono calcolati in accordo col paragrafo 6.6.3 dell'EC8

� La snellezza adimensionale delle colonne, λ̄, deve essere limitata a: λ̄ ≤ 1.5
(EC8 6.9(3))

� L'indice di drift di interpiano θ, come de�nito al paragrafo 4.4.2.2 dell'EC8
deve risultare θ ≤ 0.2 (EC8 6.9(4)). Tale prescrizione deve essere veri�cata
in maniera indipendente dall'utente.

7.10.12 Strutture secondarie

Le strutture secondarie possono essere calcolate unicamente in accordo al-
l'EC3, senza prescrizioni aggiuntive.

7.11 Progetto dei nodi

SAP2000 è in grado di fornire informazioni di progetto complete per quanto
riguarda:

� calcolo di piatti di continuità per nodi trave colonna di strutture a telaio
(MRF)

� calcolo di imbottiture d'anima per nodi trave colonna di strutture a telaio
(MRF)

relativamente a nodi composti da travi ad I che si innestano perpendicolarmante
all'asse forte di colonne con sezione ad I o ad H.

Inoltre SAP e�ettua il controllo dei rapporti di resistenza per qualunque nodo
trave-colonna in accordo col punto 4.4.2.3 dell'EC8, e fornisce le sollecitazioni di
progetto per il calcolo dei nodi di travi e controventi.
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7.11.1 Progetto delle nervature di continuità

Quando, in strutture a telaio, una trave ad I incide in direzione perpendico-
lare all'asse forte di una colonna avente sezione a I o ad H, al �ne di garantire
un'adeguata capacità �essionale alla connessione, potrebbe essere necessario pre-
vedere l'inserimento di nervature sull'anima della colonna in corrispondenza delle
ali della trave.

SAP2000 valuta la necessità di inserire tali piatti di continuità sulla base
delle prescrizioni presenti al 6.2.6.1-4 dell'EC3-1-8. In particolare il calcolo viene
eseguito sulla base dei 3 meccanismi resistenti interessati:

� anima della colonna soggetta a compressione trasversale

� anima della colonna soggetta a trazione trasversale

� �angia della colonna soggetta a �essione trasversale

7.11.1.1 Anima della colonna soggetta a compressione trasversale

La resistenza di progetto a compressione trasversale di un'anima non irrigidita
è data dalla relazione:

Fc,wc,Rd =
ωkwcbeff,c,wctwcfy,wc

γM0

Fc,wc,Rd ≤
ωkwcρbeff,c,wctwcfy,wc

γM1

(EC3-1-8 Eq. 6.9)

in cui

ω fattore di riduzione che tiene conto della possibile inte-
razione con lo sforzo di taglio presente nell'anima della
colonna (EC3-1-8 Tab. 6.3). ω è una funzione del para-
metro β assunto conservativamente nei calcoli pari a 2
(EC3-1-8 5.3(7))

beff,c,wc è la larghezza e�cace dell'anima della colonna sogget-
ta a compressione trasversale. Nel caso di connessione
saldata si ha:
beff,c,wc = tfb + 2

√
2ab + 5(tfc + s) (EC3-1-8 �g. 6.6)

con:

ab = tfb/2 assunto nel calcolo

s = rc per sezioni laminate

s =
√

2ac per sezioni saldate

ac = tfc/2 assunto nel calcolo
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ρ fattore di riduzione per e�etto dell'instabilità (EC3-1-8
Eq. 6.13(a,b)):

ρ = 1 se λ̄p ≤ 0.72

ρ =
λ̄p − 0.2

λ̄2p
se λ̄p > 0.72

λ̄p è la snellezza dell'anima (EC3-1-8 Eq. 6.13(c)):

λ̄p = 0.932

√
beff,c,wcdwcfy,wc

Et2wc
dwc = hc − 2(tfc + rc) per sezioni laminate

dwc = hc − 2(tfc +
√

2ac) per sezioni saldate

kwc fattore di riduzione de�nito al punto 6.2.6.2(2) dell'EC3-
1-8 assunto, nel calcolo, pari a 1

7.11.1.2 Anima della colonna soggetta a trazione trasversale

La resistenza di progetto a trazione trasversale di un'anima non irrigidita è
data dalla relazione:

Ft,wc,Rd =
ωbeff,t,wctwcfy,wc

γM0
(EC3-1-8 Eq. 6.15)

in cui

ω fattore di riduzione che tiene conto della possibile inte-
razione con lo sforzo di taglio presente nell'anima della
colonna (EC3-1-8 Tab. 6.3). ω è una funzione del para-
metro β assunto conservativamente nei calcoli pari a 2
(EC3-1-8 5.3(7))

beff,t,wc è la larghezza e�cace dell'anima della colonna soggetta
a trazione trasversale. Nel caso di connessione saldata
si ha:
beff,t,wc = tfb + 2

√
2ab + 5(tfc + s) (EC3-1-8 �g. 6.6)

con:

ab = tfb/2 assunto nel calcolo

s = rc per sezioni laminate

s =
√

2ac per sezioni saldate

ac = tfc/2 assunto nel calcolo
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Parte II Veri�ca elementi in acciaio

7.11.1.3 Ala della colonna soggetta a �essione trasversale

La resistenza di progetto a �essione trasversale di un'anima non irrigidita è
data dalla relazione:

Ffc,Rd =
beff,b,fctfbfy,fb

γM0
(EC3-1-8 Eq. 6.20)

in cui:

beff,b,fc è la larghezza e�cace dell'ala della colonna soggetta a
�essione trasversale (EC3-1-8 4.10(2)):
beff,b,fc = twc + 2s+ 7ktfc (EC3-1-8 Eq. 4.6a)

con:

k = (tf/tp) (fy,f/fy,p) ≤ 1 (EC3-1-8 Eq. 4.6a)

fy,f resistenza a snervamento dell'ala della colonna

fy,p resistenza a snervamento dell'ala della trave

s = rc per sezioni laminate

s =
√

2ac per sezioni saldate

L'area delle nervature di continuità, Acp, è calcolata imponendo:

max



FEd − Fc,wc,Rd
Nb,Rd

= 1

FEd − Ft,wc,Rd
Nb,Rd

= 1

FEd − Ffc,Rd
Nb,Rd

= 1

in cui:

FEd azione di progetto trasferita dalle travi, assunta pari a:

FEd =
MEd

h− tf
per combinazioni statiche

FEd = 1.1γovbfbtfbfyb (EC8 Eq. 6.1) per combinazioni
sismiche in strutture tipo DCH-MRF o DCM-MRF

Nb,Rd resistenza all'instabilità della sezione composta dalle
nervature e dalla porzione collaborante di anima della
colonna:

154



Nb,Rd =
χAefffy
γM1

(EC3 9.4(2))

χ fattore di riduzione della resistenza per e�etto del-
l'instabilità (calcolato assumendo la curva di instabilità
c)

Aeff = Acp +Awc,eff area e�cace della sezione

Awc,eff area di anima della colonna collaborante. Ai �ni
del calcolo si assume una porzione di anima collaborante
di lunghezza pari a 25twc quando sono presenti colonne
al di sopra ed al di sotto del nodo, e di 12twc quando è
presente solo la colonna inferiore (AISC J10.8)

Qualora dalle relazioni precedenti risultasse Acp < 0, non è necessario disporre
nervature di continuita, viceversa l'area totale delle nervature dovrà comunque
risultare superiore a:

Amincp = bmincp tmincp (AISC J10.8)

con:

bmincp = 2

(
bfp
3
− twc

2

)
(AISC J10.8)

tmincp = 0.5tfb (AISC J10.8)

7.11.2 Progetto delle imbottiture d'anima

Quando, in strutture a telaio, una trave incide in direzione perpendicolare
all'asse forte di una colonna avente sezione a I o ad H, al �ne di garantire un'ade-
guata capacità �essionale alla connessione, potrebbe essere necessario prevedere
l'inserimento di imbottiture sull'anima della colonna per garantire il trasferimento
delle azioni taglianti nel pannello.

La forza sollecitante sul pannello d'anima è calcolata attraverso la relazione:

Vwp,Ed =
Mb1,Ed cos θb1 −Mb2,Ed cos θb2

h− tfb
−
Vc1,Ed−Vc2,Ed

2
(EC3-1-8 Eq. 5.3)

con:

Mbi,Ed momento �ettente trasferito dalla trave i-esima, assunto
pari al momento derivante dall'analisi per combinazioni
statiche, e pari a γovWplfy (EC8 6.1.3) per combinazioni
sismiche in strutture di tipo DCH-DCM MRF
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Parte II Veri�ca elementi in acciaio

θbi angolo compreso fra l'asse della trave i-esima e l'asse
debole della colonna

Vci,Ed taglio sollecitante nelle colonne derivante all'analisi

La resistenza di un'anima rinforzata con singola o doppia imbottitura, è data
da:

Vwp,Rd =
0.9fy,wcAvc√

3γM0

(EC3-1-8 Eq. 6.7)

con

Avc = htp area a taglio del complesso anima-imbottitura

h altezza dell'anima della colonna

tp spessore complessivo di anima e imbottiture

Lo spessore richiesto alle imbottiture,ts ,viene quindi calcolato imponendo:

Vwp,Ed = Vwp,Rd

tp =
Vwp,Ed

√
3γM0

0.9hfy,wc

ts = tp − twc

Qualora dai calcoli risultasse ts > tw, il programma riporta un messaggio di
errore in accordo con quanto prescritto in EC3-1-8 6.2.6.1(6). In aggiunta:

� Qualora le imbottiture d'anima siano saldate:

� se hwc/(twc + ts) > 69ε, viene riportato un messaggio di errore

� Qualora le imbottiture d'anima non siano saldate:

� se hwc/twc > 69ε, viene riportato un messaggio di errore

� se bs/ts > 40ε allora viene posto ts = bs/40ε

Si ricorda inoltre che, nel caso di utilizzo di imbottiture d'anima, devono essere
soddisfatte tutte le prescrizioni di dettaglio strutturale riportate al punto EC3-1-8
6.2.6.1.
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7.11.3 Veri�ca dei rapporti di resistenza trave-colonna

Per strutture a telaio in CDA e in CDM (DCH-DCM MRF), in condizioni
sismiche, in ogni nodo fra elementi principali della struttura deve risultare che
la somma dei momenti resistenti delle colonne sia maggiore della somma dei
momenti �ettenti delle travi incidenti nel nodo (EC8 4.4.2.3). La resistenza a
�essione delle colonne deve essere calcolata tenendo conto dell'eventuale in�uenza
dello sforzo assiale così come la resistenza �essionale delle travi deve tener conto
di possibili incrudimenti che ne accrescano la capacità.

I rapporti di capacità in direzione forte e debole,Rmaj e Rmin, vengono
riportati sulla stazione superiore della colonna inferiore del nodo:

Rmaj =
1.3
∑nb

n=1MRbn cos θn
Mpl,RdA +Mpl,RdB

(EC8 Eq. 4.29)

Rmin =
1.3
∑nb

n=1MRbn sin θn
Mpl,RdA +Mpl,RdB

(EC8 Eq. 4.29)

con

MRbn momento resistente della n-esima trave incidente nel
nodo

θn angolo compreso fra l'asse della trave n-esima e l'asse
debole della colonna

Mpl,RdA momento resistente della colonna inferiore del nodo,
ridotto per e�etto dell'azione assiale presente

Mpl,RdB momento resistente della colonna superiore del nodo,
ridotto per e�etto dell'azione assiale presente

nb numero di travi incidenti nel nodo

I momenti resistenti delle colonne, ridotti per e�etto dello sforzo assiale, sono
calcolati come:

MN,Rd = Mpl,Rd

[
1−

(
NEd
Npl,Rd

)2
]

(EC3 Eq. 6.32)

I momenti resistenti delle travi, incrementati per e�etto di potenziali incrudimen-
ti, sono calcolati come:

Mpl,Rd = γovWpl,bfyb (EC8 6.1.3(2))
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Parte II Veri�ca elementi in acciaio

7.11.4 Calcolo dei tagli di progetto per le connessioni delle
travi

Per tutte le travi presenti nella struttura, il programma riporta le massime
forze di taglio in direzione forte che l'elemento trasferisce alle estremità. Tali
azioni rappresentano, di fatto, le azioni di progetto per le eventuali connessioni
da realizzare con elementi adiacenti.

Per le combinazioni statiche, i tagli di progetto riportati coincidono con i
massimi tagli derivanti dall'analisi alle etremità dell'elemento.

Per le combinazioni simiche valgono le seguenti considerazioni:

� Per strutture a telaio in CDA o CDM (DCH-DCM MRF) i tagli di progetto
alle estremità sono calcolati attraverso la relazione:

VEd = VEd,G + VEd,M (EC8 6.6.4(1))

VEd,M =
CMEd,M

L

in cui:

VEd taglio di progetto di estremità

VEd,G taglio sollecitante all'estremità della trave dovuto ai soli
carichi non simsici

VEd,M taglio sollecitante all'estremità della trave dovuto al rag-
giungimento dei momenti plastici alle estremità della
trave

C = 0 se la trave è incernierata ad entrambi gli estremi

= 1 se la trave è incernierata ad una sola estremità

= 2 se la trave è continua ad entrambi gli estremi

MEd,M momento resistente della trave che tiene conto di
possibili incrudimenti, assunto pari a γovWpl,bfyb

L luce della trave

� Per strutture a telaio in CDB (DCL MRF) i tagli di progetto alle estremità
sono pari ai massimi tagli di estremità derivanti dalle analisi

� Per strutture a controventi concentrici in CDA, CDM e CDB (DCH-DCM-
DCL CBF) i tagli di progetto alle estremità sono pari ai massimi tagli di
estremità derivanti dalle analisi
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� Per strutture a controventi eccentrici in CDA o CDM (DCH-DCM EBF) i
tagli di progetto alle estremità sono calcolati come speci�cato in EC8 6.8.4
Eq. 6.31

� Per strutture a controventi eccentrici in CDB (DCL EBF) i tagli di progetto
alle estremità sono pari ai massimi tagli di estremità derivanti dalle analisi

7.11.5 Calcolo delle azioni di progetto per le connessioni
dei controventi

Per tutti i controventi presenti nella struttura, il programma riporta le mas-
sime forze assiali che l'elemento trasferisce alle estremità. Tali azioni rappresen-
tano, di fatto, le azioni di progetto per le eventuali connessioni da realizzare con
elementi adiacenti.

Per le combinazioni statiche, le azioni assiali di progetto riportate coincidono
con i massimi sforzi assiali derivanti dall'analisi alle etremità dell'elemento.

Per le combinazioni simiche valgono le seguenti considerazioni:

� Per strutture a controventi concentrici in CDA o CDM (DCH-DCM CBF)
le azioni assiali di progetto sono calcolate attraverso la relazione:

Ed = 1.1γovRfy (EC8 Eq. 6.1)

con:

Ed è la sollecitazione di progetto sulla connessione

Rfy è la resistenza del controvento dissipativo

γov è il coe�ciente di sovraresistenza del materiale

� Per strutture a controventi concentrici in CDB (DCL CBF) le azioni assiali
di progetto alle estremità sono pari alle massime azioni assiali di estremità
derivanti dalle analisi

� Per strutture a controventi eccentrici in CDA o CDM (DCH-DCM EBF) le
azioni assiali di progetto sono calcolate attraverso la relazione:

Ed = Ed,G + 1.1γovΩEd,E (EC8 Eq. 6.31)

con:

Ed è la sollecitazione di progetto sulla connessione

Ed,G è la sollecitazione agente sul controvento dovuta ai soli
carichi statici
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Ed,E è la sollecitazione agente sul controvento dovuta ai soli
carichi sismici

γov è il coe�ciente di sovraresistenza del materiale

Ω è il rapporto di sovraresistenza dei link della struttu-
ra come de�nito al punto 6.8.3(1) dell'EC8 (N.B. ta-
le rapporto non viene calcolato automaticamente ma
deve essere inserito dall'utente nelle preferenze di ve-
ri�ca o assegnato, elemento per elemento, attraverso le
sovrascritture)

� Per strutture a controventi eccentrici in CDB (DCL EBF) le azioni assiali
di progetto alle estremità sono pari alle massime azioni assiali di estremità
derivanti dalle analisi

7.12 Preferenze di veri�ca

Viene di seguito riportato il signi�cato di tutte le diverse preferenze di pro-
gettazione che possono essere impostate dall'utente una volta selezionata la nor-
mativa EC3-2005. Con riferimento alla �gura 7.2 si ha:

1. Design Code: indica il codice di veri�ca selezionato

2. Country: indica il paese di riferimento per l'impostazione dei parametri di
progetto speci�ci per i vari paesi

3. Combinations Equation: indica l'equazione dell'EC0 cui far riferimento per
la generazione delle combinazioni automatiche di progetto

4. Reliability Class: classe di a�dabilità, utilizzata nella generazione delle
combinazioni di progetto per Danimarca, Finlandia e Svezia

5. Interaction Factors Method: metodo di calcolo dei coe�cienti di interazione
per i momenti �ettenti nella veri�ca ad instabilità per presso�essione. È
possibile scegliere fra l'approccio presente nell'allegato A dell'EC3 (Metodo
1) oppure nell'allegato B dell'EC3 (Metodo 2)

6. Multi-Response Case Design: de�nisce la procedura di progetto per analisi
con risposta multipla (analisi time history, analisi statiche non lineari e
analisi multi-step statiche). È possibile scegliere fra:

� Envelopes: considera l'inviluppo per le analisi time-history e le analisi
multi-step statiche e lo stato �nale per le analisi non lineari statiche
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� Step by step: considera tutti gli step per le analisi time-history e le
analisi multi-step statiche e lo stato �nale per le analisi non lineari
statiche

� Last step: considera solo lo stato �nale per le analisi time-history, le
analisi multi-step statiche e le analisi non lineari statiche

� Envelopes-All: considera l'inviluppo per le analisi time-history, le
analisi multi-step statiche e le analisi non lineari statiche

� Step by step-All: considera tutti gli step per le analisi time-history, le
analisi multi-step statiche e le analisi non lineari statiche

È opportuno sottolineare che le opzioni Step by step e Step by step-All
vengono automaticamente convertite alle corrispondenti Envelope qualora
più di un caso di analisi a risposta multipla sia presente in combinazione

7. Framing Type: tipologia strutturale. È possibile scegliere fra le tipologie
elencate nei precedenti paragra�

8. Behavior Factor, q: fattore di struttura da impiegare nelle veri�che

9. System Overstrength Factor, Ω: fattore di sovraresistenza della struttura,
come de�nito nei paragra� precedenti in funzione delle diverse tipologie
strutturali

10. Consider P-Delta Done?: opzione che permette di speci�care se gli e�etti
globali del secondo ordine sono stati inclusi nell'analisi. In caso a�ermativo
il programma in fase di veri�ca utilizzerà per tutte le tipologie strutturali
le lunghezze libere calcolate nell'ipotesi di struttura a nodi �ssi, in caso
contrario il programma utilizzarà le lunghezze libere per strutture a nodi
�ssi nel caso di strutture controventate e le lunghezze corrispondenti a
strutture a nodi spostabili nel caso di strutture a telaio

11. γM0: coe�ciente parziale di sicurezza del materiale per veri�che di resi-
stenza

12. γM1: coe�ciente parziale di sicurezza del materiale per veri�che di insta-
bilità

13. γM2: coe�ciente parziale di sicurezza del materiale per veri�che di resi-
stenza ultima a trazione

14. Ignore Seismic Code?: consente di escludere dalla veri�ca le prescrizioni
relative all'EC8

15. Ignore Special Seismic Load?: consente di escludere la generazione delle
combinazioni di carico sismiche
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16. Is Doubler Plate Plug Welded?: consente di speci�care se il piatto di rinforzo
dell'anima della colonna nei giunti trave colonna è saldato

17. Consider De�ection?: opzione che permette di attivare la veri�ca di defor-
mabilità degli elementi agli stati limite di esercizio

18. DL Limit, L/: freccia limite per carichi permanenti compiutamente de�niti
(espressa come frazione della lunghezza dell'elemento)

19. Super DL+LL Limit, L/: freccia limite dovuta alla somma dei carichi per-
manenti non compiutamente de�niti e dei carichi variabili (espressa come
frazione della lunghezza dell'elemento)

20. Live Load Limit, L/: freccia limite per carichi variabili (espressa come
frazione della lunghezza dell'elemento)

21. Total Limit, L/: freccia limite totale (espressa come frazione della lunghez-
za dell'elemento)

22. Total-Camber Limit, L/: freccia limite totale al netto della monta (espressa
come frazione della lunghezza dell'elemento)

23. Pattern Live Load Factor: quota di carico variabile che viene ripartita
secondo lo schema di semplice appoggio per il progetto delle travi

24. Demand/Capacity Ratio Limit: valore limite per l'accettabilità dei rapporti
di capacità

7.13 Sovrascritture

Viene di seguito riportato il signi�cato delle possibili sovrascritture assegna-
bili a travi e pilastri. Le sovrascritture possono essere assegnate, una volta sele-
zionato l'elemento, attraverso il comando Design > Steel Frame Design >
View/Rewise Overwrites. Con riferimento alla �gura 7.3 si ha:

1. Current Design Section: indica qual'è la sezione di progetto assegnata alla
data trave

2. Framing Type: è possibile de�nire la struttura di cui fa parte l'elemento
scegliendo fra quelle compatibili

3. Section Class: classe della sezione

4. Column Buckling Curve (y-y): curva di intabilità per in�essione attorno
all'asse maggiore
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Figura 7.2: preferenze di progettazione per l'EC3-2005

5. Column Buckling Curve (z-z): curva di intabilità per in�essione attorno
all'asse minore

6. Buckling Curve for LTB: curva di intabilità per instabilità �esso-torsionale

7. System Overstrength Factor, Ω: fattore di sovraresistenza della struttura,
come de�nito nei paragra� precedenti in funzione delle diverse tipologie
strutturali

8. Is Rolled Section?: consente di speci�care se la sezione è laminata (tale
opzione in�uenza la scelta della curva di instabilità per l'elemento)

9. Consider De�ection?: opzione che permette di attivare la veri�ca di defor-
mabilità degli elementi agli stati limite di esercizio
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10. De�ection Check Type: consente di speci�care se le frecce limite debbano
essere veri�cate come frazione della lunghezza dell'elemento (Ratio), come
valore assoluto (Absolute) o entrambi (Both)

11. DL Limit, L/: freccia limite per carichi permanenti compiutamente de�niti
(espressa come frazione della lunghezza dell'elemento)

12. Super DL+LL Limit, L/: freccia limite dovuta alla somma dei carichi per-
manenti non compiutamente de�niti e dei carichi variabili (espressa come
frazione della lunghezza dell'elemento)

13. Live Load Limit, L/: freccia limite per carichi variabili (espressa come
frazione della lunghezza dell'elemento)

14. Total Limit, L/: freccia limite totale (espressa come frazione della lunghez-
za dell'elemento)

15. Total-Camber Limit, L/: freccia limite totale al netto della monta (espressa
come frazione della lunghezza dell'elemento)

16. DL Limit, abs: freccia limite per carichi permanenti compiutamente de�niti
(espressa nell'unità di misura corrente)

17. Super DL+LL Limit, abs: freccia limite dovuta alla somma dei carichi
permanenti non compiutamente de�niti e dei carichi variabili (espressa
nell'unità di misura corrente)

18. Live Load Limit, abs: freccia limite per carichi variabili (espressa nell'unità
di misura corrente)

19. Total Limit, abs: freccia limite totale (espressa nell'unità di misura corren-
te)

20. Total-Camber Limit, abs: freccia limite totale al netto della monta (espressa
nell'unità di misura corrente)

21. Speci�ed Camber: monta iniziale (espressa nell'unità di misura corrente)

22. Net Area to Tootal Area Ratio: rapporto fra area netta e area della sezione
lorda. Utilizzato nel calcolo della resistenza ultima a trazione dell'elemento

23. Live Load Reduction Factor: moltiplicatore per i carichi variabili �riducibili�
(reducible live)

24. Unbraced Length Ratio (Major): rapporto fra la distanza dei punti di vin-
colo e la lunghezza dell'elemento per instabilità attorno all'asse di massima
inerzia
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25. Unbraced Length Ratio (Minor): rapporto fra la distanza dei punti di vin-
colo e la lunghezza dell'elemento per instabilità attorno all'asse di minima
inerzia

26. Unbraced Length Ratio (LTB): rapporto fra la distanza dei punti di vincolo
e la lunghezza dell'elemento per instabilità �esso-torsionale

27. E�ective Length Factor Braced (K1major): coe�ciente di lunghezza e�cace
lungo l'asse maggiore nell'ipotesi di struttura a nodi �ssi

28. E�ective Length Factor Braced (K1minor): coe�ciente di lunghezza e�cace
lungo l'asse minore nell'ipotesi di struttura a nodi �ssi

29. E�ective Length Factor Sway (K2major): coe�ciente di lunghezza e�cace
lungo l'asse maggiore nell'ipotesi di struttura a nodi spostabili

30. E�ective Length Factor Sway (K2minor): coe�ciente di lunghezza e�cace
lungo l'asse minore nell'ipotesi di struttura a nodi spostabili

31. E�ective Length Factor (KLTB): coe�ciente di lunghezza e�cace per in-
stabilità �esso torsionale

32. Bending Coe�cient C1: coe�ciente moltiplicativo per il calcolo del momen-
to critico per instabilità �esso torsionale

33. Moment Coe�cient kyy,major: coe�ciente di interazione per la �essione
attorno all'asse maggiore nella veri�ca di instabilità

34. Moment Coe�cient kzz,major: coe�ciente di interazione per la �essione
attorno all'asse minore nella veri�ca di instabilità

35. Moment Coe�cient kzy,major: coe�ciente di interazione per la �essione
attorno all'asse maggiore nella veri�ca di instabilità

36. Moment Coe�cient kyz,major: coe�ciente di interazione per la �essione
attorno all'asse minore nella veri�ca di instabilità

37. Yeld Stress, fy: tensione di snervamento

38. Material Overstrength Factor, γov: coe�ciente di sovraresistenza del ma-
teriale

39. Compressive Capacity, Nc,Rd: resistenza a compressione dell'elemento

40. Tensile Capacity, Nt,Rd: resistenza a trazione dell'elemento

41. Major Bending Capacity, Mc3,Rd: resistenza dell'elemento a �essione at-
torno all'asse maggiore

165



Parte II Veri�ca elementi in acciaio

42. Minor Bending Capacity, Mc2,Rd: resistenza dell'elemento a �essione at-
torno all'asse minore

43. Buckling Resistance Moment, Mb,Rd: resistenza dell'elemento a instabilità
per �essione

44. Major Shear Capacity, V2,Rd: resistenza dell'elemento a taglio lungo l'asse
maggiore

45. Major Shear Capacity, V3,Rd: resistenza dell'elemento a taglio lungo l'asse
minore

46. Demand/Capacity Ratio Limit: valore limite per l'accettabilità dei rapporti
di capacità

Figura 7.3: Sovrascritture
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7.14 Output di progetto

Viene di seguito riportato l'output fornito da SAP con riferimento al proget-
to di travi e colonne in accordo con l'EC3-2005. Le �nestre di dettaglio sono
raggiungibili, una volta e�ettuato il progetto della struttura, cliccando col tasto
destro sull'elemento da interrogare. In particolare, nella �nestra riassuntiva (�-
gura 7.4) sono riportati i rapporti di capacità corrispondenti alle varie stazioni
dell'elemento per tutte le diverse combinazioni di carico.

Figura 7.4: �nestra riassuntiva di veri�ca per elementi in acciaio

Selezionando una stazione ed una data combinazione di progetto, cliccando
sul pulsante �Summary� è possibile avere accesso ai dettagli di relativi alla sta-
zione selezionata con riferimento alla data combinazione. Le informazioni sono
riportate in forma ordinata e sequenziale. Con riferimento alle �gure 7.5 e 7.6 si
possono individuare 7 aree speci�che:

� Area A: nella parte superiore della �nestra di dettaglio sono riportate le
informazioni relative all'elemento in esame, alla corrispondente sezione non-
ché i dettagli riguardanti la stazione di output, la combinazione di progetto
e i coe�cienti di sicurezza dei materiali

� Area B: in tale area vengono riportate le sollecitazioni di progetto cor-
rispondenti alla stazione in esame (eventualmente incrementate per tener
conto dei criteri di gerarchia delle resistenze)

� Area C: in tale area viene riportato il riassunto della veri�ca per azione
combinata di �essione e sforzo assiale:
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� Governing Equation: riferimento all'equazione dell'EC3 che ha deter-
minato il raggiungimento del massimo fattore di utilizzo per l'elemento

� Total Ratio: massimo coe�ciente di utilizzo totale per azione combi-
nata di �essione e sforzo assiale

� N Ratio: massimo fattore di utilizzo assiale

� MMajor Ratio: massimo fattore di utilizzo per �essione attorno all'as-
se maggiore

� MMinor Ratio: massimo fattore di utilizzo per �essione attorno all'as-
se minore

� Ratio Limit: massimo valore accettabile del rapporto di capacità

� Status Check: controllo del massimo coe�ciente di utilizzo

� Area D: in tale area vengono riportati i calcoli della veri�ca per azioni
assiali dell'elemento:

� Ned Force: sforzo assiale di progetto

� Nc,Rd Capacity: resistenza a compressione della sezione

� Nt,Rd Capacity: resistenza a trazione della sezione

� Npl,Rd: resistenza plastica della sezione

� Nu,Rd: resistenza ultima a trazione della sezione netta

� Ncr,T: sforzo normale critico per instabilità torsionale

� Ncr,TF: sforzo normale critico per instabilità �esso-torsionale

� An/Ag: rapporto fra l'area della sezione netta e l'area della sezione
lorda

Vengono inoltre riportate, in forma tabellare, le grandezze che intervengono
nel calcolo della resistenza per instabilità a compressione, in particolare:

� Curve: curva di instabilità relativa al modo considerato. Il modo di
instabilità corrispondente alle varie righe è riportato nella colonna sini-
stra della tabella. Per i modi di instabilità �essionali lungo le direzioni
principali viene considerata sia l'ipotesi di struttura a nodi �ssi (B) che
di struttura a nodi mobili. In base alla tipologia strutturale de�nita
il programma utilizzerà nel calcolo il relativo valore di resistenza

� Alpha: valore del fattore di imperfezione, dipendente dalla curva di
instabilità

� Ncr: sforzo normale critico per il modo corrispondente

� LambdaBar: snellezza adimensionale per il modo corrispondente

� Phi: coe�ciente per il calcolo di del fattore di riduzione della resistenza
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� Chi: fattore di riduzione della resistenza

� Nb,Rd: resistenza dell'elemento all'instabilità per il modo considerato

� Area E: in tale area vengono esplicitati i calcoli della veri�ca a �essione
dell'elemento:

� Med Moment: momento sollecitante nella stazione in esame lungo la
direzione corrispondente. La direzione corrispondente è riportata nella
colonna sinistra della tabella

� Med,span Moment: momento sollecitante massimo, in valore assoluto,
agente sull'elemento lungo la direzione corrispondente

� Mc,Rd Capacity: resistenza a �essione della sezione lungo la direzione
corrispondente

� Mv,Rd Capacity: resistenza a �essione della sezione lungo la direzione
corrispondente ridotta per e�etto delle azioni taglianti

� Mn,Rd Capacity: resistenza a �essione della sezione lungo la direzione
corrispondente ridotta per e�etto delle azioni assiali

� Mb,Rd Capacity: resistenza dell'elemento ad instabilità per �essione
lungo la direzione maggiore

Vengono inoltre riportate, in forma tabellare, le grandezze che intervengono
nel calcolo della resistenza per instabilità �esso torsionale, in particolare:

� Curve: curva di instabilità per instabilità �esso torsionale

� AlphaLT: valore del fattore di imperfezione, dipendente dalla curva di
instabilità

� LambdaBarLT: snellezza adimensionale per instabilità �esso torsionale

� PhiLT: coe�ciente per il calcolo di del fattore di riduzione della resi-
stenza

� ChiLT: fattore di riduzione della resistenza

� C1: coe�ciente di calcolo per il momento critico

� Mcr: momento critico per instabilità �esso torsionale

Sono in�ne esplicitati i valori dei coe�cienti di interazione k dei momenti
per le varie direzioni

� Area F: in tale area vengono esplicitati i calcoli della veri�ca a taglio
dell'elemento:

� Ved Force: taglio sollecitante lungo la direzione corrispondente. La
direzione corrispondente è riportata nella colonna sinistra della tabella
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� Vc,rd Capacity: resistenza a taglio della sezioni lungo la direzione
corrispondente

� Stress Ratio: fattore di utilizzo a taglio nella direzione in esame

� Status Check: stato della veri�ca a taglio nella direzione in esame

� Ted Torsion: mometo torcente sollecitante

Viene inoltre riportata, in forma tabellare, la veri�ca ad instabilità a taglio
lungo la direzione forte:

� Vpl,rd Capacity: resistenza a taglio per instabilità lungo la direzione
forte

� Eta: fattore di area a taglio

� LambdabarW: snellezza adimensionale per l'intsbilità a taglio

� Area G: in tale area vengono esplicitati i calcoli del progetto dei piatti
di continuità e delle imbottiture e la veri�ca dei rapporti di resistenza nei
collegamenti trave-colonna:

� Cont Pl Area: area richiesta per i piatti di continuità

� Dbl Pl Thick: spessore dell'imbottitura d'anima

� BC Ratio Major: rapporto di resistenza trave colonna lungo la dire-
zione maggiore

� BC Ratio Minor: rapporto di resistenza trave colonna lungo la dire-
zione minore

Sempre con riferimento alla �gura 7.4, cliccando sul pulsante �Flexure� sa-
rà possibile avere accesso ad un'lteriore schermata di dettaglio in cui vengono
riportati, in aggiunta alle informazioni già presentate, i dettagli del calcolo del-
le lunghezze libere di in�essione per i vari modi di instabilità (area A �gura
7.7) e i dettagli della classi�cazione della sezione e del calcolo dei coe�cienti di
interazione (area B �gura 7.7).
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Figura 7.5: dettagli di veri�ca (prima parte)
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Figura 7.6: dettagli di veri�ca (seconda parte)
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Figura 7.7: dettagli di veri�ca (terza parte)
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Capitolo 8

Esempio di calcolo: Telaio in

CDA

Nel presente capitolo verrà illustrata la procedura di calcolo, in accordo con
l'Eurocodice 3 ed Eurocodice 8, di una struttura a telaio in acciaio in classe di
duttilità alta. I parametri di veri�ca verranno settati in accordo con il documento
di applicazione nazionale italiano, in modo da rendere le veri�che pienamente
conformi alle prescrizioni nazionali.

8.1 De�nizione della struttura

La struttura in esame rappresenta un telaio piano in acciaio a 4 piani e 4
campate. L'ampiezza delle campate è pari a 5 metri, mentre l'interpiano è pari a
3 metri, per un'altezza totale di 12 metri. Travi e pilastri hanno sezioni a doppio
T:

� travi: sezione IPE220 (�gura 8.1)

� pilastri: sezione HE220A (�gura 8.2)

La geometria globale della struttura è riportata in �gura 8.3. Tutte le sezioni
sono costituite da acciaio di tipo S275, aventi le caratteristiche riportate in �gura
8.4.
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Figura 8.1: IPE220

Figura 8.2: HE220A
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Figura 8.3: geometria globale del telaio

Figura 8.4: de�nizione dei materiali
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8.2 Analisi dei carichi

Alla struttura sono stati applicati i seguenti carichi statici:

� peso proprio degli elementi strutturali: DEAD

� carichi permanenti di piano: g2k = 2.5kN/m2

� carichi accidentali di piano: qAk = 2.0kN/m2

Supponendo una larghezza di in�uenza dei vari telai pari a 5 metri, le travi sono
state caricate come illustrato in �gura 8.5 ed in �gura 8.6. Per quanto riguarda
i carichi sismici è stato de�nito uno spettro di risposta allo SLV in accordo con
la normativa italiana. Il fattore di struttura assunto è pari a 6.5, valore coerente
con la tipologia strutturale in esame e la classe di duttilità adottata (vedi �gura
8.7).

Figura 8.5: distribuzione dei carichi permanenti
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Figura 8.6: distribuzione dei carichi variabili

Figura 8.7: spettro di risposta allo SLV impiegato nell'analisi
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Ad ognuno dei carichi de�niti è stato associato un load case come mostrato
in �gura 8.8.

Figura 8.8: casi di analisi

8.3 Combinazioni di progetto

Le combinazioni di progetto impiegate nel calcolo sono 2, riportate in �gura
8.9:

� SLU: combinazione agli stati limite ultimi

� QKE: combinazione sismica allo SLV

(a) (b)

Figura 8.9: combinazioni di progetto
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8.4 Impostazione dei parametri di progetto

I parametri di progetto sono stati impostati come mostrato in �gura 8.10 in
accordo con le prescrizioni contenute nelle norme italiane NTC2008. Il valore
minimo dei rapporti Ω è stato lasciato, in prima battuta, pari a 1 e sarà modi-
�cato sulla base dei risultati di veri�ca ottenuti per le travi. Le combinazioni
precedentemente create sono state quindi impostate come uniche combinazioni
di progetto, vedi �gura 8.11.

Figura 8.10: preferenze di progetto
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Figura 8.11: impostazione delle combinazioni di progetto

8.5 Veri�ca delle travi

Per prima cosa si esegue la veri�ca delle travi, in tal modo sarà possibile
determinare il valore esatto del coe�ciente Ω ed e�ettuare la veri�ca dell'intera
struttura. Ipotizzando che le travi siano piolate al solaio in calcestruzzo, si de�ni-
sce un vincolo allo sbandamento dell'ala superiore attraverso il comando Design
> Lateral Bracing > User Speci�ed > Specify Uniform Bracing come descritto in
�gura 8.12. Completata tale operazione si possono lanciare le veri�che attraverso
il comando Design > Steel Frame Design > Start Design/Check of Structure. I
risultati del processo di veri�ca posssono essere visualizzati attraverso il coman-
do Design > Steel Frame Design > Display Design Info > P-M Ratio Colors &
Values per quanto riguarda la veri�ca a sforzo assiale e �essione, oppure P-M
Colors/Shear Ratio Values per quanto riguarda la veri�ca a taglio. Cliccando su
una qualunque trave col tasto destro sarà possibile avere accesso alla �nestra dei
dettagli di veri�ca. I risultati della veri�ca sono riportati in �gura 8.13 e 8.14.
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Figura 8.12: vincolo allo sbandamento sulla piattabanda superiore

Figura 8.13: risultati della veri�ca P-M-M delle travi in acciaio
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Figura 8.14: risultati della veri�ca a taglio delle travi in acciaio

Una volta accertato che le travi risultino adeguatamente resistenti, prima di
procedere alla veri�ca di tutta la restante parte di struttura, occorre procedere
al calcolo del rapporto di sovraresistenza Ω delle travi, de�nito dalla relazione
Ω = min {Mpl,Rd,i/MEd,i}. A tal proposito è su�ciente ripetere la procedura di
veri�ca delle travi escludendo le combinazioni non sismiche dal processo di veri�ca
e calcolare il reciproco del coe�ciente di utilizzo più alto, che nel caso in esame
risulta essere pari a 0.607 (vedi �gura 8.16). Pertanto si avrà Ω = 1/0.607 = 1.65.
Una voltra determinato il valore di Ω le preferenze di veri�ca possono essere
corrette come mostrato in �gura 8.17.
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Figura 8.15: impostazione delle combinazioni di progetto per il calcolo dei
coe�cienti Ω

Figura 8.16: risultati della veri�ca P-M-M delle travi in acciaio per le sole
combinazioni sismiche
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Figura 8.17: preferenze di progetto corrette

8.6 Veri�ca delle colonne

Una volta completata la procedura di progettazione delle travi e calcolato il
valore del coe�ciente Ω è e�ettuare la veri�ca dell'intera struttura. Tale opera-
zione può essere compiuta attraverso il comando Design > Steel Frame Design
> Start Design/Check of Structure. I risultati del processo di veri�ca posssono
essere visualizzati attraverso il comando Design > Steel Frame Design > Display
Design Info > P-M Ratio Colors & Values per quanto riguarda la veri�ca a sforzo
assiale e �essione, oppure P-M Colors/Shear Ratio Values per quanto riguarda la
veri�ca a taglio. Cliccando su una qualunque colonna col tasto destro sarà pos-
sibile avere accesso alla �nestra dei dettagli di veri�ca. I risultati della veri�ca
sono riportati in �gura 8.18 e 8.19.

186



Figura 8.18: risultati della veri�ca P-M-M delle colonne in acciaio

Figura 8.19: risultati della veri�ca a taglio delle colonne in acciaio
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8.7 Veri�ca dei rapporti di resistenza trave-colonna

La veri�ca dei rapporti di resistenza trave-colonna in accordo al punto 4.4.2.3
dell'EC8 viene condotta in automatico per le strutture a telaio in CDA e CDB
una volta lanciata la veri�ca dell'intera struttura. I dettagli della veri�ca sono
accessibili per tutte le combinazioni sismiche cliccando col tasto destro su una
qualunque colonna e selezionando la stazione di estremità della stessa vedi �gura
8.20.

8.8 Progetto delle nervature di continuità e delle
imbottiture d'anima

Il progetto delle nervature di continuità e delle imbottiture d'anima è con-
dotto in automatico per i nodi composti da colonne ad I con travi incidenti
parallelamente all'anima della colonna, una volta lanciata l'analisi della strut-
tura. I dettagli della veri�ca sono accessibili per tutte le combinazioni sismiche
cliccando col tasto destro su una qualunque colonna e selezionando la stazione di
estremità della stessa vedi �gura 8.20.

Figura 8.20: risultati della veri�ca dei rapporti di resistenza trave-colonna e della
progettazione del nodo
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8.9 Identi�cazione degli elementi non veri�cati

Una volta condotta la veri�ca della struttura possono essere facilmente indi-
viduati gli elementi che non soddisfano un determinato criterio di veri�ca sem-
plicemente andando nel menu Design > Steel Frame Design > Display Design
Info e, alla voce Design Output, scegliere fra:

� Identify P-M Failure: per identi�care gli elementi non veri�cati per intera-
zione fra �essione esforzo assiale

� Identify Shear Failure: per identi�care gli elementi non veri�cati a taglio

� Identify All Failures: per identi�care tutti gli elementi non veri�cati

Scegliendo l'ultima opzione accanto ad ogni elemento comparirà l'informazione
riguardante il tipo di veri�ca non soddisfatta (vedi 8.21). Cliccando col tasto
destro su tale elemento si avrà accesso alle informazioni complete circa la veri�ca
in esame (vedi 8.22).

Figura 8.21: identi�cazione di tutti gli elementi non veri�cati
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Figura 8.22: identi�cazione del tipo di veri�ca non soddisfatta

190



Parte III

Appendici





Panoramica su Section

Designer

8.10 Introduzione

In questo capitolo viene brevemente descritto il programma Section Designer
incluso in SAP2000. Attraverso di esso si possono de�nire sezioni di forma qua-
lunque e di materiale qualunque. Nel seguito verranno fatti alcuni esempi di
utilizzo di Section Designer. Si svolgerà un quick tutorial per permettere al let-
tore di prendere subito con�denza con il programma. Verrano dati in�ne alcuni
suggerimenti su come utilizzare Section Designer. Per maggiori chiarimenti ed
approfondimenti si faccia riferimento al manuale Section Design Manual, presente
in formato elettronico in ogni distribuzione del software.

8.11 Descrizione di Section Designer

Section Designer è un programma incluso in SAP2000, attraverso cui si pos-
sono de�nire sezioni di forma e materiale qualunque, anche miste. Il programma
calcola automaticamente tutte le caratteristiche della sezione.

8.11.1 Come lanciare Section Designer da SAP2000

Aprire il programma SAP2000 e creare un nuovo modello oppure aprirne uno
già impostato. Ai �ni di questa nostra breve panoramica è su�ciente creare un
modello di telaio preimpostato:

1. Impostare le unità di misura a KN, m, C, attraverso il menu a tendina in
basso a destra della �nestra principale del programma

2. Cliccare su File > New Model per aprire la �nestra NewModel
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3. In questa �nestra cliccare su 3D Frames per aprire la �nestra 3D Frames

4. Quindi cliccare su OK lasciando tutti i dati invariati

5. Si otterrà un telaio come quello riportato in �gura 8.23

Figura 8.23: Modello di telaio creato attraverso i template prede�niti

Un ulteriore passo da fare prima di aprire Section Designer è quello di impo-
stare la normativa con cui eseguire le veriche in modo da poter tracciare i domini
resistenti secondo le normative Europee. A tal �ne si apra la �nestra Concrete
Frame Design Preferences attraverso il comandoOptions > Preferences >
Concrete Frame Design... e s'imposti la normativa di progetto a EUROCODE
2-2004. Quindi si clicchi il tasto OK.

Per aprire il programma Section Designer utilizzare il comando De�ne >
Frame Sections... per aprire la �nestra Frame Properties. Da qui si clicchi
sulla voce Add SD Section dal relativo menu a tendina. Quindi si clicchi Add
New Property... Cliccare sulla voce Add SD Section dal relativo menu a
tendina. Quindi cliccare su Add New Property...

Si aprirà la �nestra SD Section Data. In questa �nestra:

� Impostare il materiale a Calcestruzzo (CONC ) sotto la voce Base Material

� Spuntare Concrete Column sotto la voce Design Type
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� Lasciare spuntato Reinforcement to be Checked sotto la voce Concrete
Column Check/Design al �ne di eseguire una veri�ca sulla sezione.

� In�ne cliccare il tasto Section Designer... sotto la voce De�ne/Edit/Show
Section

Alla �ne di questa procedura si aprirà la �nestra di Section Designer. Si veda la
�gura 8.24

Figura 8.24: Finestra di Section Designer

8.11.2 L'interfaccia

L'interfaccia di Section Designer si presenta molto semplice. In essa si trova:

� La griglia su cui disegnare la sezione dell'elemento

� Le unità di misura che si stanno impostando (in basso a destra). Di default
queste sono quelle impostate nella �nestra principale di SAP2000

� La barra degli strumenti per la creazione della sezione a sinistra, in verticale.

� La barra con gli strumenti standard di creazione nuovo �le, do e undo,
refresh window, zoom. Questa barra è posizionata in alto a sinistra.

� In�ne si hanno altri 4 tasti che sono cliccabili solo dopo aver de�nito la
sezione. Questi 4 tasti servono per:
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� Mostrare le proprietà della sezione;

� Mostrare il dominio resistente della sezione;

� Mostrare il diagramma momento-curvatura della sezione;

� Mostrare lo stress nella sezione;
NOTA: quest'ultimo tasto non è presente in ETABS.

Nella descrizione che segue si useranno i comandi che si trovano nei menu a
tendina. Le stesse operazioni possono anche essere fatte attraverso i tasti presenti
nelle barre brevemente descritte sopra.

Nelle sezioni che seguono si riportano degli esempi di creazione di sezioni. In
questo modo si permette al lettore di essere da subito produttivo. Al solito si
rimanda al manuale distribuito con il software per maggiori dettagli.

8.12 Alcuni esempi

Verrano presi in considerazione i seguenti esempi:

� Pilastro quadrato

� Trave di forma qualunque con presenza di foro

� Sezione composta calcestruzzo/acciaio

� PacMan

Una delle prime cose da fare è impostare correttamente la griglia. Per i nostri
scopi è utile avere una griglia con linee guida ogni 0.1 m con linee minori ogni 2
cm.

Cliccare quindi su Options > Preferences per aprire la �nestra Preferen-
ces. In questa �nestra impostare a 0.1 il valore Background Guideline Spacing
e a 4 il valore Fine Grids between Guidelines in modo da avere una suddivisio-
ne in 5 parti (�gura 8.25). Cliccare quindi su OK per chiudere la �nestra. Si
può ingrandire la visualizzazione attraverso il comando View > Zoom In One
Step.

8.12.1 Pilastro quadrato

Si vuole de�nire un pilastro quadrato di 50 cm di lato, armato con 16φ20
distribuiti nel perimetro della sezione, con un copriferro di 5 cm valutato dal
bordo della trave all'asse della barra di acciaio.

I passi da seguire sono i seguenti:

1. De�nire una sezione rettangolare attraverso il comando Draw > Draw
Solid Shape > Rectangle. Il cursore cambierà forma.
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Figura 8.25: Finestra di preferenze di Section Designer

2. Cliccare sul centro degli assi per posizionare la sezione rettangolare al
centro.

3. Ripristinare il Select Mode con il comando Draw > Select Mode

4. Posizionandosi con il cursore sopra gli angoli della sezione appena creata si
nota che si visualizza un pallino rosso. Guardando le coordinate del punto
in basso a destra, si nota che la sezione di default è già di per se una sezione
di lato 50 cm

5. Cliccare sopra la sezione con il tasto destro del mouse per aprire la �nestra
Shape Properties - Solid. In questa �nestra:

(a) Impostare Yes sotto la voce Reinforcing. (�gura 8.26)

Figura 8.26: Finestra per la de�nizione delle proprietà di forma della sezione
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(b) Cliccare su OK. Si ottiene la sezione riportata in �gura 8.27.

Figura 8.27: Sezione pilastro in calcestruzzo in Section Designer

6. Ora bisogna de�nire l'armatura. L'armatura nella sezione è di due tipi:

(a) L'armatura d'angolo (corner)

(b) L'armatura di lato (edge)

Per operare delle modi�che, procedere come segue:

(a) Cliccare con il tasto destro del mouse sopra una barra d'armatura d'an-
golo. Comparirà la �nestra Corner Point Reinforcement (�gura
8.28).

Figura 8.28: Finestra per la de�nizione delle barre d'armatura d'angolo

In questa �nestra scegliere le barre di diametro φ20 e spuntare la voce
Apply to All Corners. In questo modo la variazione sarà e�ettuata
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in tutti e quattro gli angoli. Cliccare in�ne su OK per chiudere la
�nestra.

(b) Cliccare ora con il tasto destro del mouse in una barra d'armatura
laterale. Si aprirà la �nestra Edge Reinforcing (�gura 8.29). In
questa �nestra scegliere le barre di diametro φ20 , impostare il copri-
ferro (Bar Cover) a 0.04 (4 cm) e spuntare la voce Apply to All Edges.
In questo modo la variazione sarà e�ettuata in tutti e quattro i lati.
Si è impostato il valore 4 cm perchè il programma considera come Bar
Cover la distanza fra il bordo della sezione e il bordo della barra d'ar-
matura. Cliccare in�ne su OK per chiudere la �nestra. La sezione si
presenta ora con le barre d'armatura della giusta dimensione.

Figura 8.29: Finestra per la de�nizione delle barre d'armatura laterali

Ora la sezione è de�nita. Section Designer permettere di ottenere delle
informazioni sulla sezione appena de�nita:

� Display > Show Section Properties... permette di visualizzare la �-
nestra Properties che mostra le proprietà della sezione (area, momenti
di inerzia, raggi giratori ecc). Si veda la �gura 8.30. Cliccare su OK per
uscire da questa �nestra.

� Il comando Display > Show Interaction Surface... permette di visua-
lizzare il dominio resistente della sezione. Si apre la �nestra Interaction
Surface che mostra il dominio resistente della sezione in forma tabellare
esportabile, in forma gra�ca 2D ed in forma tridimensionale. Operando
tramite i vari tasti presenti è possibile ruotare il dominio 3D per visualiz-
zarlo da diversi punti di vista. Si veda la �gura 8.31. Cliccare su Done per
uscire dalla �nestra.

� Attraverso il comando Display > Show Moment-Curvature Curve...
aprire la �nestraMoment Curvature Curve con il diagramma momento
curvatura della sezione. A tal proposito si veda la �gura 8.32.

La �nestra riporta numerose altre informazioni (che sono anche esportabili).
Cliccare su Done per uscire dalla �nestra.
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Figura 8.30: Finestra delle proprietà della sezione

Figura 8.31: Dominio resistente della sezione
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Figura 8.32: Diagramma momento curvatura della sezione

Cliccando il tasto Done in basso a destra della �nestra principale di Section
Designer, si ritorna a SAP2000. Si è nuovamente nella �nestra SD Section
Data. Cliccando OK si accetta la sezione che entra a far parte del database col
suo nome di default FSEC1.

Cliccare in�ne su OK della �nestra Frame Properties per tornare alla
�nestra principale di SAP2000. Ora la sezione può essere usata per un qualsiasi
elemento del modello.

8.12.2 Trave di forma qualunque con foro

Può succedere di essere chiamati realizzare una trave con una sezione non
standard, ad esempio con un foro al suo interno (come nel caso del passaggio di
impianti). Utilizzando Section Designer è possibile de�nire una sezione qualunque
e posizionare l'armatura in una posizione qualunque.

La sezione che si vuole modellare in Section Designer è quella riportata in
�gura 8.33. Come illustrato in �gura si utilizzano armature principali φ20 e
armature φ16 di confezione. Il copriferro è pari a 5 cm misurato dal bordo di
calcestruzzo all'asse della barra. Le dimensioni del foro sono 30 cm× 85 cm. La
�scatola� di calcestruzzo che ricopre il foro per il passaggio di eventuali impianti
ha uno spessore di 15 cm. In questa parte, il copriferro viene preso pari a 3 cm.
Le sta�e sono solamente rappresentate a �ni gra�ci e il disegno non è in scala.
Lo scopo è puramente quello di dare un esempio della �essibilità d'uso di Section
Designer.
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Figura 8.33: Sezione di trave in c.a. con foro all'interno
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In quanto segue si riporteranno solamente i passi principali per la creazione
della sezione, dando alcuni suggerimenti sui comandi da utilizzare. Per ottenere
lo stesso risultato ci sono diverse vie: l'utente può, dopo aver acquisito le basi,
utilizzare quella che ritiene più rapida e più conforme alle proprie esigenze.

Come precedentemente illustrato, per aprire il programma Section Designer
utilizzare il comandoDe�ne > Frame Sections... per aprire la �nestra Frame
Properties. Cliccare sulla voce Add SD Section dal relativo menu a tendina.
Quindi cliccare su Add New Property...
Si aprirà la �nestra SD Section Data. In questa �nestra:

� Impostare il materiale a Calcestruzzo (CONC ) sotto la voce Base Material

� Spuntare Concrete Column sotto la voce Design Type. Anche se stiamo
analizzando una trave si può utilizzare l'opzione per i pilastri in modo che
il programma calcoli il dominio di rottura della sezione. In sede di veri�ca
SAP2000 (ma anche ETABS), considera una presso�essione in cui il carico
assiale è nullo. Questo approccio presenta il vantaggio di includere nel
calcolo anche le sollecitazioni di tipo torsionale.

� Lasciare spuntato Reinforcement to be Checked sotto la voce Concrete
Column Check/Design al �ne di eseguire una veri�ca sulla sezione.

� In�ne cliccare il tasto Section Designer... sotto la voce De�ne/Edit/Show
Section

� Il programma Section Designer viene avviato e compare la sua �nestra base.

Di seguito si riporta la traccia da seguire per la creazione della sezione:

1. Per prima cosa bisogna disegnare la forma della sezione. Un modo per
farlo è quello di utilizzare il comando Draw > Draw Poly Shape. Si
suggerisce di procedere disegnando la sezione in due parti sovrapposte come
illustrato in �gura 8.34.

Per farlo usare prima il comando Draw > Draw Poly Shape per di-
segnare una sagoma che assomigli a quella desiderata. Quindi utilizzare
il comando Draw > Reshape Mode per assegnare punto per punto le
giuste coordinate. Il risultato �nale è quello di �gura 8.34.

2. Create le due forme sovrapposte, utilizzare il comando Edit > Merge
Areas per unire le due aree.

3. Si tratta ora di posizionare l'armatura nella sezione secondo lo schema di
�gura 8.33. I comandi da utilizzare sono:

� Draw > Reinforcing Shape > Line Pattern
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Figura 8.34: Disegno di due �gure sovrapposte

� Draw > Reinforcing Shape > Single Bar

Le armature nella sezione sono state disegnate utilizzando talvolta il co-
mando Line Pattern e talvolta il comando Single Bar come illustrato in
�gura 8.35.

(a) Il comando Line Pattern permette di tracciare una linea in cui di-
sporre una serie di barre di armatura. Una volta invocato il comando
si clicca sul primo estremo della linea e poi sul secondo. Appariranno
le barre di armatura distribuite uniformemente lungo la linea traccia-
ta. Cliccando col tasto destro sopra una qualunque delle barre della
linea apparirà la �nestra riportata in �gura 8.36.
In questa �nestra è possibile modi�care a piacimento:

� la posizione della linea d'armatura (X1, Y 1, X2, Y 2)
� la spaziatura fra una barra e l'altra (Bar Spacing)
� la dimensione delle barre (Bar Size)
� la presenza o meno delle barre posizionate alle estremità della
linea (End Bars)

Per posizionare e de�nire nel modo desiderato le barre d'armatura
disposte secondo una linea si agisca su questi parametri.

(b) Il comando Single Bar permette di posizionare una barra singola
d'armatura in un punto qualunque all'interno della sezione. Dopo aver
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Figura 8.35: Sezioni con indicati i metodi usati per la disposizione di ogni barra
di armatura

Figura 8.36: Finestra di de�nizione proprietà armatura lineare
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invocato il comando è su�ciente cliccare sul punto della sezione in cui
si desidera posizionare la barra d'armatura. Cliccando con il tasto
destro del mouse sopra ad una barra d'armatura singola, si aprirà la
�nestra riportata in �gura 8.37.

Figura 8.37: Finestra di de�nizione proprietà armatura singola

In questa �nestra è possibile modi�care:

� la posizione dell'armatura singola (X Center, Y Center)

� la dimensione della barra (Bar Size)

Si consiglia, in entrambi i casi, di posizionare le armature nella posizione
desiderata qualora possibile (quando lo snap possibile combacia con la po-
sizione di interesse). Qualora ciò non fosse possibile, posizionare l'armatura
nel posto più vicino a quello desiderato e andare a de�nire la posizione in
maniera precisa attraverso i menu che compaino cliccando sopra l'armatura
col tasto destro del mouse.

Una volta ultimato il posizionamento delle armature si ottiene il risultato
riportato in �gura 8.38.

Di questa sezione si possono ricavare tutte le informazioni e le caratteristiche
che Section Designer ha calcolato ovvero: proprietà della sezione, dominio di rot-
tura e analisi momento curvatura. Si veda quanto detto nell'esempio del pilastro
a sezione quadrata, trattato nella precedente sezione.

8.12.3 Sezione composta calcestruzzo/acciaio

Creare sezioni miste acciaio calcestruzzo è molto semplice in Section Designer.
Supponiamo di voler modellare una sezione di pilastro quadrata di lato 50 cm
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Figura 8.38: Sezione della trave con le armature

Figura 8.39: Sezione composta acciaio-calcestruzzo
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armata con 4φ20 agli angoli e 4φ16 uno per ogni lato con all'interno una sezione
HE 300-B in acciaio. Il risultato �nale è riportato in �gura 8.39.

Per creare la sezione in c.a. si procede esattamente come visto in una delle
sezioni precedenti. Per inserire il pro�lo in acciaio HE 300-B bisogna innanzitutto
che il database dei pro�lati Europei sia stato caricato. Tale operazione deve
essere fatta prima di aver fatto partire Section Designer. Dalla �nestra Frame
Properties, aperta tramite il comandoDe�ne > Frame Sections..., dal menu
a tendina sotto la voce Choose Property Type to Add, si sceglie Import/Wide
Flange; quindi si clicca su Add New Property... e si cerca nella cartella di
installazione di SAP2000 o di ETABS il �le EURO.PRO. Si selezionano le sezioni
di interesse dalla lista che compare.

Attraverso Section Designer si utilizza il comando Draw > Draw Structu-
ral Shape > I/Wide Flange per inserire una sezione a doppio T. La sezione
va inserita cliccando sull'asse centrale della sezione in calcestruzzo. Cliccare ora
sulla sezione in acciaio appena creata con il tasto destro del mouse per aprire la
�nestra Shape Properties - I/Wide Flange (�gura 8.40).

Figura 8.40: Finestra di de�nizione proprietà sezione in acciaio

In questa �nestra scegliere la sezione HE 300-B sotto la voce Type. Quindi
cliccare su OK per ritornare alla �nestra principale. Di nuovo sono disponibili le
proprietà della sezione, il dominio resistente e il diagramma momento curvatura.

8.12.4 PacMan

Per concludere, come simpaticamente mostrato in una serie di seminari tenuti
in Italia nell'autunno del 2004 direttamente dalla CSI, anche una sezione tipo
PacMan è facilmente ottenibile con Section Designer come illustrato in �gura
8.41. Questo a mostrare l'estrema �essibilità del software.
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Figura 8.41: Sezione PacMan
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